
Account Manager overview

In the Account Manager, you can see a summary of all your accounts, create a new account, and delete or modify an existing 

account. You can also go to Account Details, where you can enter and change information about your accounts, set up accounts 

for use with Online Services, and see an account's running balance over the last 12 months.

You can also use the Account Manager to see the current balance of all your accounts by choosing Account Balances from the 

View bar drop-down list.

{button ,AL("ProcEnteringaTransaction;AccountsOverview;ProcDeletinganAccount;ProcChanginganAccountsNameorType;ProcC

hanginganAccountsOpeningBalance;ProcCreatinganAccount")} See Related Topics



Accounts overview

Microsoft Money has eight main account types:
Asset Accounts -- for personal property or amounts that are owed to you other than amortized loans
Bank Accounts -- for savings, checking, or line-of-credit accounts
Cash Accounts -- for out-of-pocket expenditures and petty cash
Credit Card Accounts -- for amount you owe on credit cards
Investment Accounts -- for stocks, bonds, CDs, money markets, mutual funds, and T-bills
Liability Accounts -- for amounts you're paying in a few installments, such as insurance premiums, quarterly taxes 

payable, or other amounts you owe other than amortized loans
Loan Accounts -- for amortized loans, such as home mortgage loans, car loans, and school loans
Retirement Accounts – for tax-deferred retirement plans, such as 401(k)s, IRAs, 403(b)s, SEPs, Keoghs, and RRSPs

{button ,AL("ProcCreatinganAccount")} See Related Topics



Starting and ending balances when balancing your Bank Account

The starting balance is the amount that was in your bank account at the beginning of your bank statement period. The ending 

balance is the amount in your account on the last day of the bank statement period. Both figures should be taken from your bank 

statement to ensure that your records agree with the bank.

If your previous balancing worked without error, but the starting balance is incorrect this time, one of two things could have 

happened: You might have changed the opening balance of the account itself, or a reconciled transaction was changed, added 

or deleted, meaning a transaction that was reconciled in a previous balancing was changed/deleted or is no longer marked 

reconciled, or a transaction that did not clear in the previous statement was manually marked reconciled.

{button ,AL("ProcMarkingaTransactionasClearedorReconciled;ProcChanginganAccountsOpeningBalance")} See Related Topics



To create an account

1 Make sure you have your checkbook or savings book and your most recent statement handy.

2 In the Account Manager, click the New Account button at the bottom of the screen.

3 Follow the instructions on the screen.

{button ,AL("ProcEnteringaTransaction")} See Related Topics



To create a Checking Account

1 Make sure you have your checkbook and your most recent bank statement handy.

2 In the Account Manager, click the New Account button.

3 Enter the bank name, and then click the Next button.

4 Choose Checking as the account type.

5 Follow the instructions on the screen.

{button ,AL("ProcEnteringaTransaction")} See Related Topics



To switch between accounts in the Account Register

1 Click the triangle to the left of the account name in the navigation bar.

2 Click the account you want.



To balance (reconcile) an account

You should balance your accounts each time you receive a statement from your bank or other financial institution. The main 

reason your want to balance your accounts is to ensure that your records are in sync and that neither you nor the bank or 

financial institution has made an error.

1 Make sure you have your account statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the account 

you want to balance.

3 Click the Balance button on the right of the screen.

4 Read the instructions on the screen, and click the Next button when you're ready to move on.

5 In the Starting and Ending balance fields, enter the balances you had in the account at the beginning and end of the 

statement period, as listed on your account statement.

6 After entering any service charges you've paid on the account, or any interest earned or charged on this account during this 

balance period, click the Next button.

7 Read the Balance Account information on the right of the screen, and clear each transaction that appears on your account 

statement by clicking in the Cleared (C) field. If you need to enter or change any transactions while balancing, click the box 

toward the bottom, right of the screen, and then enter your changes.

8 When you're done, click the Next button, and follow the instructions on the screen.

When you finish, all transactions that have been reconciled will have an R in the Cleared field.

{button ,AL("BalancingorReconcilingYourCreditCardAccount;StartingandEndingBalancesWhenBalancingYourBankAccount;Proc

MarkingaTransactionasClearedorReconciled")} See Related Topics



To mark a transaction as cleared or reconciled

1 In the Account Register, highlight the transaction.

2 On the Edit menu, point to Mark As, and then click the option you want.

Important
These commands are most useful for Liability, Asset, and Cash Accounts. For accounts you want to balance against a 

statement, such as Checking, Savings, and Credit Card Accounts, it's best to balance the account.

{button ,AL("ProcBalancingorReconcilinganAccount")} See Related Topics



To change an account's opening balance

1 In the Account Manager, highlight the account, and then click the Account Details button at the bottom of the screen.

2 Make your change in the Opening Balance box.

The ending balance of this account will be adjusted to reflect the change you made to the opening balance.

Warning
If you change your account's opening balance, make sure the figure comes from an account statement. Otherwise, you 

won't have an official figure to balance the account against.



##### in an amount field

If an amount is too wide to display, Money displays ##### in the amount field. To see the actual amount, try maximizing Money.



To change an account's name or type

1 In the Account Manager, highlight the account, and then click the Account Details button.

2 Click the Modify button.

3 Make your changes.



To delete an account

1 In the Account Manager, highlight the account.

2 Click the Delete button at the bottom of the screen.

Warning
When you delete an account, all its transactions are permanently deleted. Before deleting an account, you may want to 

back up the file. If you just want to close an account, see Closing an Account. Close an account in Money if you want to retain the 
account's transactions, but don't want the accounts to show up in your account lists.

{button ,AL("ProcBackingUpYourFile;ProcArchivingYourRecords")} See Related Topics



Asset Accounts overview

You can use Asset Accounts to track changes in the value of your personal assets. For example, you might want to keep records 

of improvements that increase the value of your home. After you've created the Asset Account, enter each increase or decrease 

in value as a separate transaction.

Personal assets should not be confused with investment assets. For investment assets such as stocks, bonds, CDs, T-Bills, 

Money Market Funds, and IRAs, you should create Investment Accounts.

Use an asset account for:
 Antiques  Homes
 Cars  Stamp collections
 Boats  Furniture

{button ,AL("ProcCreatinganAssetAccount;ProcUpdatinganAssetorLiabilityAccount;InvestmentPortfolioOverview")} See Related 

Topics



To create an Asset Account

1 In the Account Manager, click the New Account button.

2 Enter the bank name, and then click the Next button.

3 Choose Asset as the account type.

4 Follow the instructions on the screen.

For the opening balance, enter the cost of the item(s). For example, if you purchased a house for $150,000, enter that amount 

as your opening balance. You can then enter an adjustment transaction to reflect any changes in the value of the asset.

{button ,AL("ProcUpdatinganAssetorLiabilityAccount")} See Related Topics



To create a Liability Account

1 In the Account Manager, click the New Account button.

2 Enter the bank name, and then click the Next button.

3 Choose Liability as the account type.

4 Follow the instructions on the screen.

For the opening balance, enter the amount you still owe. (Enter this as a positive number.)

Note
Use a Liability Account to track money you owe that you don't want to track in a Loan Account. For example, money that 

you owe to a friend. Use a Loan Account for tracking loans with a regular payment schedule, such as home mortgage loans. After 
you've created the Liability Account, enter each increase or decrease as a separate transaction.

{button ,AL("ProcUpdatinganAssetorLiabilityAccount")} See Related Topics



To update an Asset or Liability Account

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the account.

2 Click the Decrease, Increase, or Transfer tab.

3 Enter the transaction as usual, except in the Amount field enter the change in value, and in the Category field, type Market 

Adjustment.

Don't change the amount of the original transaction. You might need a record of it for tax purposes.

Tip
You could track improvements to your home by entering a transaction into your home's Asset Account for the cost of the 

improvements.





To create a Cash Account

1 In the Account Manager, click the New Account button.

2 Enter the bank name, and then click the Next button.

3 Choose Cash as the account type.

4 Follow the instructions on the screen. For the opening balance, enter the amount of cash you have on hand.

Tip
You can also record your cash transactions in a Checking or Savings Account. Use a Cash Account if you want to keep 

more detailed records of how you spend your cash.

{button ,AL("ProcEnteringaTransaction;ProcUpdatingaCashAccountsBalance;ProcRecordingaCashMachineATMWithdrawal")} 

See Related Topics



To update a Cash Account's balance

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the Cash 

Account you want to update.

2 Click the Balance button.

3 In the New ending balance box, type the present balance.

4 In the As of date box, either accept the proposed date or type a different date.

5 If you want, choose a category for the adjustment.

An adjustment transaction is then created to balance the account.

Tip
To clear individual transactions and balance the account as you would a checking account, click the Balance button in the 

Adjust Account Balance dialog box and follow the instructions on the screen.



To record a cash machine (ATM) withdrawal

1 Make sure you have your ATM receipt handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the account 

from which you withdrew the cash.

3 Click the Cash Machine tab if you don't track your spending through a Cash Account.

Click the Transfer tab if you track your spending through a Cash Account.

4 Fill out all the fields in the form.

{button ,AL("ProcTransferringMoneyBetweenAccounts")} See Related Topics





Categories and subcategories overview

Categories are the key to organizing your finances, and subcategories help further refine your record keeping.

With categories and subcategories, you can:
See where your money is coming from and where it's going to.
Budget your income and expenses and compare budgeted amounts with actual amounts.
Track tax-related income and expenses.

When you set up Money, you start with the Standard Categories. You can add, delete, and modify these built-in categories to 

meet your needs, or you can start from scratch and create your own custom list of categories.

When entering a transaction, just choose an existing category, or type a new one. If you type a new category or subcategory 

name, Money will ask if you want to add it as a new category or subcategory.

Subcategories can be used together with categories to further refine the way you track income and expenses. For example, in 

the Automobile category you may want to use subcategories to track expenses such as gasoline, maintenance, and car 

payments.

{button ,AL("ProcCreatingaNewCategoryorSubcategory;ProcAssigningCategoriesToTransactions;StandardCategories;ProcDeleti

ngaCategoryorSubcategory;ProcRenamingaCategoryorSubcategory;ProcTrackingTaxInformationUsingCategories;ProcSplittin

gaTransactionBetweenMultipleCategories;ProcAddingInformationtoaCategoryorSubcategory")} See Related Topics



To assign categories to transactions

1 While entering your transaction, move to the Category field in the transaction form at the bottom of the Account Register.

2 Type a category name, or choose one from the list.

3 If you want to assign a subcategory, move to the Subcategory field and type a name or choose one from the list.

{button ,AL("ProcAddingInformationtoaCategoryorSubcategory;ProcCreatingaNewCategoryorSubcategory;ProcDeletingaCatego

ryorSubcategory;ProcRenamingaCategoryorSubcategory")} See Related Topics



To split a transaction between multiple categories

1 In the Account Register, fill out the transaction form as usual.

2 Click the Split button.

3 Enter the category, subcategory, description, and amount for each portion of the split.

To move down one line, press ENTER, or double-click the next line.

If you have an unassigned amount you want to apportion between all the parts of the split, press the F6 key. For example, if 

you've purchased several items and categorized them in a split transaction, you can apportion the sales tax among all of 

them.

4 When finished, click the Done button. Split is then displayed in the Category field.

If you want to return to the Split Transaction dialog box, just click the Split button again.

Tip

You can use split transactions for:
Depositing part of a check and taking some of it in cash.
Purchasing several items that you want to describe and keep track of separately.
Itemizing a credit card payment.
Itemizing your paycheck. See Itemizing a Paycheck Deposit.



To create a new category or subcategory

1 While entering a transaction in the Account Register, type the name you want for the new category or subcategory in the 

Category or Subcategory field.

2 Press TAB.

The Create New Category/Subcategory dialog box is displayed. You can then change the name or type of the category or 

subcategory and indicate whether you want it to be included on tax reports.

{button ,AL("ProcAssigningCategoriesToTransactions;ProcAddingInformationtoaCategoryorSubcategory;ProcCreatingaBudget")} 

See Related Topics



To add information to a category or subcategory

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Go To Details button at the bottom of the screen.

4 Enter your changes.

{button ,AL("ProcRenamingaCategoryorSubcategory;ProcCreatingaBudget")} See Related Topics



To track tax information using categories

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Go To Details button at the bottom of the screen.

4 Choose the Include On Tax Reports check box to include the category or subcategory in your tax reports. Clear the check 

box to exclude it from your tax reports.

Note
With Money's Standard Categories, the tax status of each category is already specified for you.

{button ,AL("PreparingForTaxTime;ProcAssociatingaCategoryorSubcategoryWithaTaxFormLine")} See Related Topics



To associate a category or subcategory with a tax form line

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Go To Details button at the bottom of the screen.

4 Choose the Include On Tax Reports option, and then choose the Tax Form and Form Line information you want.

Tip
Assigning a category or subcategory to a particular line on a Federal Income Tax form enables you to generate a Tax 

Software Report and export it directly into the correct lines in leading tax software packages. You can also simply print a Tax-Related 
Transactions report and use it to help you manually complete your tax forms.

{button ,AL("PreparingForTaxTime;ProcTrackingTaxInformationUsingCategories;ProcExportingtoaTaxPreparationProgram")} See 

Related Topics



To rename a category or subcategory

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Modify button at the bottom of the screen.

4 Type the new name and verify the category type.

When you rename a category or subcategory, the name will change in all transactions using that category or subcategory.

{button ,AL("ProcCombiningCategories;ProcDeletingaCategoryorSubcategory")} See Related Topics



To move or combine categories

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Move button.

4 In the Move Transactions dialog box, choose the category you want the transactions assigned to.

{button ,AL("ProcDeletingaCategoryorSubcategory")} See Related Topics



To delete a category or subcategory

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category or subcategory in the list.

3 Click the Delete button.

If any transactions were assigned to the deleted category or subcategory, Money asks you to choose a new category or 

subcategory to reassign the transactions to. You don't have to reassign the transactions to a new category or subcategory. 

However, if you want to include the transactions in budgets or reports, it's best to reassign them.



To prepare for tax time

Categories and subcategories simplify preparation of your taxes. If you use Money's Standard Categories, all your tax-related 

transactions will automatically be included in your tax reports. You can change the tax status of any category or subcategory in 

the Payees and Categories area. At the end of the year, you can then print a Tax-Related Transactions report that lists all your 

tax-related income and expenses.

You can also then create a Tax Software Report. This report associates categories and subcategories with specific Federal 

Income Tax forms and tax form lines. If you plan to use a tax preparation software program, you can export this report directly 

into it. You can also print the report to help you complete your tax forms manually.

{button ,AL("ProcExportingtoaTaxPreparationProgram;StandardCategories")} See Related Topics



To change a category's type

1 In the Payees and Categories area, click Categories on the button panel to the left.

2 Highlight the category in the list.

3 Click the Modify button at the bottom of the screen.

4 Click the correct type.

If the Modify Category dialog box doesn't display the options for category type, you might have chosen a subcategory name 

instead of a category name. If so, cancel out of the dialog box, and return to step 2.

Note
When you change a category's type, its subcategories are automatically changed to the new type also.

{button ,AL("CategoriesandSubcategoriesOverview;ProcAssigningCategoriesToTransactions;ProcAddingInformationtoaCategory

orSubcategory;ProcRenamingaCategoryorSubcategory")} See Related Topics



To create a budget

1 On the Tools menu, click Budget.

2 If you want Money to automatically create a budget based on your prior spending, click the AutoBudget button, and specify 

the period on which you want to base your budget, and then click the Create button. (To create a useful budget, it's best to 

have at least 30 days of data entered.)

3 In the Budget dialog box, highlight a category or subcategory in the list, and then enter or adjust the yearly, monthly, or weekly 

amount for it. Or, for categories such as utility expenses that can vary widely from month to month, create a custom budget 

amount for each month by clicking the Customize by month option and then entering the monthly amounts below.

Tips
If you want to print a copy of your budget, go to the Report and Chart Gallery, click Spending Habits on the button panel to 

the left, and then double-click My Budget in the report list. Then, click Print on the File menu. Later, you might also want to print a 
How I'm Doing on My Budget report to compare your actual spending to your budget.

Money's budgets are based on spending per category. To make changes to your list of categories, go to the Payees and 
Categories area.





Standard Categories

Money automatically gives you a list of Standard Categories you can use when entering your transactions. You can change, 

delete or add to this list at any time.

To view Money's Standard Categories, see Income Categories and Expense Categories.

{button ,AL("ProcDeletingaCategoryorSubcategory;ProcRenamingaCategoryorSubcategory;ProcTrackingTaxInformationUsingCa

tegories;ProcAddingInformationtoaCategoryorSubcategory;ProcCreatingaNewCategoryorSubcategory")} See Related Topics



Income categories

You can print this file for easy reference by clicking Print Topic on the File menu of the online Help window.

Category/Sub

Tax

Fla

g

Tax Form Tax-Form Line

Investment 

Income

T

Dividend T Schedule B Dividend income

Interest T Schedule B Interest income

Long-Term 

Capital Gain 

T

Short-Term 

Capital Gain 

T

Tax-Exempt 

Interest

T Schedule B Interest Income, 

non-taxable

Other Income T 1040 Other income-

misc.

Child Support 

Received

Gifts Received

Loan Principal 

Received

Lotteries T 1040 Prizes, awards, 

gambling

State & Local 

Tax Refund

T 1040 State and local 

refunds

Unemployment 

Compensation

T 1040 Unemployment 

compensation

Retirement 

Income

T

IRA 

Distributions

T 1099R IRA total 

distribution - 

taxable

Pensions & 

Annuities

T 1099R Pension total 

distribution - 

taxable

Social Security 

Benefits

T 1040 Soc. Sec. Income

Wages & Salary T W-2 Salary

Bonus T W-2 Salary

Commission T W-2 Salary

Employer 

Matching

Gross Pay T W-2 Salary

Net Pay

Overtime T W-2 Salary



{button ,AL("ProcCreatingaNewCategoryorSubcategory;CategoriesandSubcategoriesOverview;ProcAssigningCategoriesToTrans

actions;ProcTrackingTaxInformationUsingCategories")} See Related Topics



Expense categories

You can print this file for easy reference by clicking Print Topic on the File menu of the online Help window.

Category/Sub

Tax

Fla

g

Tax Form Tax-Form Line

Automobile

Gasoline

Maintenance

Bank Charges

Bills

Cable Television

Electricity

Garbage & 

Recycle

Homeowner's 

Dues

Mortgage 

Interest

T Schedule A Home mortgage 

interest

Mortgage 

Principal

Natural Gas

Rent

Telephone

Water & Sewer

Cash Withdrawal

Charitable 

Donations

T Schedule A Cash charity 

contributions

Child care T 2441 Child care - day 

care

Clothing

Credit Card 

Payment

Education

Books

Fees

Tuition

Food

Dining Out

Groceries

Furnishings

Gifts

Healthcare T Schedule A Doctors, 

Dentists, Hosp.



Dental T Schedule A Doctors, 

Dentists, Hosp.

Eye care T Schedule A Doctors, 

Dentists, Hosp.

Hospital T Schedule A Doctors, 

Dentists, Hosp.

Physician T Schedule A Doctors, 

Dentists, Hosp.

Prescriptions T Schedule A Medicine and 

drugs

Insurance

Automobile

Health Schedule A Doctors, 

Dentists, Hosp.

Homeowner's/

Renter's

Legal Fees

Life

Job Expense T

Non-

Reimbursed

T Schedule A Misc. (Subject to 

2%)

Reimbursed T

Leisure

Books & 

Magazines

Cultural Events

Electronics

Entertaining

League Fees

Movies & Video 

Rentals

Sporting Events

Sporting Goods

Tapes & CDs

Toys & Games

Loan

Loan Interest

Loan Principal

Miscellaneous

Pet Care

Food

Supplies

Veterinarian

Taxes T Schedule A Other taxes



Federal Income 

Tax

T W-2 Federal 

Withholdings

Local Income 

Tax

T W-2 Local 

Withholdings

Medicare Tax T W-2 Medicare Tax 

Withholding

Other Taxes T Schedule A Other taxes

Real Estate 

Taxes

T Schedule A Real estate tax

Social Security 

Tax

T W-2 Soc Sec Tax 

Withholdings

State/Provincial T Schedule A State and local 

taxes

State Income 

Tax

T W-2 State 

Withholdings

Vacation

Lodging

Travel

{button ,AL("ProcCreatingaNewCategoryorSubcategory;CategoriesandSubcategoriesOverview;ProcAssigningCategoriesToTrans

actions;ProcTrackingTaxInformationUsingCategories")} See Related Topics





To make changes to a transaction

1 In the Account Register, highlight the transaction.

(If you're not displaying the right account, click the triangle to the left of the account name in the navigation bar, and then click 

the account you want.)

2 In the transaction form below, click the field you want to change.

3 Make the changes.

4 Click the Enter button.

Tip
To undo changes to a transaction you haven't yet entered, click the Cancel button.

{button ,AL("ProcEnteringaTransaction")} See Related Topics



To void a transaction

1 In the Account Register, highlight the transaction.

2 On the Edit menu, point to Mark As, and then click Void.

In a voided transaction, **VOID** is displayed in the Amount field, and R for Reconciled is displayed in the C (Cleared) field.

To unvoid a transaction, repeat this process.

Note
When you void a transaction, a record of the transaction is maintained, but the transaction amount is not included in the 

account balance.
If you void a transfer in one account, the corresponding transaction is also voided. Voiding any part of a split will void all 

parts of that split.

{button ,AL("ProcDeletingaTransaction")} See Related Topics



To delete a transaction

1 In the Account Register, right-click the transaction in the register.

2 Click Delete.

Tip
To delete changes to a transaction you haven't yet entered, press the ESC key.

{button ,AL("ProcVoidingaTransaction")} See Related Topics



To move a transaction to another account

1 In the Account Register, right-click the transaction in the register.

2 Click Move To Account.

3 In the Move Transaction dialog box, choose the account you want to move the transaction to.





Classifications overview

If you own rental property, run a charity, or have separate projects, you might want to organize your records by more than just 

income and expense categories. Classifications let you do this.

Classifications can include:
Customers, clients, or projects
Properties
Type of expense -- business or personal

You can create up to two classifications. Each classification can contain both items and subitems -- a structure similar to 

categories and subcategories.

For example, if you own rental property, you might set up a Property classification with: Rental Property 1 as an item, and 

Apartments A, B, and C as subitems; Rental Property 2 as another item, and Apartments 1, 2, 3, and 4 as subitems.

Note
When you create a classification, additional fields are added below the Category and Subcategory fields in the Account 

Register.

{button ,AL("ProcCreatingaClassification;ProcAssigningaClassificationtoaTransaction")} See Related Topics



To create a classification

1 In the Payees and Categories area, click Classification 1 or 2 on the button panel to the left.

2 In the Add Classification dialog box, choose one of the existing classification names, or type a new one.

3 Click the OK button.

4 Click the New button at the bottom of the screen to add items to the classification. (For example, if you created a Family 

Members classification, you might add a new item for the name of each family member.)

Note
When you create a classification, additional fields are added below the Category and Subcategory fields in the Account 

Register.

{button ,AL("CreatingaClassificationItemorSubitem;ProcAssigningaClassificationtoaTransaction")} See Related Topics



To create a classification item or subitem

1 In the Payees and Categories area, click the classification that you want to add the items or subitems to, on the button panel 

to the left.

2 If you are going to add a subitem, highlight the item you want to add it to.

3 Click the New button at the bottom of the screen.

4 In the New Classification dialog box, click the item or subitem button, and then type the name you want.

{button ,AL("ProcAddingInformationAboutClassificationItemsandSubItems")} See Related Topics



To assign a classification to a transaction

1 When entering a transaction, move to the Classification field, which is below the Category field. (It will be labeled with the 

name of the classification you created.)

2 Type an item name or choose one from the list.

3 If your classification includes subitems, type a name in the Subitem field or choose one from the list.

{button ,AL("ProcCreatingaClassification;CreatingaClassificationItemorSubitem")} See Related Topics



To add information about classification items and subitems

1 In the Payees and Categories area, click the classification on the button panel to the left.

2 Highlight the item or subitem in the classification list.

3 Click the Go To Details button at the bottom of the screen.

4 Add your information.



To rename a classification or classification item

1 In the Payees and Categories area, click the classification on the button panel to the left.

2 To rename a classification, click the Rename button below the button panel.

To rename a classification item (or subitem), highlight the item, and then click the Modify button at the bottom of the screen.

3 In the New Name box, type the new name.



To delete a classification or classification item

1 In the Payees and Categories area, click the classification on the button panel to the left.

2 To delete a classification, click the Delete button below the button panel.

To delete a classification item (or subitem), highlight the item, and then click the Delete button at the bottom of the screen.

Note
When you remove a classification, the item and subitem information is deleted from each transaction. This does not affect 

the remainder of the transaction. You can also delete items and subitems you no longer need.



To set up a rental property classification

1 In the Payees and Categories area, click Classification 1 or 2 on the button panel to the left.

2 Under Type, choose Properties or enter an appropriate name.

3 Click the OK button.

4 Click the New button.

5 In the New Properties or Sub-Properties dialog box, type a name for the first property.

6 Click the OK button.

7 Click the New button again if you want to create other properties or any subitems for a property.

Your new classification will now appear in the Account Register.

Examples:

For a single-family building:

Classification item: 1000 High Street.

For a multiple-unit building:

Classification item: Sunset Apartments

Subitem: Apt1

Subitem: Apt2

Subitem: Apt3

Subitem: Apt4

Tip
Classifications work well if you have more than one rental property and you want to view and report income and expenses 

by property or apartment.

{button ,AL("ProcAssigningaClassificationtoaTransaction")} See Related Topics





Credit Card Accounts overview

A Credit Card Account can help you:
Keep an up-to-date record with a running balance by entering transactions from credit card receipts.
Balance your records against your credit card statement each month.
Track a large number of payees through your credit card charges.

You can enter new charges as you make them, or enter them all at once when you get a new statement. In either case, you'll pay 

your credit card bill from a Bank Account, such as checking, not from the Credit Card Account.

If you generally pay your credit card bill in full and you're not concerned about tracking any unpaid balance or tracking by payee, 

you don't need to set up a Credit Card Account. You can track your credit card transactions using split transactions in your 

Checking Account.

{button ,AL("ProcTrackingaCreditCardThroughaCheckingAccount;ProcEnteringCreditCardPayments;ProcCreatingaCreditCardAc

count;ProcEnteringCreditCardPayments;ProcBalancingorReconcilingYourCreditCardAccount")} See Related Topics



To create a Credit Card Account

1 Make sure you have your most recent credit card statement handy.

2 In the Account Manager, click the New Account button at the bottom of the screen.

3 Enter a bank name, and then click Next when you're ready.

4 Choose Credit Card as the account type.

5 Follow the instructions on the screen.

{button ,AL("ProcTrackingaCreditCardThroughaCheckingAccount;ProcEnteringCreditCardPayments;ProcBalancingorReconciling

YourCreditCardAccount")} See Related Topics



To track a credit card through a Checking Account

1 Make sure you have your credit card statement handy.

2 In the Account Register, go to the Checking Account you'll use to pay the credit card bill.

3 Fill out the Check transaction form as usual.

4 Click the Split button.

5 For each charge on your credit card statement, assign a category and type a description and amount.

To enter another charge, press ENTER, or double-click the next line.

6 Click the Done button.

Tip
If you generally pay your credit card bill in full and you're not concerned about tracking any unpaid balance, or tracking by 

payee, this is a good way to track your credit card transactions.

{button ,AL("ProcEnteringCreditCardPayments;ProcSplittingaTransactionBetweenMultipleCategories")} See Related Topics



To enter credit card payments

1 Make sure you have your credit card statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and choose the account from 

which you want to make the payments (typically this is a Checking Account).

3 Click the Transfer tab, and begin entering a transaction as you would for any check.

4 In the To field, choose the name of the Credit Card Account.

5 Click the Enter button.

{button ,AL("ProcTrackingaCreditCardThroughaCheckingAccount;ProcCreatingaCreditCardAccount")} See Related Topics



To balance (reconcile) your Credit Card Account

1 Make sure you have your credit card statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and choose the Credit Card 

Account.

3 Enter transactions for any charges you have not previously entered.

4 Click the Balance button.

5 In the Statement Date box, type the closing date of your statement.

6 Enter the previous balance from your statement in the box labeled Total amount you owed last month, and the new balance 

in the box labeled Total amount you owe this month.

If the previous balance from your statement does not agree with the proposed starting balance, you may have forgotten to 

balance your account one month. You should go back and reconcile the previous month's statement before proceeding.

7 In the Service Charge and Interest Charge boxes, type the amounts from your statement. If you want, assign a category and 

subcategory for these expenses also.

8 Click the Next button, and follow the instructions on the screen.

{button ,AL("ProcEnteringCreditCardPayments")} See Related Topics





To convert foreign currencies

1 In a window or dialog box, type the amount you spent or received in foreign currency in the amount field.

For example, if you reside in the United States but made a purchase in Canada, you would type the amount you spent in 

Canadian dollars.

2 Press the F8 key to bring up the Currency Converter dialog box.

3 In the Foreign Currency box, choose the currency you are converting from.

In the example of making a purchase in Canada, choose Canadian Dollar.

4 Depending on which exchange rate you know, choose Local units for each foreign unit or Foreign units for each local 

unit.

For example, if you know that $.8425 in the U.S. is equal to $1.00 in Canada, then choose Local Units For Each Foreign 

Unit. That is, .8425 local units for each foreign unit.

5 In the Exchange rate box, type the exchange rate at the time you made the purchase, or exchanged cash at the bank.

In our example, you would type 0.8425.

The number in the amount field will then be converted to the local currency.

Note
If you made a purchase with a credit card, you can wait until you get your statement to make an adjustment.

{button ,AL("ConvertingForeignCurrenciesforInvestments")} See Related Topics



To convert foreign currencies for investments

1 Enter your investment activity, leaving the Price field blank.

2 In the Total field, type the amount you spent or received in foreign currency.

For example, if you reside in Australia, but purchased stock in the U.S., you would type the amount you spent in U.S. dollars.

3 Press the F8 key to bring up the Currency Converter dialog box.

The Foreign amount box will display the number you typed in the Amount field.

4 In the Foreign currency box, choose the currency you are converting from.

In the example of making a purchase in the U.S. you would choose the US Dollar.

5 Depending on which exchange rate you know, choose Local Units For Each Foreign Unit or Foreign Units For Each Local 

Unit.

For example, if you know that $1.5 in Australia is equal to $1.00 in the U.S., choose Local Units For Each Foreign Unit.

6 In the Exchange rate box, type the exchange rate at the time the transaction took place.

In our example, you would type 1.5.

The number in the Total field will convert to the local currency, and the amount in the Price field will be entered automatically 

when you complete the transaction.

{button ,AL("ProcUpdatingCurrencyExchangeRates")} See Related Topics



To update currency exchange rates

1 On the Tools menu, click Options.

2 Click the Currencies tab.

3 In the Currency list box, highlight the currency whose exchange rate you want to change.

4 In the Display exchange rate as box, choose an option.

For example, if you know there are .80 local units for each foreign unit, choose Local Units For Each Foreign Unit; however, 

if you know there are 1.25 foreign units for each local unit, then choose Foreign Units For Each Local Unit. Either way, the 

exchange rate will produce the same result.

5 In the Exchange rate box, type the new exchange rate.

{button ,AL("ProcConvertingForeignCurrencies")} See Related Topics
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archive

To copy your current file into a storage file and remove older transactions from the current file. Everything related to those 
records is copied into this file, including reconciled transactions, account, category, classification, payee, and budget information.



balance

The sum of all transactions in an account, as of a particular date. The running total of an account.



Balance button

Located at the right side of the Account Register. Click this button to balance a Money account against a statement.



Online Banking

A service provided by your bank or financial institution that lets you electronically update your bank and credit card records, 
transfer funds between accounts, check your current balances, and order new checks.



Calculator

Press CTRL+K whenever you want to use the Windows calculator.



category

A label that you assign to each transaction so that you can more clearly see spending and income patterns in Money's reports. 
Categories include, for example, Housing, Investment Income, and Insurance. You can create categories of your own, or use 
Money's Standard Categories.



classification

Use classifications in addition to income and expense categories to further organize your transactions. For example, with 
classifications, transactions can be organized by family member, property, or project. You can create up to two classifications in 
the Payees and Categories area.



cleared transaction

A transaction that is listed on a bank, credit card, or loan statement. In Money, the letter "C" in the C (Cleared) field indicates a 
cleared transaction.



disk

A place for permanently storing information, such as the files needed to run an application or the files that contain your work. 
This term, unless specified, can refer to your computer's internal hard disk or to a floppy disk that can be inserted into your 
computer's A or B drive.



drive

A storage place for information for operating applications and the contents of the files you create. Usually, your computer's hard 
drive is drive C. If you have one or two slots for inserting floppy disks, the first slot is usually considered drive A and the second 
drive B. This may vary depending on the type of computer you have and the way it's set up.



export

To copy the information or data from a report into a file. You can then import the file into a tax preparation program, a word 
processor, or a spreadsheet.



field

A single area in a transaction where you enter information, for example, a date or a payee name.



Planning Wizards

Money tools that help you accomplish some of the most common tasks in financial planning.

To use the wizards, click Planning Wizards from Contents, and then click the wizard you want.



frequency

The rate at which recurring transactions take place, for example, weekly or quarterly.



highlight

To select an item by pointing and clicking with the mouse, or by pressing the UP ARROW key or the DOWN ARROW key.



import

To insert a file or piece of data from another application. You can import a file by clicking Import on the File menu.



item

A part of a classification. For example, if you own rental property, you might set up a Property classification with "House at 1000 
High St." and "Apartment on Burton Road" as items.



modem

Short for modulator/demodulator, a communications device that enables a computer to send or receive information over a 
standard telephone line.



Online Bill Payment

One of Money's three Online Services. It lets you pay nearly any individual or business in the U.S. It can be used with any 
checking account in the U.S.



payee

The individual or business a check is written to or from.



postdated check

A check written using a future date.



Online Quotes

A service that lets you electronically download the most recent prices of your investments. If you have Internet access and a web 
browser compatible with Microsoft Internet Explorer, you can use Online Quotes free of charge.



reconcile

The process of verifying that all transactions shown on your statement are properly recorded in Money.



reconciled transaction

A transaction that is listed on a bank statement and has been checked by Money against your records during balancing. In 
Money, the letter R in the C (Cleared) field indicates a reconciled transaction.



Payment Reminder

A Money feature that give you a    message when a transaction you entered in the Payment Calendar is nearly due.



schedule

To assign a transaction to a specific date in the future.



Recurring Payment

A bill or deposit that has been entered in the Payment Calendar area. This feature reminds you when a transaction is due, and 
then lets you enter it automatically into the appropriate account.



Abbreviation

A shorter name you can assign to categories, classifications, accounts, and payees for quick entry.



AutoComplete

A Money feature that automatically fills in a payee, category, classification item, or account name you have used before once you 
start typing.



split

To divide a transaction into two or more parts. You can split a transaction according to existing categories or classifications, or 
you can give each part a separate description.



Split button

Located in the Account Register forms. Choose this button to divide a transaction into two or more parts according to existing 
categories or classifications or to give each part its own description.



subitem

A subset of an item in a classification. For example, if you own rental property, you might set up a Property classification with: 
"Condo at 1000 High St." as an item, and Apartments A, B, and C as subitems; "Apartments on Burton Rd." as another item, and 
Apartments 1, 2, 3, and 4 as subitems.



subcategory

A subset of an income or expense category. For example, for a category called Utilities, you could have a Water subcategory and 
an Electricity subcategory.



AutoComplete+

A Money feature that automatically enters the amount, memo, category, classification, and account fields from the last 
transaction when you enter a payee name you've used before.



transfer

A movement of money between accounts. You can enter a transfer transaction by clicking the Transfer tab in the Account 
Register. By entering a transfer, you only need to enter the transaction once, and it will be recorded in both accounts.



dialog box

A window that displays options for you to review or change things that are specific to what you are currently doing in Money. A 
dialog box is your way of "conversing" with Money.



application

Software designed to help you perform specific tasks. For example, Money is a personal finance application that helps you 
manage your finances, print checks, and use Online Services. There are hundreds of different applications that help you do 
everything from creating spreadsheets to drawing pictures.



annotation

A note or comment you can add to a Help topic by choosing Annotate from the Edit menu of any Help topic.



bookmark

Just as you can place bookmarks in a book to mark specific places, you can place bookmarks in Help topics you use frequently. 
Help puts the titles of those topics in a special list you can read by choosing the Bookmark menu. To enter a bookmark, click 
Define on the Bookmark menu of any Help topic.



title bar

The horizontal bar at the top of the window above the menu that contains the title of the application or dialog box. On many 
windows the title bar also contains the Maximize and Minimize buttons in the right corner.



view bar

The horizontal bar at the top of the Account Register, Payment Calendar, Account Manager, Investment Portfolio, and Payees 
and Categories area that lets you choose what's displayed in the list. Click the triangle to the left of "View:" to see the available 
options.



Transaction

Any deposit, transfer, purchase, withdrawal, or other action you enter in an account.



menu bar

The horizontal bar at the top of the window containing the names of all of the Money menus. The menu bar appears below the 
title bar.



Clipboard

A temporary, invisible storage area for cut or copied information. You can paste the contents of the Clipboard into another 
account or into another Windows application. The Clipboard will hold only one item at a time.



opening balance

The beginning balance for a Money account. Usually, you type a positive number for the opening balance -- even for a Credit 
Card or Liability Account.

Bank Account (includes Savings and Checking)

Ending balance from most recent statement.

Credit Card Account

Ending balance from most recent statement.

Cash or other Account

Amount of cash on hand.

Asset Account

Original purchase cost of asset. (You can later enter an adjustment transaction to compensate for an increase or decrease in 
value.)

Liability Account

Amount you currently owe.

Investment Associated Cash Account

Zero if you plan to enter a transfer transaction for the original cash deposit. Otherwise, enter the amount of the original cash 
deposit.



Associated Cash Account

A Money term for the cash portion (usually a money market) of a brokerage account. You use the cash in this account to buy 
your investments. You can also deposit cash from investment sales and profits into this account.

For example, your Investment Account may consist of stock, some CDs, a T-bill, and $5,000 in the Associated Cash Account.

Associated Cash Accounts have the same name as the Investment Account they are tied to followed by the word "Cash." (For 
example, "Hanson Brothers (Cash)")

When you create a Retirement Account, an Associated Cash Account is created automatically with the same name as the 
Retirement Account it is tied to followed by the word "Contributions." (For example, "Rose's 401(k) (Contributions)")



Associated Contributions Account

A Money term for the cash portion of a Retirement Account. This account holds the cash contributions you make to a Retirement 
Account until you enter the actual purchases. Once you receive your Retirement Account statement, the money will be 
transferred to the Retirement Account to fund your purchases for that statement period.

Associated Contributions Accounts have the same name as the Retirement Account they are tied to followed by the word 
"Contributions." (For example, "Rose's 401(k) (Contributions)")



Investment Account

A Money account type specifically tailored for investment record keeping. Generally, you'll set up one Investment Account for 
each account statement you receive. You'll then add individual investments to this Investment Account.



void

To keep a record of a transaction but not include the transaction amount in the account balance. You can void a transaction 
when, for example, you stop payment on a check.





tax-sheltered annuity

A retirement plan in which contributions are made by nonprofit and public service employees and (sometimes) employers. 
Employee contributions and earnings from a tax-sheltered annuity aren't taxed, but withdrawals are. (This plan is also commonly 
known as a 403(b))



tax-deferred annuity

A retirement plan in which contributions are made by nonprofit and public service employees and (sometimes) employers. 
Employee contributions and earnings from a tax-deferred annuity aren't taxed, but withdrawals are. (This plan is also commonly 
known as a 403(b))



401(k) Plan

A retirement plan into which contributions are made by employees and (sometimes) employers. Employee contributions and 
earnings from a 401(k) aren't taxed, but withdrawals are.



403(b) Plan

A retirement plan in which contributions are made by nonprofit and public service employees and (sometimes) employers. 
Employee contributions and earnings from a 403(b) aren't taxed, but withdrawals are.



amortization

The process of repaying a loan. An amortization schedule shows the division of principal and interest for each payment and the 
principal balance left after each payment.



Annual Percentage Rate

The simple interest rate plus fees or finance charges associated with a loan. The Annual Percentage Rate reflects the true cost 
of a loan.



annual return

Your annual profit on an investment as a percentage of the amount invested. For example, a $1,000 investment that pays $100 
in profits over the year has an annual return of 10 percent. This is a tool for comparing the performance of different investments 
over the same time period. For example, if you want to compare the performance of a six-month CD to a one-year bond, you 
would calculate (annualize) what the same CD would have earned if it were held for one year.



annuity

A contract in which you make a payment or series of payments now and receive a payment or series of payments later. Money 
invested in an annuity grows tax free.



asset

Something you own, such as cash, real estate, stocks, bonds, automobiles, and other items that have measurable value.



ATM

Automated Teller Machine.



balloon payment

The loan principal you still need to pay after the last regular payment. Balloon payments occur because a loan's regular 
payments didn't fully amortize the loan.



bond

An agreement to borrow money, pay interest, and later repay money. Bonds are issued by the government and many 
businesses.



broker

Typically a salesperson who makes a commission by helping execute purchases and sales of stocks, bonds, and other 
investments.



brokerage account

The collection of investments a brokerage company holds for you. Each of your brokerage accounts should be set up as a 
separate Investment Account in Money.



capital gain

The profit you get by selling a stock, bond, or mutual fund for more than you paid.



capital gains distribution

A mutual fund shareholder's portion of the fund's capital gains. Generally, these are paid once a year.



capital loss

The loss you incur by selling a stock, bond, or mutual fund for less than you paid for it.



CD (certificate of deposit)

An investment purchased from a bank. CDs pay interest and can usually be purchased in any denomination greater than $100.



commission

A fee charged by brokers for buying or selling investments.



cost basis

The total purchase price you paid for an investment. The difference between what you sell an investment for and its cost basis 
determines your capital gain or loss.



discounted bond

A bond sold for less than its par (or face) value. If you buy a "$50 savings bond," the face value is $50. However, because 
savings bonds are sold at a discount, you will pay less than $50 for it. All savings bonds and T-Bills are sold at a discount, as 
these investments do not make interest payments to investors. Investors are compensated by the increased value of the bonds 
over time. When redeemed or sold, the profit is treated as interest income.



dividend

The portion of corporate earnings distributed to shareholders. Dividends are taxable, and are usually distributed quarterly.



face value

The redemption value of a bond at maturity.



fractional shares

A partial portion of an individual share of a stock, bond, or mutual fund.



FIFO (First In, First Out)

An assumption that investments are sold in the same order they're purchased. Money assumes all investments are sold on a 
FIFO basis.



Ginnie Mae

The nickname for the Government National Mortgage Association, which is a federal agency that borrows money from investors 
and then lends it to homeowners for mortgages.



inflation

An increase in the price of goods and services.



interest

The cost of borrowed money. Interest payments do not reduce principal.



interest rate

The cost of money, expressed as an annual percentage.



investment

An asset that produces profits. Money supports six main types of investments:
Mutual Funds (except those invested in money market securities)
Money Market Funds (a special type of mutual fund that invests in money market instruments)
Certificates of Deposit (CDs)
Stocks (including foreign currency investments, calls, and puts)
Bonds (including corporate and municipal bonds)
Discounted Bonds (including government savings bonds, zero-coupon bonds, and other investments traded at a 

discount)



IRA (Individual Retirement Account)

A retirement plan in which contributions may be tax deductible, but from which earnings and contributions are taxed when they're 
withdrawn.



Keogh

A retirement plan for the self-employed. Money invested in a Keogh is tax deductible and earnings from the plan are tax 
deferred. Withdrawals from the plan are taxed.



liability

Debts you owe, such as a mortgage or home-equity loan, credit card balance, car loan, student loan, or any other personal loan 
or obligation. Money can track credit card balances with a Credit Card Account and all other liabilities with Loan and Liability 
Accounts.



loan

Money borrowed or lent, usually in exchange for interest. In Money you may want to set up Loan Accounts to track major debts 
on which you make regular payments. For tracking debts that you'll pay off in the near future or with a single payment, you may 
want to use Liability Accounts.



load

A sales commission charged when buying or selling shares in a mutual fund. Some mutual funds don't charge a sales 
commission. These are referred to as no-load mutual funds.



lot

A block of stock or mutual fund shares purchased at the same time. For example, if you purchase 100 shares of Litware, Inc. on 
Jan. 10, and 50 shares of Litware, Inc. on Jan. 11, you would own two lots of Litware, Inc. When securities are sold, Money will 
assume a FIFO (First In, First Out) sale flow. Therefore, if you later sold 50 shares of Litware, Inc. Money will assume half the 
first lot has been sold.



market value

The price a buyer is willing to pay for an asset. Market prices are readily available for most stocks, bonds, and mutual funds.



maturity date

The date at which a bond, note, CD, or loan principal must be repaid.



money market fund

A type of mutual fund that invests in short-term securities, such as T-bills, and earns interest. The fund's share value is usually 
$1.



municipal bond

State or local government-issued debt. Municipal bonds are generally exempt from federal income taxes and most state and 
local taxes, particularly in the state of issue.



mutual fund

A collection of stocks, bonds, and other securities managed by investment professionals but owned by the mutual fund's 
shareholders. When you buy shares in a mutual fund, your money is combined with other investors' money.



net asset value (NAV)

The market value of an asset less liabilities.



net worth

What you own minus what you owe.



offer price

The price at which a security is offered to buyers.



Online Services

Services provided by your bank or financial institution that allow you to do common banking tasks from your computer. 

Money offers three types of Online Services:
Online Bill Payment    Lets you make bill payments from your computer. This works with any checking account in the 

U.S.
Online Banking    Lets you electronically update your bank and credit card records, transfer funds between accounts, 

check your current balances, and order new checks.
Online Quotes    Lets you electronically download the most recent prices of your investments.



opportunity cost

The amount you could have earned on an alternative investment. For example, if you could earn 8 percent on a CD, the 
opportunity cost of investing in stock or something else is 8 percent.



options

The right to purchase or sell something, such as a stock, at a predetermined price at some time in the future.



par value

The value of a bond at maturity. Bonds are usually issued with a $1,000 par value.



percentage unrealized gain or loss

The potential profit or loss on an investment at a point in time stated as a percentage.



preferred stock

Preferred stock receives dividends prior to common stock and has preference over common stock in case of bankruptcy.



principal

What you still owe or are owed on a loan.



RRSP (Registered Retirement Savings Plan)

A Canadian retirement plan that allows you to save on a tax-deferred basis. Amounts contributed to an RRSP are tax deductible, 
and income earned is tax-exempt as long as the funds remain in place. Capital and income from the plan are fully taxable once 
funds are withdrawn from the plan.



realized gain or loss

The actual profit or loss on an investment you sell. (The value of investments can go up or down, but the gain or loss is 
unrealized until the investment is sold.)



reinvestment

Using interest or dividend payments from an investment to purchase more shares of that investment. Retirement plans such as 
401(k) plans are frequently set up to automatically reinvest dividends and interest.



savings bond

U.S. government bonds issued at a discount with face value denominations ranging from $50 to $10,000. When savings bonds 
are redeemed, the difference between purchase price and redemption value is considered interest income. Interest from savings 
bonds is exempt from state and local taxation, and generally no federal tax is due until the bonds are sold.



security

Any investment that has a unit value that can change. Typical securities include stocks, bonds, and mutual funds.



Simplified Employee Pension Plan (SEP)

A pension plan for owners of small businesses and the self-employed. Money invested in an SEP is tax deductible and earnings 
from the plan are tax-deferred.



stock

Shares of ownership in a corporation's earnings, assets, and liabilities. Stockholders may receive dividends and can generally 
sell their shares at any time.



stock dividend

A dividend paid with shares of the issuing company's stock rather than cash. Stock dividends are generally not taxable.



stock split

A transaction where a corporation gives existing shareholders new shares resulting in stockholders owning more shares at a 
lower price. For example, if a company initiates a two-for-one split, it doubles the number of shares each shareholder owns and 
drops the price by half.



stock symbol

The abbreviation for a corporation's stock that is used by brokers when trading. You must have a stock symbol entered for each 
stock you want to use with Online Quotes.



tax-exempt

Investment income that isn't taxed. Be careful not to confuse this with accounts that are "tax-deferred."



tax-deferred

Tax-deferred investments accumulate with no tax liability until withdrawal. Be careful not to confuse this with investments that are 
"tax exempt."



treasury bill (T-Bill)

Money the U. S. government borrows and pays back within one year. T-Bills sell at a discount because they do not make interest 
payments.



treasury bond

Money the U. S. government borrows for more than ten years. Bonds pay interest on a semi-annual basis.



treasury note

Money the U. S. government borrows for two to ten years. Treasury notes pay interest on a semi-annual basis.



unrealized gain or loss

The profit or loss on an investment if it were to be sold at its current price.





Investment Details



Click this to change the investment's name. The name will be changed throughout Money, including in the Update Price dialog 
box and in all transactions using this investment.



The official, market-approved symbol for this investment, which is the way it is listed in newspaper indexes and stock reports.

If you use Online Quotes, this is what Money uses to determine which investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



Choose this if you want transactions from this investment excluded from your tax reports. Be careful not to confuse this with 
accounts that are "tax deferred."



Provides a space for you to enter any comments about this investment. This is just for your own reference.



The par or redemption value of the bond. This is the amount you will be paid when the bond matures. (Bonds are commonly 
issued with a par value of $1,000.)



The date the bond achieves par value. This is only for your reference, and does not affect any Money calculations.



Click this if you want to see the price history of an investment or if you want to manually update the market price of an 
investment.



Click this to enter a split for any of your investments, such as a stock split. When you enter a split, Money adjusts the price and 
quantity to reflect the split. These changes will also be reflected in the Investment Portfolio and in the Update Price dialog box.



Loan Account Details



Click this to change the Loan Account's name. The name will be changed throughout Money, including all transactions using this 
loan.



The number of your Loan Account. You can find this on your loan statement.



A shortcut for this Loan Account. If you type this abbreviation in a field, the full name will be filled in when you move to the next 
field.



Provides a space for you to enter any comments about this account. This is just for your own reference.



Choose this if you want to designate this as a Favorite Account. You'll then be able to go directly to this account at any time from 
the Go To menu in the navigation bar.



Choose this if you want to close this account. Closed accounts retain their transaction history, but don't show up in your account 
lists.



Takes you to the Account Register, where you can enter your Loan Account transactions.



Click this if you want to change any information for this loan, such as the interest rate, loan balance, or other fees.



Investment Account Details



The name and address of the financial institution with which you have this account.



The number of the Investment Account. You can get this number from your brokerage statement.



The name of the person you deal with at this financial institution.



Your contact's telephone number.



Your contact's fax telephone number.



A shortcut for this Investment Account. If you type this abbreviation in a field, the full name will be filled in when you move to the 
next field.



Choose this if you want to designate this as a Favorite Account. You'll then be able to go directly to this account at any time from 
the Go To menu in the navigation bar.



Choose this if you want to close this account. Closed accounts retain their transaction history, but don't show up in your account 
lists.



Takes you to the Account Register, where you can enter your Investment Account transactions.



Takes you to this account's Associated Cash Account details.



Takes you to this account's associated Investment Account details.



Choose this if you want this to be a Retirement Account. With Retirement Accounts, you can use the Update Retirement Account 
Wizard in the Account Register.



Choose this if your employer matches a percentage of your retirement account contributions.



Provides a space for you to enter the category you want assigned to your employer's matching contribution amounts. For 
example, enter Wages & Salary in the Category field and Employer Matching in the Subcategory field.



Provides a space for you to enter the subcategory you want assigned to your employer's matching contribution amounts. For 
example, enter Wages & Salary in the Category field and Employer Matching in the Subcategory field.



Click this if you want to change the category assigned to the employer-matching contributions made to this Retirement Account.



Account Details



Click this to change the account name or type. The name will be changed everywhere this account is used.



The name of this account's bank or financial institution.



The number of your account. You can find this on your bank statement. If this account is set up for Online Services, you'll have to 
go through the Online Services Setup Wizard if you want to change it.



The opening balance you entered when you created this account. If you change this, it will also affect your current balance.



The minimum (or maximum) balance allowed for this account. This is just for your own reference.



A shortcut name for this account. If you type this abbreviation in a field, the full name will be filled in when you move to the next 
field.



Provides a space for you to enter any comments about this account. This is just for your own reference.



Click this to set this account up for use with Online Services or to change your existing Online Services information for this 
account.



Choose this if you want to designate this as a Favorite Account. You'll then be able to go directly to this account at any time from 
the Go To menu in the navigation bar.



Choose this if you want to close this account. Closed accounts retain their transaction history, but don't show up in your account 
lists.



Takes you to the Account Register with this account opened. Click this if you want to add transactions to this account.



Takes you to this account's Home Banking area.



Category Details



Click this to rename the item selected in the navigation bar. The new name will be used in all transactions that have this 
assigned to them.



Click this to create a new subcategory for this category or a new subitem for this classification item.



Lists the subcategories or classification subitems assigned to this category or classification.



A shortcut name for the item selected in the navigation bar. If you type this abbreviation in a field, the full name will be filled in 
when you move to the next field.



Provides a space for you to enter any comments about this item. This is just for your own reference.



Choose this if the transactions assigned to this category or subcategory should be included in your tax reports. For example, if 
the transactions assigned to the category or subcategory are tax deductible, it would be useful to include them in your tax 
reports.



Lists the available tax forms that all transactions using this category or subcategory will be assigned to. This is especially helpful 
if you plan to export your data to a tax software program.



Lists the lines that are available for the tax form chosen above. All transactions with this category or subcategory will be assigned 
this tax form line. This is especially helpful if you plan to export your data to a tax software program.



Provides a space for you to record the copy of the tax form you're using. Most often the number will be 1. However, if you're 
using multiple forms, such as W-2s or Schedule Cs, this number will be greater.



Click this to see your budget or create a budget. Money budgets are based on your spending per category or subcategory.



Payee Details



Click here to change any of the Online Bill Payment information for this payee.



Click here to rename the payee. The name will be changed in all transactions using this payee.



The address for this payee. This is also the address Money will use if you send online payments to this payee. Use the second 
line if you need more room.



The address for this payee. This is just for your own reference.



The address for this payee. This is also the address Money will use if you send online payments to this payee. Use the second 
line if you need more room.



The city of this payee's address. This is also the address Money will use if you send online payments to this payee.



The two-letter abbreviation for this payee's state or province. This is also the address Money will use if you send online 
payments to this payee.



The five- or nine-digit zip code (or 6-digit postal code) for this payee. This is also the address Money will use if you send online 
payments to this payee.



The phone number for this payee. You can also click the Dial button to have Money dial the number for you.



Click here to dial the number for this payee.



If this payee is a business with which you have an account, you can type your account number here. If you send electronic 
payments to this payee, this account number will also appear on the check.



A shortcut for this payee. If you type this abbreviation in a field, the full name will be filled in when you move to the next field.



Provides a space for you to enter any comments about this payee. This is just for your own reference.





To switch between Top Line Only and All Transaction Details view

1 In the Account Register, click the triangle to the left of the register's view bar.

2 Click Top Line Only or All Transaction Details on the list.

Tip
Use Top Line Only view to display more transactions at once and to scroll more quickly through your transactions.



To find a specific transaction

1 On the Tools menu, point to Find, and then click the transaction type you're looking for.

2 In the Find dialog box, click the tab that applies to your search, and then enter your search criteria.

3 Click the Find button.

Money will then display all the transactions, if any, that meet your criteria. If you want to make changes to one of the 

transactions listed, double-click on it.

Tip
Once the search is completed, you can click the Change Category button (if available) to change the category of all 

transactions found by the search.



To sort transactions by date, check number, or entry order

1 In the Account Register, click the triangle to the left of the register's view bar.

2 Click the sort option you want.



To display only unreconciled transactions

1 In the Account Register, click the triangle to the left of the register's view bar.

2 Click Unreconciled Transactions.

{button ,AL("ProcSortingTransactionsByDateNumberorEntryOrder")} See Related Topics





Click this to learn more about Electronic Payment dates.



Click this to learn more about Electronic Transfer dates.



A list of all your categories. Choose the one you want applied to your employer's matching contributions.



A list of all your subcategories. Choose the one you want applied to your employer's matching contributions.



Provides a space for you to type the name you want for this bank.



Click this check box if you don't want to see this information when entering Electronic Payments in the future.



Click this check box if you don't want to see this information when entering Electronic Transfers in the future.



This is a list of transactions that have cleared your bank.



This is a list of the transctions that were sent to Online Services on this connection.



These are the message from Online Services. If you want to save them, click the Save Messages button above.



This is a list of the transctions that were sent to Online Services on this connection.



This is a list of all the transactions downloaded during the connection. Click Update Account Register to add them to your 
Account Register.



Saves this Call Summary information in a text file.



Closes this window. If you want to save your Call Summary information in a text file, click the Save Messages button.



Choose this check box if you never want to be reminded of this again.



Provides a space for you to type the name you want for this Loan Account.



Provides a space for you to type the name you want for this category.



Provides a space for you to type the new name you want for this item.



Provides a space for you to type the name you want for this item.



Provides a space for you to type the name you want for this subitem.



Click this if the transactions assigned to this category increase your account balances.



Click this if the transactions assigned to this category decrease your account balances.



Provides a space for you to type the name you want for this account.



Bank Accounts should be used to track all the accounts at your bank, including checking and savings.



Credit Card Accounts should be used to track all your credit card activity.



Cash or Other Accounts should be used if you want to keep track of cash expenditures, petty cash balances, or other income 
and expenses not included in Bank or Credit Card Accounts.



Asset Accounts should be used for property you own, such as your house or an art collection. To keep records of investments, 
create an Investment Account in the Account Manager.



Liability Accounts should be used for money you owe other than amortized loans. Examples include taxes, short-term loans, or 
money you've borrowed from a friend. For an amortized loan, such as a mortgage, create a Loan Account in the Account 
Manager.



Create New Recurring Payment



Creates a recurring bill, such as a utility payment.



Creates a recurring deposit, such as a paycheck.



Creates a recurring transfer, such as a regular transfer to a credit card account.



New Account Setup Wizard



Provides a space for you to type your account's current balance.



Creates an Associated Cash Account to record any uninvested cash you have in your brokerage account.



Will not create an Associated Cash Account for this Investment Account.



Creates a monthly reminder to pay this bill in the Payment Calendar.



Provides a space for you to type your best guess at your monthly credit card payment. You'll be able to change this before it's 
entered in the Account Register.



The date your next credit card payment is due.



Lists all the accounts you can include in your report.



Provides a space for you to type the name of your account.



Includes all transactions from this account in Money's tax reports.



Does not include transactions from this account in Money's tax reports. Tax-deferred accounts include 401(k)s, IRAs, and SEPs.



The type of account you want to set up. See the description for the highlighted account type below.



Lists the accounts you can move this transaction to.



Lists all your categories, divided by income and expense.



Lists all the accounts you can include in your search. Highlight those you want to include.



Lists all the Loan Accounts you can include in your search. Highlight those you want to include.



Lists all the Loan Accounts you can include in your search. Highlight those you want to include.



Includes all accounts in your search. Choose this to highlight all the accounts to the right.



Includes all your Loan Accounts in your search. Choose this to highlight all the accounts to the right.



Choose this to include closed accounts in the account list to the right.



Choose this to include your closed Loan Accounts in the list to the right.



Choose this to include your closed Loan Accounts in the list to the right.



Limits your search to what's highlighted in the list to the right.



Limits what's displayed to the highlighted Loan Accounts in the list to the right.



Includes all open accounts in your search. Choose this to highlight only the open accounts to the right.



Lists all the categories you can include in your search. Highlight those you want to include.



Includes all categories in your search. Choose this to highlight all the categories to the right.



Limits your search to the categories highlighted in the list to the right.



Highlights all the income categories in the list to the right.



Highlights all the expense categories in the list to the right.



Highlights all the tax-related categories in the list to the right.



Limits your search to transactions that have no category assigned to them.



Displays subcategories in the list so that you can also limit your search to specific subcategories.



Includes all the items in your classification in the search. Highlights all the classification items in the list to the right.



Highlights only the classification items you select in the list to the right.



Limits your search to those transactions that have no classification item assigned to them.



Lists all the classification items you can include in your search. Highlight those you want to include.



Displays subitems in the list so that you can also limit your search to specific subitems.



The transaction date range that will be covered in the search. You can choose an option from the list, or enter specific dates in 
the From and To boxes.



The starting date of the range that will be covered in your search. You can also choose a date range from the list.



The ending date of the range that will be covered in your search.



Lets you choose which type of transactions to include in your search.



Lets you limit your search based on reconciled status of the transactions.



The starting point of the transaction numbers your search is limited to.



The ending point of the transaction numbers your search is limited to.



The starting point of the transaction amount your search is limited to.



The starting point of the transaction amount your search is limited to.



The ending point of the transaction amount your search is limited to.



The ending point of the transaction amount your search is limited to.



Lets you limit your search based on investment activity.



Lets you limit your search based on investment type.



Lists all the payees you can include in your search. Highlight those you want to include.



Uses all the payees in the list to the right in your search.



Lets you limit your search to transactions that are to or from the payees highlighted in the list.



Lets you limit your search based on the reconciled status of the transactions.



Limits your search to those transactions that have no payee assigned to them.



Provides a space for you to type the text or number you want to search for. Money will search through all fields.



Starts the search for the items meeting the criteria you specified above.



Closes this dialog box without saving any changes you have made.



The starting point of the investment transaction amount your search is limited to.



The ending point of the investment transaction amount your search is limited to.



Select Transactions



Choose the investment activities you want included in your report or chart.



Choose if you want to limit your report or chart to show only reconciled or only unreconciled transactions.



The beginning date of the range that will be covered in your report or chart.



The ending date of the range that will be covered in your report or chart.



Provides a space for you to enter the lowest amount of the range that will be covered in this report or chart. If you don't want to 
limit your report or chart by amount, leave this field blank.



Provides a space for you to enter the highest amount of the range that will be covered in this report or chart. If you don't want to 
limit your report or chart by amount, leave this field blank.



Select Investment Activities



Lists all the activities you can include.



Click this to highlight all the investment activities in the list.



Click this to remove the highlight from all activities in the list. You might click this if you selected some items by mistake and want 
to start over.



Zero Transaction dialog



Choose this if you want to return to the transaction and enter a different amount.



Choose this if you want to enter the transaction with the amount as zero.



Choose this if you want to enter the transaction and mark it as void.



Choose this if you want to cancel this transaction and start over.



Click this to print the entire report.



Provides a space for you to enter how many copies of this chart you want to print.



Provides a space for you to enter how many copies of this report you want to print.



Specifies the resolution you want for printing, in dots per inch (dpi). Higher-resolution settings produce higher-quality printing; 
however, your documents may take longer to print.

The resolutions available depend on your printer's capabilities.



Specifies the resolution you want for printing, in dots per inch (dpi). Higher-resolution settings produce higher-quality printing; 
however, your documents may take longer to print.

The resolutions available depend on your printer's capabilities.



Takes you to the Print Setup dialog box, where you can set up another printer, or change your printer properties.



Takes you to the Print Setup dialog box, where you can set up another printer, or change your printer properties.



To print specific pages, type the page numbers.



To print specific pages, type the page numbers.



To print specific pages, type the page numbers.



To organize pages when you print multiple copies of a document, select the Collate check box. A complete copy of the document 
is printed before the first page of the next copy is printed.





Currency List (dlgidOptCurrencies)



Lists the currencies you can work with in Money.



The last exchange rate used for the highlighted currency.



Displays the exchange rate as local units for each foreign unit. Choose the option that describes the exchange rate you know.



Displays the exchange rate as foreign units for each local unit. Choose the option that describes the exchange rate you know.



The last exchange rate used for the currency selected above.



Creates a new currency that will be added to the list.



Deletes the highlighted item from the list.



Lets you rename the highlighted currency.



Displays the exchange rate as local units for each foreign unit. Choose the option that describes the exchange rate you know.



Displays the exchange rate as foreign units for each local unit. Choose the option that describes the exchange rate you know.



Create New Currency dialog



Provides a space for you to type the name you want for the new currency.



Provides a space for you to type the new name you want for the currency. This new name will replace the old throughout Money.



Currency Converter dialog



The amount that is being converted to a different currency.



Lists all the currencies Money supports. If you don't see the one you need, type it in.



Place Details Fields:



Goes to the next Recurring Payment without entering this one into the Account Register.



This is your balance forecast over the coming month based on the Recurring Payments you've entered above. Click this menu 
bar if you want to change which accounts are displayed in this chart.



Enters the Scheduled Payment into your Account Register. You can make any changes you want now.



Creates an income category, such as Wages & Salary or Investment Income.



Creates an expense category, such as Food or Healthcare.



Includes the transactions assigned to this category or subcategory in your tax reports. For example, if the transactions assigned 
to this category or subcategory are tax deductible, they should be included in your tax reports.



Won't include the transactions assigned to this category or subcategory in your tax reports.



Creates a category or classification item. You can also create these when entering transactions by simply typing the new name in 
the appropriate field of the Account Register.



Creates a subcategory or classification subitem. You can also create these when entering transactions by simply typing it in the 
appropriate field of the Account Register.



Provides a space for you to type the name you want for the new item.



Lets you attribute each transaction to a family member so that later you can compare spending habits in reports.



Lets you, for example, track expenses by unit if you have multiple rental properties or multiple apartments, so that later you can 
make comparisons in reports.



Lets you track the expenses for a special project separately from the rest of your records.



Lets you track the expenses for a hobby separately from the rest of your records.



Lets you track your vacation expenses separately from the rest of your records.



Lets you track job expenses separately from your personal expenses.



Provides a space for you to type the name you want for this classification.



Provides a space for you to type the new name you want for this classification. This name will be used wherever the old name 
appeared.



Click this if you want to create your own type of classification.



Provides a space for you to type the name you want for this payee.



Provides a space for you to type the name you want for your new payee.



Lists all your categories or classifications.



Lists all your categories or classifications.



Lists all your subcategories or classification subitems.



Lists the payees that use this same name. Highlight a payee and then use the information displayed to the right to determine 
which one you want.



Specifies if the transactions assigned to this subcategory should appear on your tax reports.



Move Transaction dialog box:



A list of all your existing categories.



A list of all your existing subcategories.



Brings up Money's transaction forms that you can use to enter any transactions that appear on your account statement, but that 
have not yet been entered in Money.





Click this if you want to postpone adding these transactions to your Account Register.



Attaches this Call Summary information to the end of the existing file.



Overwrites the existing file with the new Call Summary information.



Lists all the information that was received during your online call.



Copies your call summary information to the Microsoft Windows Clipboard, so that you can paste it into another program.



Saves your call summary information as a text file for your records.



Lists all the investments for which you've entered a market-approved symbol.

To add investments to the list, highlight the investment in the Investment Portfolio, and then click the Details button and type your 
entry in the Symbol field.



Click here to update the market prices of the investments that have a check in the box to the left of the investment name.



Choose this if the two transactions above actually represent the same transaction.



Choose this if the two transactions above do not represent the same transaction.



Takes you back to the previous dialog box.



Starts the search for the items you specified above.



Returns all the search options to their default settings so that you can do another search.



Takes you to the Report and Chart Gallery and shows an Account Transaction report with all the transactions that pass your 
search criteria.



Takes you to the Change Category dialog box, where you can assign to a different category all the transactions you highlighted 
below.



Change Category dialog box



Click this if you want the selected transactions to have no category assigned to them.



A list of all your categories and subcategories.



Category Options (dlgidOptCategories)



Restores Money's Standard Categories to the list of categories you have to choose from. If you imported the file from another 
program, Money's Standard Categories might not have been added to your list.



Removes all unused categories from your category list.



Asks you for confirmation before removing each unused category after you click the Remove button above.



Displays a warning if you enter a transaction without assigning a category to it.



Displays a warning if you mistakenly enter an Income category for an expense or an Expense category for income.



Editing Options (dlgidOptEditing)



Automatically fills in a previously entered payee name after you have typed one or more characters in the payee field.



Automatically displays the list of categories when you enter the Category field.



Automatically adds the decimal point when you type a transaction amount.



Moves you from one field to the next when you press the ENTER key -- instead of the TAB key.



Automatically opens a new, empty form when you enter a transaction in the Account Register. This can be useful if you're 
entering a lot of transactions at once and don't want to click the New button each time you enter another transaction.



Gives you a selection of customized forms you can use in the Account Register when entering your transactions. Clear this 
check box if you want to enter your transactions directly into the Account Register.



Displays a confirmation before a transaction is entered so you can accept or cancel the entry.



Clear this check box if you don't want Money to make any extra sounds.



Displays a message when you use a new payee, asking if you want to add it to the payee list.



Displays a warning when you try to change a transaction that is already reconciled.



General Options (dlgidOptGeneral)



Click this check box if you want to display forms for entering transactions in the Account Register (instead of displaying only the 
register).



Displays a message when you close Money, asking if you want to create a backup file.



Lists all Money's main areas. Choose the area you want to go to automatically when entering Money. You can also choose to 
automatically go to the last area you used.



Click this check box if you want your on-screen charts to display in color instead of two-dimensional patterns.



Click this check box if you want your reports to print in color instead of two-dimensional patterns.



Lists Money's automated file-backup options.



Payment Calendar Options (dlgidOptPayBills)



The number of days in advance you want to be reminded of pending bills.



Counts only business days in determining when to remind you of upcoming bills.



Day on which you want your calendar week to begin.



Watches for transactions you make repeatedly and asks if you want to add them to the Payment Calendar.



Shows only debited accounts for transfers in the Payment Calendar.



Print Checks Options (dlgidOptPrintChecks)



Displays a message notifying you there are checks to be printed with future dates. You then have the option to print them using 
today's date or to use the original date.



Prints the payee name on checks as the first line in the address field.



Vertical printing offset number. See the instructions below the boxes.



Horizontal printing offset number. See the instructions below the boxes.



Vertical printing offset number. See the instructions below the boxes.



Horizontal printing offset number. See the instructions below the boxes.



Click this if you converted from Quicken and you want to continue printing to the same checks you were using with Quicken.



Currencies Options



Choose this option if you want to be reminded, when you enter Windows, of payments that are coming due.



Choose this option if you would like to password-protect your bill-reminder notification. This will prevent others from being 
notified when your payments are due.



Choose this option if you want to be asked for the bill reminder password once per Windows session. This can save you from 
entering your password repeatedly.



Online Services Options



Prompts you to confirm every transaction Money downloads. This method takes a little more time, but gives you more control 
and enables you to add memos and to categorize each transaction.



The range of dates Money will search through when matching the bank's transaction records with your Money transaction 
records. For example, if you type 30 as the number of days, Money will automatically match transactions that have cleared the 
bank within 30 days of the date you entered for the transaction in Money.



Enters the bank or credit card company's transaction details into the Memos field in your Money records. If you already have an 
entry in the Memo field, the transaction details will be added to it. These details can include the posting date at your bank, the 
address of the ATM, or a description of a bank fee -- whatever the bank chooses to tell you about this transaction.



Specify Date Range (dlgidPayBills)



Adjust Account Balance (dlgidBalOtherAcct)



Begins balancing your account against your statement.



The ending balance of the period for which you're balancing.



The end date of the period for which you're balancing.



Lists the categories you can assign to the adjustment transaction.



Lists the subcategories you can assign to the adjustment transaction.



Account Didn't Balance (dlgidDidntBal)



Returns you to the Account Register to find and fix the problem yourself. You can modify existing transactions, mark them as 
cleared, or add any previously omitted transactions.



Returns you to the Account Register to find and fix the problem yourself. You can modify existing transactions, mark them as 
cleared, or add any previously omitted transactions.



Lets Money try to find the transaction causing the problem.



Automatically adds an adjustment transaction to balance your account.



Automatically adds an adjustment transaction to balance your account.



Finishes balancing without resolving the starting balance difference. If you choose this, you'll probably still have the problem next 
time you balance.



The difference between Money's account balance and the balance you entered from your bank statement.



Lists the categories you can assign to the adjustment transaction.



Lists the categories you can assign to the adjustment transaction.



Lists the subcategories you can assign to the adjustment transaction.



Lists the subcategories you can assign to the adjustment transaction.



Balance Account (dlgidBalance)



The end date of the period covered by the statement.



The beginning balance listed on your statement.



The ending balance listed on your statement.



The service charge listed on your bank statement.



The expense category for your bank's service charge. Typically, this will be Bank Charges.



The expense subcategory for your bank's service charge.



The interest earned or charged on this account. This is probably listed on your account statement.



The category for the interest earned or charged on this account during the balance period.



The subcategory for the interest earned or charged on this account during the balance period.



Completes the balancing process. If there's a remaining balance in step two, you'll be given some options on how to resolve the 
discrepancy.



Saves the balancing information you've entered so far and lets you resume balancing later.



Possible Error (dlgidPossibleError)



The payee for the transaction that might have caused the error.



The amount of the transaction that might have caused the error. Make sure you haven't incorrectly entered the amount or 
misplaced the decimals.



The type of the transaction that might have caused the error.



The cleared status of the transaction. Verify whether the transaction is listed as cleared or uncleared on the statement.



The date the transaction was entered.



Displays the category assigned to the transaction.



Find (dlgidFind)



This is the list of transactions that have met the search criteria you entered above. If you would like to see these transactions 

compiled into a report, click the Create a Report button above.





Spend or Receive (dlgidSpendReceive)



Will result in the amount being SUBTRACTED from your account balance.



Will result in the amount being ADDED to your account balance.



Choose this if you don't want to be notified in the future of any recurring payments you enter.



VISA DLL Context Help



This is a test. If you see this, happiness abounds.



This is a test. If you see this, happiness abounds.







A list of all the transactions that make up this portion of the chart.



Takes you to the Report and Chart Gallery and creates a report based on the transactions listed here.



Provides a space for you to type the name you want for this Favorite Report.



The report type you've selected in the button panel to the left. If you would like to see a different group of reports, click another 
button.



Automatically adjusts the report's columns to the appropriate width.



Adjusts the widths of the columns in your report.



Adjusts the widths of the columns in your report or chart.



Adjusts the widths of the columns in your report or chart.



Adjusts the widths of the columns in your report or chart.



Report: Generic Controls



Dates



Displays more customization options.



The date range that will be covered in your report or chart. You can choose an option from the list, or enter specific dates in the 
From and To boxes.



From



The starting date of the range that will be covered in your report or chart. You can also choose a date range from the list.



To



The ending date of the range that will be covered in your report or chart.



Lists all the accounts you can include in the report or chart.



All Transactions



Includes all transactions from the selected account(s) in the report or chart.



Select Transactions



Lets you choose which transaction to include in the report based on type, payee, status, category, date, number, or amount.



Subtotal By



Lets you choose how you want to group the amounts in your report.



Lets you group your amounts by Investment Account or investment type.



Lets you set a minimum period of time on which your report or chart is based. This makes for more accurate reporting.



Show Splits



Shows the split transaction breakdown for each transaction.



Shows the split transaction breakdown for each loan payment.



Include Fields:



Adds a column to show the loan payment number.



Adds a column to show the terms of all your loans.



Adds columns to show payee, payment amount, and other fees for each loan payment.



Adds columns to show the principal and interest categories for your loans.



Adds a column to show the loan number of each loan.



Shows the payment breakdown by category.



Adds a column to show the balance remaining on each loan.



Adds a column to show if the money from each loan was borrowed or lent.



Adds a column to show the payee of the loan.



Adds a column to show the memo text of each transaction.



Adds a column to show the memo text of each transaction.



Adds a column to show which account each transaction is transferred from.



Adds a column to show which account each transaction is from.



Adds a column to show which account each payment is from.



Adds a column to show all other fees (besides principal and interest).



Adds a column to show your classifications.



Adds a column to show your classifications.



Adds a column to show your classifications.



Adds a column to show your classifications.



Adds a column to show the transaction numbers.



Adds a column to show if each transaction has been cleared ("C") or reconciled ("R").



Adds a column to show the category each transaction is assigned to.



Adds a column to show the classification of each transaction.



Adds a column to show the classification of each transaction.



Choose this if you want the report to display the abbreviations you've entered.



Adds columns to show the opening and current balances of the accounts.



Adds a column to show the bank's name and account number.



Adds a column to show the account limits.



Shows no subtotal breakdown of your balance.



Shows all the payments you've entered so far, plus the remaining amortization for the life of the loan.



Shows all the payments you've entered in Money so far.



Shows the default principal/interest breakdown for the loan, regardless of what payments you've actually entered.



Shows a quarterly breakdown of your account balance.



Shows an annual breakdown of your account balance.



Displays the account's opening balance at the top of the report.



Adds a column to show payment dates.



Adds a column to show payment amounts.



Adds a column to show your principal payment amounts.



Adds a column to show your interest payment amounts.



Shows a column for annual budget amounts (as opposed to monthly totals).



Shows additional columns for a more detailed report.



Choose this if you want to break down your amounts by subcategories (as opposed to just categories).



Lists your choices of column headings.



Sorts your rows in descending order according to the amount. Otherwise, your reports will be sorted alphabetically.



Combines all smaller amounts for cleaner looking charts.



Includes categories that have budgeted amounts but have not been used in any transactions.



Sorts your transactions by actual amounts (as opposed to budgeted amounts).



Sorts your transactions by budgeted amounts (as opposed to actual amounts).



Sorts your transactions in descending order according to the difference between budgeted and actual amounts.



Includes all your Investment Accounts in the report.



Lets you choose which Investment Accounts you want to include in the report.



Includes all your investment transactions in the report.



Lets you choose which investment(s) you want represented in the report.



Specifies if the transactions assigned to this category should appear on your tax reports.



Provides a space for you to type the name you want for this category.



Click this if the transactions assigned to this category increase your account balances.



Click this if the transactions assigned to this category decrease your account balances.



Lists all the Investment Accounts you can include in your report or chart.



Lists all the Loan Accounts you can include in your report or chart.



Adds a column to show the source of each price update.



Gives you a Balance Forecast for the next month.



Gives you a Balance Forecast for the next three months.



Gives you a Balance Forecast for the next six months.



AutoBudget (dlgidAutoBudget)



Lists all your categories, divided by income and expense. Highlight the category or subcatgory for which you want to enter a 
budget amount, and then enter the amount to the right.



The date range that will be used to set your budget amounts. You can choose an option from the list, or enter specific dates in 
the From and To boxes.



The starting date of the range that will be used to set your budget amounts.



The ending date of the range that will be used to set your budget amounts.



Creates your budget based on the options you've entered here.



Rounds your budget totals to the nearest whole dollar.



Rounds your budget totals to the nearest ten dollars.



Rounds your budget totals to the nearest 100 dollars.



Click this if you don't want Money to round your budget totals.



Creates a budget only for categories and subcategories that currently have no budget assigned to them.



Creates a budget for all categories and subcategories.



Creates a budget for specified categories and subcategories.



Creates a budget for the category or subcategory highlighted in the Budget dialog box.



Click this to have Money create a budget for you based on your past records. (To get an accurate budget, you should have at 
least two to three months of records entered.)



Lets you assign a yearly budgeted amount to the category or subcategory highlighted in the list to the left. Click this if you want 
to create a less detailed budget.



Provides a space for you to enter a yearly budgeted amount for the category or subcategory highlighted in the list to the left.



Lets you assign a monthly budgeted amount to the category or subcategory highlighted in the list to the left. Click this if you want 
to create a fairly detailed budget.



Provides a space for you to assign a monthly budgeted amount for the category or subcategory highlighted in the list to the left.



Lets you assign a weekly budgeted amount to the category or subcategory highlighted in the list to the left. Click this if you want 
to create a very detailed budget.



Provides a space for you to assign a weekly budgeted amount to the category or subcategory highlighted in the list to the left.



Choose this if you want to create a more detailed budget. This will let you break down your amounts by subcategory (as opposed 
to category).



Click this if you want to enter a different budgeted amount for each month.

For example, you could assign a higher budget to your Gift category for the month of December if you know you're going to 
spend extra money on holiday gifts.



Provides a space for you to assign a customized monthly budgeted amount to the category or subcategory highlighted in the list 
to the left.



Excludes transfers from the report.



Shows transfers in a separate section of the report and reflects them in net income.



Shows cash inflows and outflows to or from accounts that aren't included in the report.



Customize Tax Report (dlgidTaxSchedReport)



Includes only subtotals and no individual transactions.



Shows every tax-related transaction.



The title of your report. You can change this to anything you want.



The title of your report. You can change this to anything you want.



Creates a very detailed report or chart.



Creates a less detailed report or chart.



Creates a report or chart with no details.



Includes a column for your running balance (in addition to the Amount column).



Begins the Opening Balance column with the total of your prior transactions.



Begins the Opening Balance column with zero.



Includes all payments and deposits in the report.



Includes only payments in the report.



Includes only deposits in the report.



Applies your customizations to the report now displayed.



Returns your report or chart customization to the default settings.



Widths



Sets the column width. If you have trouble fitting your report on one page, choose the Narrow option, or set your printer to use 
landscape orientation.



Fonts



Click this to specify the size and style of the typeface in the report.



Select Categories dialog box:



Removes the highlight from all items in the list. Click this if you selected some items by mistake and want to start over.



Highlights all the items in the list.



Breaks down your amounts by subcategory (as opposed to category).



Choose this if you want your closed accounts to appear in the list to the right.



A list of all your Investment Accounts. Highlight the one you want to include in your report.





Choose a bar chart if you want to compare amounts.



Choose a line chart if you want to see how an amount has changed over time.



Choose a pie chart if you want to see the proportional breakdown of a total.



Charts everything shown in your report.



Charts only the sections of the report you choose.



Lists the sections you can choose to show in the chart.



Displays your amounts side-by-side.



Displays your amounts in a single column. Sometimes, choosing Stacked makes your reports look cleaner.



Labels the slices of your pie chart by percentage.



Labels the slices of your pie chart by dollar amount.



Displays a legend containing a list of symbols and what they represent in your chart.



Displays gridlines as part of the chart.



Clear this option if you want your charts to display flat graphics.



Shows your actual amounts (as opposed to budgeted amounts).



Shows your budgeted amounts (as opposed to actual amounts).



Shows the difference between your budgeted and actual amounts.



Displays more customization options.



Returns your report or chart customization to the default settings.



Applies your customizations to the report or chart now displayed.



Displays your pie chart without labels.



Click this to specify the size and style of the typeface in the chart.





Password



Provides a space for you to type the password for this Money file.



Provides a space for you to type the password for this Money file.



Set Up Category List (dlgidSetupFile)



Backup Reminder (dlgidBackup & dlgidBackupClose)



A proposed name and location for your backup file or the name and location of the last backup file you made. You can accept the 
suggestion or type a different name and location.

Creating a backup file of your work on another disk is an extra precaution against data loss.



Closes this dialog box without creating a backup file.

If you want to change your automatic backup options, click the Options button on this dialog box.



Click this to find the location where you want to store your backup file or to find the name and location of the last backup file you 
made.



Click this to go to the Options dialog box, where you can change or turn off your automatic backup reminder.



Click this if you want to restore the backup to a different file name. This way, your current file will not be replaced.



Archive (dlgidArchive)



Enter the date up to which you want transactions deleted from the current file. Transactions dated the same as, or after, the date 
you enter will not be removed.



Select Import Account (dlgidSelImportAcct)



Creates a new Money account into which the imported transactions can be added.



Creates a new Money Investment Account into which the imported transactions can be added.



Creates a new Money Investment Account into which the imported transactions can be added.



Lists your Money Investment Accounts.



Lists Money's investments you can use for the imported investment displayed above.



A list of your existing Money accounts that the imported information can be added to.



Assign Import Account (dlgidImportAcct)



A list of your existing Money accounts that the imported information can be added to.



Creates a new account with the same name the imported account had previously.



Creates a new account.



Creates a new investment.



Exports your Money data to a file in a format that Money recognizes but that other programs may not. This allows you to merge 
Money files or copy transactions from one Money account to another.



Exports your Money data to a file in a format called QIF (Quicken Interchange Format). This allows you to export your 
transaction data to any application that recognizes QIF format.



Export (dlgidExportAcctType)



Lets you export a non-Investment Account.



Lets you export an Investment Account.



Lists your Money Investment Accounts. Highlight the one you want to export.



Select Export Account (dlgidSelExportAcct)



Lists all your Money accounts. Highlight the account you want to export.



Lists all your Money accounts.



Adjust Split Amount (dlgAdjSplitAmt)



Returns you to the Split Transaction dialog box.



Adjusts the total amount to the sum of the split transaction amounts. Choose this if the initial amount you typed was wrong.



Adjusts each split proportionally to account for the unassigned amount. This is especially useful for allocating sales tax.



Leaves an amount in the split transaction unassigned.



Split Dialog



Enters the split and returns you to the transaction.



Removes everything you've entered in this split.



Closes the Split Transaction dialog box without saving any of the changes you've made.



Click this to receive more information on using the Split Transaction window.



Closes this dialog box without saving any changes you have made.



Closes this dialog box without saving any changes you have made.



Closes this dialog box without saving any changes you have made.



This is the principal/interest breakdown of your loan payment.



This is the itemized breakdown of your paycheck.



This is the Split Transaction dialog box.

You can use split transactions to:
Deposit part of a check and take some of it in cash.
Purchase several items you want to categorize separately.
Itemize a credit card payment.



File Required



Click this if you want to restore a backup file you're saved previously.





New Investment Account (dlgidNewPort)



Creates a new investment, such as a stock, bond, or CD. 

The investment won't actually be part of your portfolio until you enter a buy transaction for it in the Account Register. This way, 
you can track investments you don't actually own without throwing off your records.



Creates an Investment Account.

In Money, Investment Accounts correspond to the brokers with whom you have accounts, and investments are added to 
Investment Accounts.



Opening Cash Account Balance (dlgidCashBal)



The account balance from your latest statement.

If you plan to record all previous transactions for this account, enter zero now and later record the original transfer of cash into 
the account.

If you want to start your investment record keeping on a certain date, enter the account balance from that date. You'll be able to 
change this balance at any time.



Create New Investment (dlgidNewSec)



Choose this to record information about mutual funds, including those that may be invested in stocks and/or bonds.



Choose this to record information about money market funds.



Choose this to record information about certificates of deposit.



Choose this to record information about stock investments, including common and preferred stock as well as options.



Choose this to record information about bonds that distribute regular interest payments, including government securities with 
original maturities greater than one year.



Choose this to record information about bonds purchased at a discount, sometimes known as "zero-coupon" bonds. These 
include government obligations with maturities of one year or less.



New Mutual Fund



Excludes transactions from this mutual fund from your tax reports. Be careful not to confuse this with accounts that are "tax 
deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to identify which investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



New Money Market



Excludes transactions from this money market from your tax reports. Be careful not to confuse this with accounts that are "tax 
deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to identify which investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



New CD



Excludes transactions from this CD from your tax reports. Be careful not to confuse this with accounts that are "tax deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to know what investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



New Stock



Excludes this stock's transactions from your tax reports. Be careful not to confuse this with accounts that are "tax deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to know what investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



New Bond



Excludes this bond's transactions from your tax reports. Be careful not to confuse this with accounts that are "tax deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to identify which investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



The redemption value of the bond. This is the amount you will be paid when the bond matures. (Bonds are commonly issued 
with a face value of $1,000.)



Provides a space for you to enter the maturity date of this bond. The maturity date is the date the bond reaches its face value. 
Enter the date in the format "11/12/97."



New Discounted Bond



Excludes transactions from this bond from your tax reports. Be careful not to confuse this with accounts that are "tax deferred."



Provides a space for you to enter any comments about the investment. This is just for your own reference.



The official, market-approved symbol for this investment, which is the way it would be listed in a newspaper index or stock report.

If you use Online Quotes, these symbols are what Money uses to identify which investment prices to update.

This also serves as a shortcut name that can be used to save time when entering transactions.



The redemption value of the bond. This is the amount you will be paid when the bond matures. (Bonds are commonly issued 
with a par (redemption) value of $1,000.)



Provides a space for you to enter the maturity date of this bond. The maturity date is the date the bond reaches its par value. 
Enter the date in the format "11/12/97."



Modify Investment Account (dlgidModifyPort)



Enables the Associated Cash Account. If you disable the Associated Cash Account, the account will be removed and the transfer 
field for all transfers to or from it will be cleared.



Update Price (dlgidPriceHistory)



Lists all the investments you've entered.



Provides a space for you to enter a date for this price update. Click the arrow next to this field to see a calendar where you can 
quickly choose a date.



Enters the new date and price. The updated information is then added to the list box below and the changes are reflected in your 
reports and in the Investment Portfolio.



Provides a space for you to enter the updated price (per share) of the investment.



Deletes the highlighted price update from the list.



The price history of the investment chosen above.



Investment Categories (dlgidInvCat)



Lists all your transaction categories. Investment activity should generally be categorized as Investment Income.



Lists all your transaction subcategories.



Buy Investment



Provides a space for you to enter the purchase date of this transaction.



Provides a space for you to enter the name of the investment.



Provides a space for you to enter the purchase price (per share) of the investment.



The account to which this investment belongs. If this is a new Investment Account, Money will prompt you for more details and 
set up the new account.



Provides a space for you to enter the name of the investment. If this is a new investment, Money will prompt you to enter the 
investment type and other details.



The price (per share) of the investment.



The total amount of this transaction. This will be calculated automatically.



Provides a space for you to enter any notes you want to make about this investment or transaction.



The number of the check you used to purchase this investment.



The payee name you entered in the Account Register. You can accept the proposed name or change it.



The account that provided the funds for this purchase.



The frequency of this recurring transaction.



The frequency you want for this recurring transaction.



The frequency you want for this recurring transaction.



The first due date of this Recurring Payment.



Provides a space for you to type the number of payments you want to make with this Automatic Payment. Online Services will 
automatically withdraw the necessary funds from your account and pay the bill when it's due for the specified number of 
payments or until the final payment date, whether or not you connect to Online Services.

If you want Online Services to automatically make this payment until you cancel it, leave this and the Date Final Payment is Due 
fields blank.



Provides a space for you to type the final date you want this payment made. Online Services will automatically withdraw the 
necessary funds from your account and pay the bill when it's due until this date, whether or not you connect to Online Services.

If you want Online Services to automatically make this payment until you cancel it, leave this and the Number of Payments fields 
blank.



Buy Investment Split (dlgidBuyInvSplit)



The number of shares you have purchased.



The amount of commission you paid your broker for this purchase.



A list of all the investments you've set up in Money.



The date this stock split took place. You can choose a date from the calendar by clicking the down arrow next to this field.



The ratio of the stock split. For example, if you are entering a two-for-one split, type 2 in the first box and 1 in the second, so that 
it reads: "2 share(s) for every 1 share(s)."



The ratio of the stock split. For example, if you are entering a two-for-one split, type 2 in the first box and 1 in the second, so that 
it reads: "2 share(s) for every 1 share(s)."



Fractional Shares (dlgidFractShares)



Records the fractional shares.



Records only whole numbers of shares. If you choose this option, Money will prompt you to enter the per-unit price of the stock 
after the split.



A list of all your bank accounts. Choose the one in which you want to deposit the remaining cash from the split.



Rename Investment (dlgidRenameSec)



Provides a space for you to type the name you want for this investment.



Provides a space for you to type the name you want for this Investment Account.



Investment Options (dlgidOptInvestments)



Gives you a warning when the transfer field is left blank. Money recommends that when an investment transaction requires or 
produces cash, you transfer the cash from or to another Money account.



Displays bond prices as percentages of their par values. Otherwise, they will display as dollar amounts. Bond prices are 
commonly quoted as percentages.



The amount of time you need to hold an investment until it is considered long term. This can have an impact on your tax records.



Lets you change how your investment transactions are categorized.



A list of all your investments. Highlight the one you want to include in your report or chart.



Provides a space for you to enter the new name you want for this investment. The new name will appear everywhere the old one 
did.



The account to which this investment belongs. If this is a new Investment Account, Money will prompt you for more details and 
set up the new account.



Provides a space for you to enter the name of the investment. If this is a new investment, Money will prompt you to enter the 
investment type and other details.



The number of shares you have purchased.



Provides a space for you to enter the purchase price (per share) of the investment.



The amount of commission you paid your broker for this purchase.



The total amount of this transaction. This will be calculated automatically.



Provides a space for you to enter any notes you want to make about this investment or transaction.



Provides a space for you to enter a date for this price update. Click the arrow next to this field to see a calendar where you can 
quickly choose a date.



Provides a space for you to enter the updated price (per share) of the investment.





Balance Loan (dlgidLoanBalDates)



The starting date of the period covered on your loan statement.



The ending date of the period covered on your loan statement.



The amount of principal you have paid during this balance period.

Accept the amount listed if it matches your loan statement. If it differs, change it to equal the amount on your statement.



The amount of interest you have paid during this balance period. 

Accept the amount listed if it matches your loan statement. If it differs, change it to equal the amount on your statement.



Opens a split transaction dialog box where you can change the amount of other fees.



Adjust Loan Payment Amount (DIDRADPICONT):



Choose this if the total loan payment is correct, but the split amount assigned to principal is incorrect. Typically, you should 
choose this option if you're adding extra principal to a regular loan payment.



Choose this if the total loan payment is correct, and you want the entire payment to go toward principal. Typically, you should 
choose this option when you are making an extra payment. Money will remove any other split amounts and assign the total loan 
payment to principal.



Returns you to the Split Transaction dialog box.



Adjusts the total amount to the sum of the split transaction amounts. Choose this if the initial amount you typed was wrong.



Choose this if you want to delete any changes you made to the loan payment and revert to the regular loan payment. Typically, 
you should choose this option if you've made unintended changes. Money will replace your changes with the regular loan 
payment amount and regular split amounts.



Leaves an amount in the split transaction unassigned.



Adjust Loan Interest (DIDRADPICONT)



Changes the principal and interest amounts so they still equal the total amount of the loan payment, which will not change. This 
is the most common option.



Increases or decreases the interest so that it equals the interest calculated as being due on this date. The total amount of the 
loan payment is adjusted to reflect the change in interest.



Choose this if you don't want to adjust any part of your loan payment.



Update Default Loan Payments (dlgidUpdateLoanPmt)



Makes the changes you made become the new default loan payment for this loan. Other scheduled payments that match the 
default loan payment will also be updated with the changes.



Makes the changes you made become the new default loan payment without updating other scheduled payments.



Enters this payment without changing the default loan payment.





Confirm Printing



Click this if all the checks printed correctly. In each transaction for which you printed a check, the correct check number replaces 
the word "Print" in the Number field.



Click this if the printing was unsatisfactory and you would like to reprint any of the checks using different printer settings.



Lists all the Bank Accounts in which you've set up checks for printing by entering "Print" in the Number field.



Prints a test check to make sure that everything aligns properly.



Prints a test check to make sure that everything aligns properly.



Provides a space for you to type the preprinted check number of the first check loaded in the printer.



Provides a space for you to type the number of checks remaining on the sheet of checks you've loaded.



Provides a space for you to type the preprinted check number of the first check loaded in the printer.



Choose this if the envelope feeder is located in the center of the paper tray.



Choose this if you load the checks from one side of the paper tray.



Choose this if your printer requires that you feed partial sheets with the right edge of the check first.



Choose this if your printer requires that you feed partial sheets with the left edge of the check first.



The number of checks remaining on this sheet. If you're loading a full sheet, leave this blank.



Select Checks (dlgidSelectChecks)



Lists all the transactions that are ready to print.



Highlights all the items in the list.



Removes highlighting from all items in the list. You might click this if you selected some items by mistake and want to start over.



Provides a space for you to type the preprinted check number of the first check loaded in the printer.



Takes you to the Print Checks tab of the Options dialog box, where you can adjust your printing alignment (for Laser checks 
only).



Takes you to the Print Checks tab of the Options dialog box, where you can adjust your printing alignment (for Laser checks 
only).



Takes you to the Print Checks tab of the Options dialog box.



Select Check Type (dlgidCheckType)



Lists the available check types.



Lists the available check types.





Mark Transaction Range as Cleared (dlgidClearRange)



The beginning point of the range of transaction numbers you want cleared.



The end of the range of transaction numbers you want cleared.



Archive Account (dlgArcAcct)



Removes all transactions before the specified date.



Removes only transactions that have been marked as cleared or reconciled. Cleared transactions have a letter "C" in the 
Cleared field; reconciled transactions have an "R" in the Cleared field.



Removes only transactions that have been reconciled.



Doesn't remove any transactions from this account.



Archive Investment Account



Removes all investment transactions before the specified date.



Removes only investment transactions that have been marked as cleared or reconciled. Cleared transactions have a letter "C" in 
the Cleared field; reconciled transactions have an "R" in the Cleared field.



Removes only investment transactions that have been reconciled.



Doesn't remove any investment transactions from this account.



Archive Loan (dlgidArcLoan)



Compensates for the removed transactions by adjusting the opening balance of the Loan Account.



Compensates for the removed transactions by entering a summary transaction for each year.



Compensates for the removed transactions by entering one summary transaction.



Choose this if you prefer that Money not remove any transactions from the Loan Account specified in the dialog box.



Online Services Write Letter options



Choose this if you have any questions about Online Bill Payment.



Choose this to start a payment investigation. Use this if, for example, a payment you sent hasn't been debited from your account. 
Before doing this, highlight the payment on the Payments in Progress tab, and then click the Payment Status button.



Choose this if you have any questions about Online Banking.



Choose this to receive a copy of a processed check in the mail.



Choose this to order new checks you'll receive in the mail.



Provides a space for you to type the name of the person or department to whom you want to direct your letter.



A list of all the accounts you've set up for Online Banking. Choose the one your letter is about.



Provides a space for you to type a short title or subject for your letter.



Provides a space for you to type your question.



Lists your past online payments. Once you send the letter, you will receive a response within the next two days. Remember that 
you will later have to connect to Online Services again in order to receive the response.



Gives you advice on importing your Quicken information into Money.



Click this to create a new Money file. 

Most of the time you'll work with a single file. However, you may want to create an additional file if you're maintaining two 
different sets of accounts, such as one for home and one for a business or charity.



Lists your Money accounts. Choose the one you use to track the account listed above.



Click this if you want to create a new account to track the account listed above.



Click this for more information on choosing the Money account that matches the account listed above.





To enter a transaction

1 From Money's Contents screen, click Account Register.

2 Click the triangle to the left of the account name in the navigation bar, and then choose an account.

3 In the transaction forms at the bottom of the screen, click a transaction tab. (For example, click Check to enter a check you 

wrote.)

4 Fill out the information in each field, or accept the proposed entry.

For additional advice on any field, press the F1 key while in the field.

5 Click the Enter button.

Note
Entering transactions in the Account Register is much like working in your checkbook.
To cancel a transaction you've started but have not yet entered, click the Cancel button.
When you enter a transaction, it is automatically saved and will appear in the register above the form.

{button ,AL("ProcEnteringaTransactionDirectlyintotheRegister;QuickWaystoEnterTransactions")} See Related Topics



To enter a transaction directly into the register

1 Click the triangle on the left of the register's view bar.

2 Click Transaction Forms.

3 Click the first empty line in the register, and then enter your transaction information as usual.

Note
Whether you enter transactions in the forms or directly into the register, the same data is displayed.
Repeat steps 1 and 2 to go back to entering transactions with the forms.

{button ,AL("QuickWaystoEnterTransactions;ProcEnteringaTransaction")} See Related Topics



Quick ways to enter transactions

Using the right mouse button

You can click in any field with the right-mouse button to see what tools are available, such as the Previous Amounts item, which 

lets you enter amounts from any of your previous transactions to the payee you've entered.

Using the plus sign (+) and minus sign (-) keys:

You can increase or decrease the transaction number or date by moving to that field and pressing the plus or minus key. You 

don't need to use the SHIFT key with the PLUS or MINUS key for this to work.

Using abbreviations

If you frequently enter payees, categories, classification items, or accounts with long, similar names, assigning abbreviations in 

the details area makes them easier to enter. The full name will be filled in when you move to the next field.

Using AutoComplete

AutoComplete automatically fills in a payee, category, classification item, or account name you have used before when you start 

typing.

Using AutoComplete+

AutoComplete+ automatically enters the amount, memo, category, classification, and account fields from the last transaction 

when you enter a payee name you've used before.



To use abbreviations

1 In the Account Manager, or in the Payees and Categories area, highlight the item, and then click the Details button at the 

bottom of the screen.

2 Type the abbreviation in the Abbreviation box.

Now, whenever you enter a transaction, you can type the abbreviated term, and Money will replace the abbreviation with the 

full name when you move to the next field or enter the transaction.

Tip
If you use names that are similar, such as Washington Electric, Washington Electrical Supplies, and Washington 

Elementary School, you may want to use abbreviations.



To turn AutoComplete on or off

1 On the Tools menu, click Options.

2 Click the Editing tab.

3 Choose or clear the Use AutoComplete check box.

Tip
AutoComplete helps you quickly type text in a transaction field. It completes an entry as soon as you type enough 

characters for it to be identified.
If you enter a payee that was used in a previous transaction, Money will also enter the information from the last 

transaction that involved that payee. If you want to change the information, just type over it.

{button ,AL("AnAccountNamingStrategy;ProcUsingAbbreviations")} See Related Topics



To enter transactions from a previous month's statement

1 Enter the transaction as you normally would in the Account Register.

2 Once the transaction is entered, hold down the SHIFT key as you click the C (cleared) field in the register to mark the 

transaction as reconciled.

An "R" for "reconciled" appears in the C (cleared) field.

Note
Adjust your account's starting balance so that the balance includes the earliest transaction you entered.

{button ,AL("ProcEnteringaTransaction")} See Related Topics



To enter a deposit less cash

1 In the Account Register, fill out the Deposit transaction form as you would for any transaction.

2 In the Amount field, enter the net deposit (the total amount minus the cash).

3 Click the Split button.

The Amount field in the first part of the Split Transaction box shows the amount of the actual deposit.

4 Change the amount to equal the total amount of the check.

5 Move to the second line of the split transaction.

The Amount field of the second line of the split transaction will contain a negative amount equal to the cash amount you 

withdrew from the check.

6 In the Category field of the second line, enter the name of the category you use for miscellaneous cash.

7 Move to the third line. The Unassigned amount at the bottom of the Split Transaction box should be $0.

Note
The amount you enter in the Deposit field before you split a transaction is unaffected by changes you make in the Split 

Transaction dialog box.

{button ,AL("ProcSplittingaTransactionBetweenMultipleCategories")} See Related Topics



To transfer money between accounts

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and choose the account you 

want to transfer from.

2 Click the Transfer tab on the transaction form.

3 Fill out all the fields in the form.

For additional advice on any field, press the F1 key while in the field.

4 Click the Enter button.

Note
When you make a transfer, you only need to enter the transaction once to credit one account and debit the other.





Use the Category field to assign an income or expense category to this transaction. You can choose one from the list, or type a 
new one.

Categories are the key to organizing your finances. You'll use them to:
See where your money is coming from and where it's going to.
Budget income and expenses and compare budgeted amounts with actual amounts.
Track tax-related income and expenses.



Use the Number field to enter a number for your check transactions.

For transactions such as deposits and automatic teller machine withdrawals, leave the Number field blank, or enter a notation 
such as "deposit" or "ATM."

There's also three options you can choose from the Number field list:
Choose Electronic Payment (Epay) if you want to send this payment electronically through Online Bill Payment. In order to 

do this, you need to have signed up for Online Services.
Choose Electronic Transfer (Xfer) to transfer money electronically between your accounts. (In order to do this, you need to 

have signed up for Online Services, and both accounts must be set up for Online Banking.)
Choose Print This Transaction if you want to print a check for this.



In the Payment Calendar, you can leave the Number field blank until you enter the transaction into the Account Register, or you 
can choose one of the options from the list:

Choose Electronic Payment (Epay) if you want to send this payment electronically through Online Bill Payment. In order to 
do this, you need to have signed up for Online Services.

Choose Automatic Payment (Apay) to create a recurring payment for any monthly bills that have a set amount -- such as 
loan payments. In order to do this, you need to have signed up for Online Bill Payment.

Choose Print This Transaction if you want to print a check for this.



Use the Date field to record the date this transaction was made (or the date it will be made).
To quickly enter a date, type the day of the month and press TAB to move to the next field. Money will fill in the month and 

year for you.
To increase or decrease the date by one day, press the PLUS SIGN (+) or MINUS SIGN (-) key.
When typing in a date, use a slash ( / ) as a separator between month, day, and year. For example, enter May 18, 1996 as 

5/18/96.



Use the Payee field to specify who the payment is coming from or going to. You can choose one from the list of previously 
entered payees, or type a new one. When you leave the Payee field, the values from the last transaction with this payee will be 
entered automatically.

You can generally see a summary of the last five transactions you've sent to a payee by right clicking in the Payee field once 
you've entered the payee, and then choosing Previous Amounts.

If you type a new payee and enter the transaction, that name is automatically added to your list of payees.



Use the Amount field to enter the transaction's payment or deposit amount.



Use the Memo field to record details about a transaction. This is just for your own reference. It won't affect how the transaction is 
recorded.



Use the Description field to record details about a transaction. This is just for your own reference. It won't affect how the 
transaction is recorded.



Use the Subcategory field to further refine (along with categories) how you track your income and expenses.

For example, for the Automobile category, you may want to choose a subcategory of Gasoline, Maintenance, or Payments. You 
can also create a new subcategory by typing it here.



Use the Frequency field to specify how often this recurring payment will be made.

For example, if you pay rent on the first day of every month, you'd choose Monthly for the frequency.



The Loan Payment Number (Pmt Num) field is used to indicate how many loan payments have been entered for this Loan 
Account (including any prior payments you chose to have entered when you set up the Loan Account in Money). The loan 
payment number may be used for coupon numbers if the loan has a payment coupon book. It is not the same as the check 
number or Bank Account transaction number.

The loan payment number does not always indicate the actual number of loan payments you've made over the life of the loan. 
For example, if you set up an existing loan to enter previous payments back only to the first of the year, the payment number will 
not include any payments you made before the first of the year.



Use the Investment field to choose from a list of previously entered investments, or type a new one.

If you create a new investment, it will be added automatically to the Investment Portfolio.



Use the Investment field to choose from a list of previously entered investments, or type a new one.

If you create a new investment, it will be added automatically to the Investment Portfolio.



Use the Activity field to choose the action you are taking with the investment. The activities available in the list are determined by 
the type of investment.



Use the Activity field to choose what action you want to carry out with the investment you chose in the Investment field. The 
activities available in the list are determined by what type of investment you chose.



Use the Quantity field to enter the number of shares you are buying or selling. Money multiplies this by the Price and adds the 
Commission to get the Total for the transaction.

For the Quantity, Price, Commission, and Total fields, you can enter figures for any three, and Money will calculate the fourth 
when you enter the transaction.



Use the Price field to enter the per-unit price of this transaction.

What you should enter depends on the investment type:

Investment 

Type

Enter

Mutual Fund The price per 

share

Money Market $1

CD Doesn't apply

Stock The price per 

share

Bond The price as a 

percentage of 

par value. 

(You can also 

enter it as a 

dollar amount 

if you've 

specified this 

in Money's 

options.)

Discounted Bond The price per 

bond

For the Quantity, Price, Commission, and Total fields, you can enter figures for any three, and Money will calculate the fourth 
when you enter the transaction.



Use the Commission field to enter the amount you paid your broker for the transaction. The commission price will be added to 
the Total for this transaction.

Amounts you enter in the Commission field are not treated as an expense, and are not included in categorized reports or in your 
budget. Money adjusts for commission amounts when calculating capital gains or losses, and commission payments are treated 
as part of the cost basis for the purchase, reducing the total gain.

For the Quantity, Price, Commission, and Total fields, you can enter figures for any three, and Money will calculate the fourth 
when you enter the transaction.



Use the Total field to enter the quantity, times the price, plus the commission for this transaction.

For the Quantity, Price, Commission, and Total fields, you can enter figures for any three, and Money will calculate the fourth 
when you enter the transaction. (This only applies to transactions that have a specific quantity and price.)



Use the Price field to enter the price of this bond.

By default, Money expects you to enter the price as a percentage of par value. For example, if the bond was issued with a 
$1,000 par value, and you purchased it for $1,050, you will enter 105 in the Price field. Money will then use the percentage of par 
value to calculate the total in dollars.

You can find the purchase price in most newspapers or on the confirmation statement sent by your broker. Most newspapers and 
brokers quote bond prices as percentages of their par value.

You can change the setting to display your bond prices as dollar amounts instead of percentage of par value by clicking Options 
on the Tools menu, and then clicking the Investments tab and changing the option.

For the Quantity, Price, Commission, and Total fields, you can enter figures for any three, and Money will calculate the fourth 
when you enter the transaction.



Use the Transfer From/To field to specify which account you want investment proceeds or expenses to go to or come from. For 
accurate record keeping, Money recommends that when an investment transaction requires or produces cash, you transfer the 
cash from or to another Money account. This transfer account is commonly the Associated Cash Account, which is set up to 
handle these sorts of transfers. Its name will already be in the Transfer field.



Use the Transfer From/To field to specify which account you want investment proceeds or expenses to go to or come from. For 
accurate record keeping, Money recommends that when an investment transaction requires or produces cash, you transfer the 
cash from or to another Money account. This transfer account is commonly the Associated Cash Account, which is set up to 
handle these sorts of transfers. Its name will already be in the Transfer field.



Use the Classification field to assign this transaction to one of the classification items or subitems you created in the Payees and 
Categories area. You can either choose one from the list, or create a new one by typing it here.



Click the Enter button to add this transaction to the register.



The Split button lets you divide the transaction amount amongst multiple categories.

You can use split transactions to:
Deposit part of a check and take some of it in cash.
Purchase several items you want to categorize separately.
Itemize a credit card payment.
Itemize your paycheck.



Click the Cancel button to close this transaction and discard any changes you've entered.



If you want to transfer money between accounts, enter the name of the account you're transferring to or from in the Subcategory 
field.

If you use the transaction forms, you can enter a transfer by just clicking the Transfer tab and then choosing the accounts in the 
fields labeled From and To.



Choose the account to which money is being transferred.



If you want to enter a Loan Account payment, enter the name of the Loan Account in the Subcategory field.

When you enter a Loan Account payment from a Money Bank Account, a payment transaction is automatically entered into the 
Loan Account.



Choose Buy Investment in this field if this transaction is a transfer from this account to an Investment Account.



Choose the Loan Account you want this payment to go toward.

When you enter a Loan Account payment from a Money Bank Account, a payment transaction is automatically entered into the 
Loan Account.



Use this field to specify the account you want for this transaction.



Choose Split in this field if you want to assign this transaction to multiple categories/classifications.



Use this field to specify the Investment Account you want for this transaction.



Leave this field empty if you want to split this transaction between multiple categories/classifications.





Money files overview

Every time you enter a transaction, create a new account, or make any other changes, your work is automatically saved -- so 

you don't have to save when quitting.

Most of the time you'll work with a single file. However, you may want to create an additional file if you are maintaining two 

different sets of accounts, such as one for home and one for a charity. If you do this, remember that Money doesn't share 

information between files. If you use more than one file, the reports and charts you create will contain information only from the 

file that is currently open.

Backing up a file

Whether your work is stored in one file or several, you should make frequent backup copies. Then, if you somehow lose or 

destroy the original, you won't lose everything.

Archiving transactions

When you archive your file, Money backs up the complete file for archival reference, and then removes old transactions from 

your working file to keep it to a manageable size.

{button ,AL("ProcCreatingaNewFile;ProcOpeningaFile;ProcBackingUpYourFile;ProcArchivingYourRecords;ProcOpeningaFileFro

maPreviousVersionofMoney")} See Related Topics



The difference between a file and an account

Money uses a single file (usually My Money.mny) to store all your Money data. An account is only one part of this Money data 

file. You can store 63 Loan Accounts, 63 Investment Accounts, and 63 other accounts in one Money file. Money has eight main 

account types: Bank, Credit Card, Cash, Asset, Liability, Loan, Investment and Retirement.

{button ,AL("ProcCreatingaNewFile;AccountsOverview;ProcCreatinganAccount")} See Related Topics



Saving your work

Every time you enter a transaction, create a new account, or make any other changes, your work is automatically saved -- so 

you don't have to save while working or when quitting Money.

Even though saving to your hard disk is automatic, it's still a good idea to back up your file to a floppy disk. Unless you've 

changed the Backup setting, you'll be prompted to back up your file whenever you quit Money.

{button ,AL("ProcBackingUpYourFile")} See Related Topics



To create a new file

1 On the File menu, click New.

2 In the File name box, type a name for the new file and specify where you want the file to be saved.

The file name extension MNY will be added automatically.

3 Click the OK button.

4 Follow the instructions on the screen.

Money then opens your new file and walks you through creating your first account.

Note
You may want to create a new file if you are working with unrelated accounts, such as one for your home and another for 

a charity.
When you create a new file, you can set up a new set of accounts, a new list of categories, and new classifications.
Money doesn't share information between files. If you use more than one file, the reports and charts you create will only 

contain information from the file currently open.



To open a file

1 On the File menu, click Open.

2 Find and highlight the file you want to open.

3 Click the Open button.

Note
When you start each work session, the last file you worked with is automatically opened. If you open a different file, you 

don't have to worry about first saving your work because Money always saves your changes as you make them. However, it's a 
good idea to back up your file regularly.

{button ,AL("ProcOpeningaFileFromaPreviousVersionofMoney")} See Related Topics



To back up your file

1 On the File menu, click Backup.

2 In the Back up file to box, accept the proposed drive and name, or type the drive you want to use, followed by a name for the 

file. For example, type: A:\My Money Backup to back up to a floppy disk in drive A.

3 Click the Back Up button.

To restore a backup file, see Restoring a backup file.

Note
Even though Money automatically saves changes to your files, it's a good idea to make frequent backup copies. It's also 

best to regularly back up your file onto a separate floppy disk and keep it in a safe place so that if your main disk drive crashes and 
you lose data, you'll have a recent backup copy.

You might want to use a different backup disk every other day in case one develops a problem.
Money will remind you to make a backup every time you exit or open a different Money file, unless you turn the backup 

reminder off.

{button ,AL("ProcArchivingYourRecords;ProcChangingtheBackupOption")} See Related Topics



To restore a backup file

Generally, you'll only need to use your backup file if your regular file becomes lost or damaged.

1 On the File menu, click Restore Backup.

2 In the Restore file from box, enter the location and file name of the backup file you want to restore, or click the Browse 

button to find it.

For example, type: A:\My Money backup to back up from a floppy disk in drive A.

3 Click the Restore button.

4 In the Restore Warning dialog box, specify whether you want the backup file to replace your current file, or if you want to 

create a new file. If you click Create New, Money will ask for a new file name, and your existing file will be preserved with it's 

current name.

5 Enter any transactions or other information you've entered since you created the backup file. After that, you can work with the 

file as usual.

Note
If you've made Electronic Payments or downloaded transaction records since you last backed up the file, call the phone 

number listed on the Contact Information tab in the Home Banking area to make sure your records will remain up to date.

{button ,AL("ProcBackingUpYourFile;ProcChangingtheBackupOption")} See Related Topics



To archive your records

1 On the File menu, click Archive.

2 In the Archive dialog box, accept the proposed date, or type the date up to which you want transactions removed from the 

current file, and then click the OK button.

3 In the File name box, accept the proposed name or type a new name for the archive file, and then click the OK button.

4 In the Archive account dialog boxes, choose which kind of old transactions you want removed from your current file, and 

then click the OK button. You'll be asked to do this for each non-Loan Account in the current file.

For each Loan Account, you'll be asked how you want Money to adjust your loan records after the archived transactions are 

removed.

5 After all accounts are archived, you'll be asked if you want to also archive your investment price histories.

Note
When you archive your file, Money backs up the complete file, and then removes old transactions from your working file to 

keep it to a manageable size.
It's a good idea to archive as of the first of the year. That way, it's easier to keep your yearly records separate.

{button ,AL("ProcBackingUpYourFile")} See Related Topics



To quit and back up your file

1 On the File menu, click Exit.

2 In the Back Up dialog box, accept the proposed file name and path, or type a new one, and then click the Back Up button.

Tip
If the backup reminder is off, you can turn it on by clicking Options on the Tools menu. On the General tab, under Backup, 

choose the Remind me to back up option.
You don't need to save your work before quitting Money. Your work is automatically saved when you enter a transaction, 

close a dialog box, or make other changes. However, it's always a good idea to make backup copies of your working file onto a 
floppy disk. Keep the backup copy in a safe place away from your computer.

{button ,AL("ProcArchivingYourRecords;ProcBackingUpYourFile;ProcChangingtheBackupOption")} See Related Topics



To open a file from a previous version of Money

1 On the File menu, click Open.

2 If necessary, choose the drive or directory where the file you want is stored.

3 In the File name box, type the file you want.

4 Before the earlier version's Money file is opened, you're asked if you want to keep a copy of the file in the earlier version's 

format with an ".mnx" extension.

It is recommended that you choose Yes.

Tip
It's a good idea to copy the file into your new Money 5 directory and give it an ".Mny" name extension before opening it in 

Money 5.





To export an account

1 On the File menu, click Export.

2 Choose the format for your exported file.

3 In the Export dialog box, choose the file name of the account you want to export.

Choose the directory and drive where you want to export the file, and then in the File name box, type a name for the file using 

a QIF extension.

4 Choose the type of account you want to export.

5 In the Select Export Account dialog box, highlight the account you want to export.

Money will confirm when the export is complete.

Note
When you export an account, information such as abbreviations and comments is not included.
For information on how to import a QIF file into other programs, consult the program's instructions.

{button ,AL("ProcOpeningAQuickenFileInMoney")} See Related Topics



To resolve ending balance differences after importing a QIF file

This information is only relevant if you've imported individual accounts into Money. This does not apply to you if you've used the 

Converter Wizard for Quicken. For help with that, see Resolving account balance differences following conversion from Quicken.
Check the date range you chose to export.
Update your investment prices in the Investment Portfolio.
Check the accuracy of all transactions that say "Imported information was incorrect" in the Memo field. You can click Find 

on the Tools menu to search for transactions with this text.
Check the signs (negative or positive) of amounts in investment transactions.
Make sure you chose the Accounts List option under Export Items in the QIF Export dialog box (if exporting from 

Quicken).



To import a file into Money

If you want to import from Quicken, see Opening a Quicken file in Money.

1 On the File menu, click Import.

2 In the Import dialog box, read the text at the top of the dialog box.

3 Choose the files you want to import, and then click the Import button.

4 Choose the Money account you want the imported transactions added to, and follow the instructions on the screen.

5 Money will display a message when the import is complete.

Note
For information on how to export a QIF file from another program, consult the program's instructions.
For information on importing an OFC file from a bank, contact the bank.

{button ,AL("ProcOpeningAQuickenFileInMoney")} See Related Topics





First steps to organizing your finances

By now you've probably created a Microsoft Money account. If you haven't already entered your records into a Checking or 

Savings Account in Money's Account Register, that's the next recommended step.

Money is divided into eight main areas that are all accessible from the Contents screen. The best way to start familiarizing 

yourself with the product is to click around the areas and see what you can do. You can always click the question mark in the 

navigation bar to see a list of topics that relate to that area.

Also, keep in mind that using the right mouse button to click on just about any element within Money opens a context menu 

listing everything you can do with that element. For example, if you right-click a check in the Account Register, you can use the 

menu to quickly make it a Recurring Payment by clicking Add to Payment Calendar.

Once you've mastered the basics of working with a single account, you might want to:
Add more accounts, including your Investment Accounts and Loan Accounts, in the Account Manager.
Get set up for Online Banking and Online Bill Payment in the Home Banking area.
Automate your recurring payments in the Payment Calendar.
Set up your investments in the Investment Portfolio.
Create a budget.
Set up a password to ensure privacy.
Protect your records by creating a backup file.

Remember, categories are the key to organizing your finances. Categories and subcategories enable you to keep track of 

income and expenses, create budgets, create reports and charts, and organize your tax records.

For step-by-step instructions on Money's basic tasks, look under Common Tasks in Money's online Help Contents screen.

{button ,AL("GettingHelp")} See Related Topics



To get help

When you need help using Money:
Look in the manual Making the Most of Microsoft Money for an introduction, examples, and overviews.
In any of Money's areas, click the question mark at the top right of the Money screen for help on the things you'll do most 

often in that area.
On Money's Help menu, click Help Topics. Once online Help is displayed, you can always click the Index tab and search 

for your topic of interest.
For help with an item in one of Money's areas or in a dialog box, either click the item with the right mouse button and then 

click the What's This button, or highlight the item and then press the F1 key.



How Money stores your records

You'll enter the details of your financial records (for example, the details about your checks or deposits) into fields in Money. A 

transaction, such as a check or deposit, is made up of several fields.

When you enter a transaction in Money, it's automatically saved on your disk. That's why there's no Save command. You don't 

need one.

You'll enter transactions into accounts, such as Bank, Credit Card, Cash, Asset, Investment, Loan, or Liability Accounts. Transfer 

transactions between two Money accounts are listed in both accounts.

All your transactions and accounts are stored in a single file named My Money.mny. If you want, you can rename the file and 

make backups.

Even though Money automatically saves your records, it's a good idea to make frequent backups and store your backup disk 

safely away from your working copy.

To get more help with Money at any time, click the question mark at the top right of the Money screen.

{button ,AL("MoneyFilesOverview")} See Related Topics





Investment Portfolio overview

The Investment Portfolio shows a summary of your current investment holdings and their values. You can also manually update 

the market prices of your investments here by clicking the Update Price button, or electronically update them by clicking the 

Online Quotes button. (Online Quotes are available free of charge if you have Internet access and a web browser compatible 

with Microsoft Internet Explorer.)

Before using Money's Investment Portfolio, it's important to understand the difference between Investment Accounts and 

investments in Money:
Investment Accounts    provide a place to store your investments. Your first step will be to set up an Investment Account 

for each brokerage statement you receive. For more information, see Creating an Investment Account.
Investments    are added to Investment Accounts. You can have multiple investments in one Investment Account, just as 

you might hold a variety of investments through a single broker.

In Money, Investment Accounts differ from Asset Accounts in that Investment Accounts are tailored to tracking investments that 

have fluctuating market value. Whereas, Asset Accounts are better for keeping records for real estate, valuable collections, and 

personal property.

Use Investment Accounts for:
 Stocks  T-Bonds, T-Notes, and T-Bills
 Bonds  Money Market funds
 CDs  Mutual Funds

For retirement plans, such as Keoghs, IRAs, 401(k)s, 403(b)s, RRSPs, and SEPs, set up a Retirement Account. For more 

information, see Tracking a retirement plan.

After entering your investment transactions in Money, you can study price histories, analyze the market value of your holdings, 

and track gains and losses for tax purposes.

{button ,AL(";ProcEnteringYourCurrentInvestmentHoldings;ProcCreatinganInvestmentAccount;ProcEnteringInterestReceivedDivi

dendsCapitalGainsDistributions;ProcEnteringPurchasesandSales;ProcMakingChangestoanInvestmentTransaction;ProcTracki

ngaRetirementPlan;ProcEnteringaStockSplit")} See Related Topics



To create an Investment Account

1 In the Investment Portfolio, click the New button at the bottom of the screen.

2 In the New dialog box, click A new Investment Account.

3 Follow the instructions on the screen.

Once you've created the account, the next step is to enter your current holdings. For instructions, see Entering Your Current 

Investment Holdings.

Tips
Create an Investment Account for each brokerage or institution in which you have investments. If you receive more than 

one statement from a financial institution, create an Investment Account for each statement. This way, you can more accurately 
compare your investment records with your statements.

For information on setting up retirement accounts such as 401(k)s, 403(b)s, Keoghs, SEPs, Canadian RRSPs, and IRAs, 
see Tracking a Retirement Plan.

Investments you hold personally (rather than through a broker) should be grouped in a single Investment Account.

{button ,AL("ProcTransferringSharesBetweenInvestmentAccounts;InvestmentPortfolioOverview;ProcEnteringYourCurrentInvestm

entHoldings")} See Related Topics



To enter your current investment holdings

Entering your investment portfolio in Money is an involved process. You might want to print this topic and use it as a reference.

1 Make sure you have all your investment records handy.

2 In the Investment Portfolio, click the New button, and then choose A new Investment Account.

3 Click the Next button, and follow the instructions on the screen.

4 Repeat steps two and three for each brokerage that sends you an account statement.

5 Double-click the Investment Account for which you want to enter investments.

If you don't see the Investment Account in the list, and you know you've set it up, choose Portfolio from the view bar drop-

down list.

6 Enter a transaction for each investment purchase, following these guidelines.

If you don't have your purchase records: In the Investment field, enter the name of the investment, and in the Activity field, 

choose Add Shares. Enter the quantity of shares your own.

If you have your purchase records: Enter a separate buy transaction for each lot. For example, if you purchased 100 shares 

of XYZ stock in January and 200 shares of the same stock in March, you should enter two buy transactions with separate 

purchase prices following these guildelines:

Field What to Enter

Date The date you purchased the 

investment

Investme

nt

The name of the investment

Activity Buy

Quantity The number of shares you bought

Price The per-share price of the 

investment

Commiss

ion

The amount your broker charged 

to make the purchase

Total Leave this blank. The total will be 

calculated automatically.

Transfer 

from

The account the purchase money 

came from. If you don't want any 

other accounts to be debited for 

this purchase, delete what's in this 

field.

Memo Anything you want

7 Once all your portfolio records are entered, the Total Portfolio Value listed in the Investment Portfolio should match what you 

have on your statements.

8 You can then update the market price of your investments:

If you use Online Quotes, click the Online Quotes button to electronically update the price of each investment. For more 

information, see Setting up Online Quotes.

You can also manually update the price of your investments by clicking the Update Price button. For more information, see 

Manually Updating Your Market Prices.

{button ,AL("ProcDownloadingMarketPricesWithOnlineQuotes;ProcCreatinganInvestmentAccount;ProcEnteringInterestReceived

DividendsCapitalGainsDistributions;ProcEnteringPurchasesandSales;ProcTrackingaRetirementPlan;ProcEnteringaStockSplit;

ProcVerifyingYourInvestmentRecordsWithaStatement;ProcManuallyUpdatingYourMarketPrices")} See Related Topics



To make changes to an Associated Cash Account

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the cash 

account. (It will be the name of the Investment Account with "Cash" afterward.)

2 Choose a transaction tab. (For example, click the Deposit tab to record an inflow of cash into the account.)

3 Click the New button and enter your transaction.

Note
The Associated Cash Account is the cash portion of a brokerage account.

{button ,AL("ProcTransferringSharesBetweenInvestmentAccounts;ProcDeletinganAssociatedCashAccount;ProcCreatinganAssoc

iatedCashAccount;InvestmentPortfolioOverview")} See Related Topics



To delete an Associated Cash Account

1 In the Investment Portfolio, highlight the Associated Cash Account you want to delete.

2 Click the Delete button.

Caution
When you delete an Associated Cash Account, the account field for all transfers to or from it will be blank.

{button ,AL("ProcCreatinganAssociatedCashAccount;ProcMakingChangestoanAssociatedCashAccount;InvestmentPortfolioOver

view")} See Related Topics



To create an Associated Cash Account

1 In the Investment Portfolio, highlight the Investment Account to which you want to add the Associated Cash Account.

2 Click the Details button.

3 Click the Modify button.

4 Choose the Cash Account Enabled option.

{button ,AL("ProcDeletinganAssociatedCashAccount")} See Related Topics



To enter interest received, dividends, or capital gains distributions

1 Make sure you have your brokerage statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account. (If you haven't yet set up an Investment Account for this, see Creating an Investment Account.)

3 Click the New button in the form below the register.

4 In the Investment field, choose the investment from the list, or type the name of a new investment.

5 Tab to the Activity field and make a choice from the list.

6 Fill out the rest of the fields as appropriate.

Note
Money considers interest received, dividends, and capital gains to be investment income. This income can be taken as a 

profit or reinvested.

{button ,AL("ProcEnteringPurchasesandSales;InvestmentPortfolioOverview;ProcCreatinganInvestmentAccount;ProcEnteringYou

rCurrentInvestmentHoldings")} See Related Topics



To enter investment purchases and sales

If you're setting up your portfolio for the first time, see Entering Your Current Investment Holdings.

1 Make sure you have your brokerage statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account. (If you haven't yet set up an Investment Account, see Creating an Investment Account.)

3 Click the New button in the form below the register.

4 In the Investment field, choose the investment from the list, or type the name of a new investment.

5 Tab to the Activity field and make a choice from the list.

6 Fill out the rest of the fields as appropriate.

{button ,AL("ProcTransferringSharesBetweenInvestmentAccounts;ProcCreatinganInvestmentAccount;InvestmentPortfolioOvervi

ew;ProcEnteringInterestReceivedDividendsCapitalGainsDistributions;ProcEnteringYourCurrentInvestmentHoldings;ProcMakin

gChangestoanInvestmentTransaction;ProcTrackingaRetirementPlan;ProcEnteringaStockSplit")} See Related Topics



To make changes to an investment transaction

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account.

2 In the register, highlight the transaction you want to change, and then click the Edit button.

3 Make your changes.

All changes will be reflected in your reports and in the Investment Portfolio.

{button ,AL("ProcTransferringSharesBetweenInvestmentAccounts;ProcVerifyingYourInvestmentRecordsWithaStatement;ProcEnt

eringInterestReceivedDividendsCapitalGainsDistributions;ProcEnteringPurchasesandSales")} See Related Topics



To enter a stock split

1 In the Investment Portfolio, highlight the investment for which you want to enter a split.

2 Click the Split Shares button.

3 In the Split Shares dialog box, enter the date and ratio for the split.

Money adjusts the price and quantity amounts to reflect the split. These changes are also reflected in the Investment Portfolio 

and the Update Price dialog box.

Note
Once you enter a split, you'll see an "s" next to the purchase price in the Account Register as a reminder that the price has 

been adjusted for the split.

{button ,AL("ProcDeletingaStockSplit")} See Related Topics



To delete a stock split

1 In the Investment Portfolio, highlight the investment for which you want to delete a split.

2 Click the Update Price button.

3 In the Update Price dialog box, highlight the stock split entry from the list at the bottom.

4 Click the Delete button.

Money will then remove the record of the split from the Update Price dialog box and adjust the prices to their pre-split 

amounts.

{button ,AL("ProcEnteringaStockSplit")} See Related Topics



To get a warning when the Transfer field is left blank

1 On the Tools menu, click Options.

2 In the Options dialog box, click the Investments tab.

3 Choose the Require a transfer account for each investment transaction option.

Tip
When an investment transaction requires or produces cash, it is recommended that you transfer the cash to or from 

another Money account.



To display bond prices as dollar amounts

1 On the Tools menu, click Options.

2 In the Options dialog box, click the Investments tab.

3 Under General, clear the Treat bond prices as a percentage of par value option.

Note
Money can display bond prices either as dollar amounts or percentages of their par value. Bond prices are commonly 

quoted as percentages.



To specify when a capital gain or loss is considered long term

1 On the Tools menu, click Options.

2 In the Options dialog box, click the Investments tab.

3 Under Capital gains, make your selection.

{button ,AL("ProcChangingCategoriesAssignedInvestmentActivities")} See Related Topics



To change the categories assigned to investment activities

1 On the Tools menu, click Options.

2 In the Options dialog box, click the Investments tab.

3 Click the Investment categories button.

4 Make your changes.



To verify your investment records with a statement

1 Make sure you have the broker's statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account.

3 In the register, highlight a transaction that matches what's shown on the statement, and then press SHIFT+CTRL+M to mark it 

as reconciled. An "R" appears in the Cleared field. Repeat this for each transaction on the statement.

If you find a discrepancy, change your investment transaction or call your financial institution.

Note
Money's regular balance feature is not available for investments. The reconciled mark is for your reference only.
You should reconcile your account each time you receive a statement. This way you know your records are accurate.



To manually update your market prices

1 In the Investment Portfolio, click the Update Price button.

2 In the Update Price dialog box, choose the investment you want to update. Then, under Update market price, type the new 

date and price.

3 Click the Update button.

A record of the update is then entered in the Investment Portfolio.

Tip
You can electronically update your stock and mutual fund prices at no charge using Online Quotes if you have Internet 

access and a web browser compatible with Microsoft Internet Explorer. For more information, see Setting up Online Quotes.

{button ,AL("ProcDownloadingMarketPricesWithOnlineQuotes")} See Related Topics



Money decimal place rounding rules

Here are some of the standards Money uses in rounding your fractional investment figures.

Field Rounding Rule

Qua

ntity 

and 

Price

When entering the quantity, Money 

rounds to the nearest .000001, and 

stores six digits internally, regardless 

of how many digits are displayed.

Total Money rounds all dollar amounts to 

the number of decimal digits specified 

in your Windows Control Panel in 

Regional Settings under the Currency 

tab.



Loan reports overview

You can choose between two loan reports, depending on what you want to use the report for. You can find both reports in the 

Report and Chart Gallery under What I Owe.
Loan Amortization Report: Shows how future loan payments will be broken into principal and interest. It's based on loan 

information you supply, not on loan payments you've made.
Loan Terms Report: A summary of all your loans and their terms. You can also customize the report to include additional 

information about the loans.



To create a loan amortization schedule

1 In the Planning Wizards area, click Loan Calculator.

2 Enter the terms for the loan, and calculate the unknown value if there is one.

3 Click the Report button.

If you want to see an amortization report for one of your actual loans, see Creating a Loan Amortization Report.

{button ,AL("ProcCreatingaLoanAccount")} See Related Topics



To create a loan report

1 In the Report and Chart Gallery, click What I Owe on the button panel to the left.

2 Highlight Loan Amortization in the list of reports, and then click the Go To button.

{button ,AL("ProcCreatingaLoanAccount;ProcCustomizingaReportorChart")} See Related Topics



Loan Accounts overview

In a Loan Account, you can: 
Keep track of money you borrow or lend.
Get Payment Reminders to enter your loan payments.
See how many payments you've made or received, how many are left, and how much you've paid in principal, interest, 

and other fees.
Prepare for taxes by tracking the interest portion of your payments.

If you borrow money, and your loan is for an asset that adds to your net worth, such as a car or boat, it's a good idea to also set 

up an Asset Account to offset the loan debt.

When you set up a Loan Account, have your loan documents available for reference.

Type of Loan Type of Money 

Account

Loans that have a 

regular payment 

schedule or an 

amortization table.

Loan

Money you owe that 

does not have an 

amortization 

schedule or regular 

payment schedule, 

such as a debt to a 

friend or relative.

Liability

Money owed to you 

that does not have an 

amortization 

schedule or regular 

payment schedule, 

such as a loan to a 

friend or relative.

Asset

Credit card advances 

and credit card 

transactions.

Credit Card

{button ,AL("ProcCreatingaLoanAccount")} See Related Topics



To create a Loan Account

1 Have your loan documents handy.

2 In the Account Manager, click the New Account button.

3 Enter the Bank's name, and then click the Next button.

4 Choose Loan as the account type, and then follow the instructions on the screen.

When setting up a Loan Account, you can omit one value in the calculation section and have Money calculate it for you. For 

example, if you don't know how much the Principal + Interest is, leave it blank. Based on the other numbers you enter, Money 

will calculate it for you.

Note
When you create a Loan Account, you automatically create a loan-payment record, or amortization schedule. Money also 

automatically calculates the principal and interest breakdown of each payment and keeps track of the balance due.

{button ,AL("LoanAccountsOverview;ProcChangingLoanAccountInformation;ProcMakingExtraLoanPayments;ProcBalancingaLo

anAccount;ProcEnteringLoanPayments")} See Related Topics



To change Loan Account information

1 In the Account Manager, highlight the Loan Account, and then click the Account Details button.

If you want to change the loan name, click the Rename button.

2 Click the Change Loan Information button at the bottom, right of the screen.

3 Follow the instructions on the screen.

For additional information, you can use PopUp Help any time you see a question mark in a box on the screen. To use it, 

simply click the Question Mark (?).



To balance a Loan Account

1 Make sure you have your most recent bank statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the Loan 

Account you want.

3 Click the Balance button.

4 Follow the instructions on the screen.

Note
Because lenders may use different interest rate calculations, it's common to have small differences between their records 

and yours.
If you commonly make large adjustments when balancing, some loan information may be incorrect. You may want to 

permanently change your loan information.

{button ,AL("ProcChangingLoanAccountInformation")} See Related Topics



To make extra loan payments

1 In the Account Register, begin entering the extra payment transaction in the account that you usually make payments from 

(typically a checking account).

2 In the Amount field, type the new amount. If you are increasing your regular payment by $50, type the amount plus $50. If you 

are making an additional payment of $50, type 50.

3 In the Category field, choose Loan Payment, and then follow the instructions on the screen.

4 Click the Enter button to enter the transaction.

5 In the Adjust Loan Payment Amount dialog box, click Apply all of the unassigned amount to principal if you're increasing 

the amount of your regular payment. If you're making an extra payment, click Apply the entire loan payment to principal.

{button ,AL("ProcChangingLoanAccountInformation")} See Related Topics



To figure Loan Accounts into your net worth

1 In the Account Manager, create a corresponding Asset Account for each loan financing an asset that increases your net 

worth, such as a house, a vacation property, a rental property, a car, a boat, or other real assets.

2 Enter 0 as the opening balance.

3 In the Asset Account, enter an Increase transaction for the original cost of the asset.

This amount should equal the total cost of the asset at the time of purchase. It might include the down payment plus the loan 

amount plus any other costs.

4 If the current value of the asset is more or less than your cost, enter a transaction in the Asset Account to adjust for the 

difference.

Now your Net Worth Reports will more accurately reflect your finances because the remaining balance on your loans will be 

offset by the amount entered in your Asset Accounts.

{button ,AL("ProcCreatinganAssetAccount")} See Related Topics



To enter loan payments

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the account 

from which your loan payments are made (usually a Checking Account).

2 Click the New button.

3 In the Category field, choose Loan Payment.

4 In the Subcategory field, choose the name of the loan.

The remainder of the loan payment information is then filled in for you.

Tip
If you use the Payment Calendar to remind yourself of loan payments, entering the transaction is nearly automatic. For 

more information, see Using the Payment Calendar to enter your Recurring Payments.

{button ,AL("ProcChangingLoanAccountInformation;ProcEnteringLateFees;ProcCreatingaLoanAccount;ProcMakingExtraLoanPa

yments")} See Related Topics



To enter late fees

1 In the Account Register, begin entering the payment as usual.

2 In the Amount field, enter the payment amount plus the late charges.

3 Enter the rest of the payment information, and then click Enter.

4 In the Adjust Loan Payment Amount dialog box, click Manually change the split amounts in the split dialog box.

5 In the Category field, enter Bank Charges.

6 In the Subcategory field, enter Late Fees.

The unassigned amount at the bottom of the Loan Payment dialog box should then be zero.

7 Click the Done button, and then click Enter.

Note
Late fees generally don't affect the principal and interest portion of your payment. They're simply added to your payment.

{button ,AL("ProcEnteringLoanPayments;ProcChangingLoanAccountInformation")} See Related Topics



To delete a Loan Account

1 In the Account Manager, highlight the Loan Account.

2 Click the Delete button at the bottom of the screen.

Tip
Before deleting a loan, it's a good idea to first back up the file and print a loan report for your records.



The New Loan Account wizard

You can use the Loan Setup Wizard to quickly and automatically create a record of all your loans that have a regular payment, or 

amortization, schedule. Before you start, make sure you have your loan documents available so you can easily find and enter 

accurate information.

For each loan you set up, Money automatically calculates the principal and interest breakdown of each payment and keeps track 

of the balance due. From the Loan Setup Wizard, you can also set up Recurring Payments that will remind you when payments 

are due and make payment entry nearly automatic.

Tip
For help as you work, click the Question Mark (?) buttons on the wizard screen.
While setting up the loan, you can leave one value blank and Money will calculate it for you. For example, if you don't 

know the Principal + Interest amount, leave it blank and Money will calculate it automatically.
When you want to keep track of a non-amortized loan, such as an interest-only loan, a loan to a friend or relative, or a 

credit card advance, you'll need to set up a Liability Account, an Asset Account, or a Credit Card Account. For more information, see 
Loan Accounts Overview.

{button ,AL("ProcEnteringLoanPayments")} See Related Topics



The Change Loan wizard

Since it's common for the terms of a loan to change before the loan is paid off, you can use the Change Loan Wizard to quickly 

and easily update such information as:
The payment amount.
The interest rate (for variable rate loans).
Any other fees associated with your loans, such as property taxes or insurance.
The payee for the loan.

To start the Change Loan Wizard, highlight the Loan Account you want to change in the Account Manger, and then click the 

Change Loan Information button.

Some elements of the Loan Account can't change. For example, you can't change the starting date of the loan or whether the 

money was borrowed or lent. To make these changes, you'll need to delete the account and create a new one.

Tip
If you want to change a single payment for a loan, make the change directly to the transaction when you enter it in the 

Account Register or Payment Calendar. If you have refinanced your mortgage, pay off your current mortgage and create a new 
Loan Account with the new rate.

For help as you work, choose the Question Mark (?) button on the wizard screen.

{button ,AL("ProcCreatingaLoanAccount;ProcDeletingaLoanAccount")} See Related Topics





To troubleshoot your modem settings

1 From Money's Contents screen, click Home Banking.

2 Click the Connect button.

3 In the Call Online Services dialog box, click Dialing Properties.

4 Read through the dialog box and make sure all the right options are selected. If you want to disable Call Waiting, select the 

check box, and then select the dialing code from the drop-down list. If you don't know the correct dialing code for your area, 

contact your telephone company.

5 If you need further help, Click the Windows Start button, and then click Help. Next, click the Index tab, and do a search for 

modems. You should be able to find what you need under setting up or troubleshooting.

Note
ISDN modems, Cable modems, and WinModems do not work with Money. Money requires a connection to a 

communication port, and these modems do not use communications ports in the same way as standard modems.



To track puts and calls

You can enter puts and calls much like any other stock investment. Make sure you create a new investment for each call or put, 

even if you already have an investment set up for the security for which you're buying the call or put.

To enter a put or call purchase

1 Make sure you have your brokerage statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account. (If you haven't yet set up an Investment Account for this, see Creating an Investment Account.)

3 Click the New button in the form below the register.

4 In the Investment field, type a descriptive name for the call or put, such as Call XYZ June 97, and then press TAB.

5 Choose Stock as the Investment type.

6 In the Activity field, enter Buy.

7 In the Quantity field, type the number of shares you are entitled to buy or sell on the call or put.

8 In the Price field, type the purchase price of the call or put.

9 Fill out the rest of the fields as appropriate.

To enter a call or put sale

If the call or put expires without being exercised, just enter a Sell transaction with the price as zero so that your loss is recorded 

accurately.

If you actually sell the option before it expires, just enter a Sell transaction as you would any other.



To track employer-offered stock options

1 Make sure you have all your option records handy.

2 In the Investment Portfolio, click the New button, and then choose A new Investment Account.

3 Follow the instructions on the screen, and give the account a descriptive name, such as Options at $20, where $20 is the 

grant price. Including the grant price will make it easier to track options granted at different prices.

4 When asked if the account has an Associated Cash Account, click Yes, and then leave the Opening Balance field blank in the 

next dialog box.

5 When you finish creating the account, double-click it in the Investment Portfolio.

If you don't see the options account in the list, make sure you've chosen Portfolio from the view bar drop-down list.

6 Enter a new Buy transaction, using the table below as a guide.

Field What to Enter

Date The date you were awarded the 

options

Investme

nt

The name of the stock

Activity Buy

Quantity The number of shares in the 

option grant

Price The per-share grant price of the 

options

Commiss

ion

Zero

Total Leave this blank. The total will be 

calculated automatically.

Transfer 

from

Your Associated Cash Account

Memo Anything you want.

7 Click Enter.

8 If you have been granted multiple stock options, repeat steps 2 through 7 for each grant.

Initially, the Associated Cash Account’s balance will have a value equal to the negative of the option's value, and the account 

value will be zero. The Associated Cash Account’s balance now represents the amount you would have to pay to exercise the 

options and, therefore, is not part of the total value of the grant.

Tips
If you want to track only the value of shares that have vested, type only the number of vested shares in the Quantity field 

when you enter the Buy activity for the stock grant. In the Memo field, type the number of unvested shares for reference. 

When additional shares vest, increase the number of shares in the Quantity field of the original Buy transaction, and subtract 

the corresponding number from the Memo field.
Exclude options accounts that have a negative value from your Net Worth and investment reports. If the stock has gone 

down in value since you were granted it, the option account will show a negative balance. This isn't really the case, since you're not 
obligated to exercise stock options.

{button ,AL("ProcExercisingEmployerOfferedStockOptions;ProcManuallyUpdatingYourMarketPrices;ProcDownloadingMarketPric

esWithOnlineQuotes")} See Related Topics



To exercise employee-offered stock options

When exercising options, you can either sell the stock as soon as you purchase it, or keep the stock you purchase. Follow the 

appropriate procedure below:

If you’re selling the option stock

You need to record the sale, and then "reimburse" your records to account for the exercise price.

1 Make sure you have all your option granting and sale records handy.

2 In the Account Register, go to your options account, and enter a Sell transaction, using the table below as a guide.

Field What to Enter

Date The date of the sale

Investm

ent

The name of the stock

Activity Sell

Quantit

y

The number of shares exercised

Price The per-share sale price

Commi

ssion

Zero

Total Leave this blank. The total will be 

calculated automatically.

Transfe

r to

The account in which you deposited 

the money from the sale.

Memo Anything you want

3 The account to which you transferred the sale proceeds now contains the total sale amount. To subtract the exercise amount, 

figure the amount of cash you spent to exercise the options. You may find this on your statement, but you can also calculate it 

by multiplying the quantity of shares by the grant price.

4 Go to the account where you deposited the sale's proceeds, and enter a transfer to the Associated Cash Account, using the 

following table as a guide.

Field What to Enter

Number Leave this blank

From The account that received the 

proceeds of the sale

Date The date of the sale

To The name of the Associated 

Cash Account

Amount The quantity of shares sold times 

the grant price

Pay to Leave this blank

Memo Anything you want

If you’re keeping the option stock

You will want to move the stock from your option account to another Money account that you use to track stock you own.

1 Make sure you have all your option records handy.

2 In the Account Register, go to your options account and enter a Sell transaction for the number of shares you exercised. 

Choose the Associated Cash Account for the transfer account. The price for the sell should be the exercise price.

3. Go to the account where you want to keep the options, and enter a Buy transaction using the exercise price. Choose the 



Associated Cash Account as the transfer account.



To change your startup location

By default, Money starts on the Contents screen when you first enter the program.

1 On the Tools menu, click Options.

2 On the General tab, under Display, choose the area you want as your startup location.

Money will automatically open to this area the next time you start it.

Tip
If you want to automatically start in the last area you used on your previous use of Money, choose Last Area Used.



To change the category of a set of transactions

1 Go to the Payees and Categories area.

2 Click the Categories button.

3 Highlight the category or subcategory you want to change.

4 Click the Go to Details button.

5 In the transactions list in the lower right of the screen, hold down the CTRL key while clicking the transactions you want to 

change.

6 Click the Change Category button.

7 In the Change Category dialog box, click a new category or subcategory.

{button ,AL("ProcFindingaSpecificTransaction")} See Related Topics



To automatically back up your file when exiting

1 On the Tools menu, click Options.

2 On the General tab, under Backup, choose Back up without reminding me from the drop down list.

Note
Even though Money automatically saves changes to your files, it's a good idea to save backup copies. It's also best to 

regularly back up your file onto a separate floppy disk and keep it in a safe place. If your main disk drive crashes and you lose data, 
you'll have a recent backup copy.

{button ,AL("ProcRestoringaBackupFile;ProcBackingupYourFile")} See Related Topics



To see the next Tip of the Day

Money's Tip of the Day helps you discover lesser-known features and gives you advice on using Money more effectively.

1 On Money's Contents screen, right-click the current Tip of the Day.

2 Click Next Tip.



To choose a Favorite Account

You can choose up to nine favorite accounts, adding them to the Go To menu in the navigation bar. This lets you quickly jump to 

the account at any time.

1 Go to the Account Manager.

2 Right-click the account you want to choose as a favorite, and then click Details.

3 Choose the Favorite account box at the bottom of the screen.

When you click the Go To button you will see the account listed.



To close an account

Close an account in Money if you want to retain the account's transactions, but don't want the accounts to show up in your 

account lists. See Deleting an Account if you want to permanently delete all records of an account.

1 Go to the Account Manager.

2 Highlight the account you want to close, and then click Account Details.

3 Click to select the Account is closed check box.

If you want to permanently delete all records of an account, see Deleting an Account.

{button ,AL("ProcDeletinganAccount")} See Related Topics



To itemize a paycheck deposit

You can enter your itemized paycheck deposits in the Account Register or the Payment Calendar. This procedure assumes you'll 

want to enter it in the Payment Calendar so that your balance forecast will be accurate. If you want to enter it in the Account 

Register, just enter the transaction as you normally would and choose Paycheck in the Category field.

1 Make sure you have your paycheck information handy.

2 In the Payment Calendar, click the New button.

3 In the Create New Recurring Payment dialog box, choose Deposit, and then click Next.

4 When you get to the Deposit form, enter the frequency of your paychecks in the Frequency field.

5 In the Account field, select the account into which you deposit your paycheck.

6 In the Date field, enter the date on the check.

7 In the From field, type Paycheck or the name of your employer.

8 In the Amount field, enter the net amount of your check. (This is the amount you actually get to take home.)

9 In the Category field, choose Paycheck. (It's toward the bottom of the list.)

Money launches the Paycheck Wizard.

10 Follow the instructions on the screen.

If you choose to track deductions, continue through the wizard until you reach the Paycheck dialog box.

11 On the Wages tab, on the same line as the Wages & Salary category, enter your gross pay (the total amount of your pay 

before any deductions are subtracted) in the Amount column.

12 Enter the appropriate information on each tab and watch your totals in the table below to make sure everything matches your 

paycheck stub. Be sure to enter all deductions as positive numbers. Money will deduct these amounts from your total wages.

Once you're done, you can go back to the Paycheck dialog box by going to the transaction and clicking the Split button.

Note
If you make contributions to a retirement account through your paycheck, enter this amount in the Deductions Before 

Taxes tab of the Paycheck dialog box, but do not include your employer's matching contributions. You'll be able to enter this when 
you update the Retirement Account.

Some employers allow you to make post-tax contributions to a retirement account after you've exceeded your pre-tax 
contributions limit. You can enter these contributions on the Deductions After Taxes tab: set the item’s Category to "Transfer," and 
then select the name of your Retirement Contributions Account.



To use Money's drop-down calendars

Money's drop-down calendar is available from any date field. Just click the down arrow next to the field or, using the keyboard, 

click ALT+DOWN ARROW.

Tips
To move ahead or back a month, click the arrows next to the month at the top of the calendar.
To switch to another year, click the month name at the top, and then click the forward or back arrows.



To use Money's drop down calculator

Money's drop-down calculator is available from any amount field. Just click the down arrow next to the field or, using the 

keyboard, click ALT+DOWN ARROW. As soon as you enter your calculation and press the ENTER key or click the equal (=) 

sign, Money puts the resulting number in the amount field.

To cancel a calculation, press the ESC key.



To delete a Recurring Payment

1 In the Payment Calendar, highlight the transaction in the list of Recurring Payments.

2 Click the Delete button.

3 In the Delete Recurring Payment dialog box, choose whether you want to delete all instances of the Recurring Payment or 

just this instance.



** Look for substantial changes in the topic To enter your current investment portfolio, which is in invstmnt.rtf. **



** Look for substantial changes in the topic To restore a backup file, which is in files.rtf. **



** Look for substantial changes in the topic Using the Payment Calendar to enter your recurring payments, which is in 

Schedule.rtf **



To forecast your account balance

1 In the Payment Calendar, enter all your recurring bills and deposits.

For more information, see Using the payment calendar to enter your recurring payments.

2 Look at the Balance Forecast graph to see your projected balance over the coming months. (Click the right arrow next to the 

month on the calendar to see the forecast over a longer period.) This forecast is based on the account's current balance, 

along with all the payments you've entered in the Payment Calendar and all the future-dated payments in the Account 

Register. In order for this forecast to be accurate, you need to have entered all your significant upcoming payments, deposits, 

and transfers in the Payment Calendar.



To add shares to an Investment Account

Use the Add Shares activity if you don't have purchase records, or if you've bought numerous lots of an investment and don't 

want to enter the whole history of purchases.

If you want to enter all purchase records, see Entering purchases and sales (Your investment reports will be more useful if you 

enter all purchase records.) If you're setting up your portfolio for the first time, see Entering your current investment holdings.

1 Make sure you have your brokerage statement handy.

2 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account.

If you haven't yet set up the Investment Account, see Creating an Investment Account.

3 Click the New button in the transaction form below the register.

4 In the Investment field, choose the investment from the list, or type the name of a new investment.

5 In the Activity field, choose Add Shares.

6 In the Quantity field, enter the number of shares you want to add.

{button ,AL("InvestmentPortfolioOverview;ProcEnteringInterestReceivedDividendsCapitalGainsDistributions;ProcMakingChange

stoanInvestmentTransaction;ProcTrackingaRetirementPlan;ProcEnteringaStockSplit")} See Related Topics



To remove shares from an Investment Account

You should only use the Remove Shares activity if you are giving shares away with no capital gain, or you need to make an 

adjustment to your records to match your broker's statements. If you actually want to enter a Sell transaction, see Entering 

purchases and sales.

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the 

Investment Account.

2 Click the New button in the transaction form below the register.

3 In the Investment field, choose the investment from the list.

4 In the Activity field, choose Remove Shares.

5 In the Quantity field, enter the number of shares you want to remove.

{button ,AL("InvestmentPortfolioOverview;ProcEnteringInterestReceivedDividendsCapitalGainsDistributions;ProcMakingChange

stoanInvestmentTransaction")} See Related Topics



To track a retirement plan

1 In the Investment Portfolio, click the New button.

2 Choose A new Investment Account, and then click Next and follow the instructions on the screen.

3 When asked, choose Retirement as the account type and click Next to continue through the wizard.

In addition to the Retirement Account, an Associated Contributions Account is created. This account holds the contributions 

you make to the Retirement Account until you enter the actual purchase information. The easiest way to track these 

contributions is through the Paycheck Wizard. See Itemizing a Paycheck Deposit.

4 When you receive a retirement account statement, go to the Account Register, and switch to the Retirement Account by 

clicking the triangle to the left of the account name in the navigation bar.

5 If you don't know the price of each investment purchase because your statement only gives summary information, click the 

Update Account button to the right of the screen. The Update Account Wizard will then ask you for the purchase information 

for the investments that were bought with your contributions and your employer-matching contributions. (Since you don't know 

every purchase price, Money will enter an average purchase price for the period.)

If your statement shows the details of all your buy and sell activities for the period -- including dates and prices -- you can 

enter Buy transactions as you would with any Investment Account. See Entering purchases and sales.

Notes
If you're currently tracking a retirement plan with an Investment Account, see Turning an existing account into a 

Retirement Account.
If you withdraw funds from your retirement account or change the mix of investments, you'll get more accurate reports if 

you enter the appropriate Buy and Sell transactions yourself before going through the Update Account Wizard.
If your retirement statement doesn't show prices or quantities of shares, when you use the Update Account Wizard, enter 

the number of shares as 1 and enter the total value of your holdings as the price. Money will then automatically calculate the correct 
market value.

If your retirement statement shows the gain/loss for your investments, don't enter it in the Update Account Wizard. The 
wizard will automatically calculate this for you.

If your statement shows interest coming from a distribution of employer-matching funds from those who have left the 
company and forfeited the amount, add it to the dividends field in the Update Account Wizard.

{button ,AL("ProcRollingOveraRetirementAccount;ProcEnteringPurchasesandSales")} See Related Topics



To start the Product Tour

1 On the Help menu, click Product Tour.

2 Follow the instructions on the screen.

Money offers three customized tours: for new users, users of previous versions of Money, and for Quicken users.



To use the Payment Reminder

The Payment Reminder notifies you whenever you have a Scheduled Payment coming due in the Payment Calendar. You will 

receive the reminder regardless of whether you start Money.

Money's Payment Reminder starts automatically when you start your computer. You'll see Money's checkbook icon in the 

Windows taskbar. A red sparkle on the checkbook means there are new bills due. An exclamation point means bills are past due. 

Double-click the icon the see which bills are due, and -- if you want to -- start Money.

The Payment Reminder is on by default. To turn it on or off, follow these steps:

1 Click Options on the Tools menu.

2 Click the Payment Reminder tab.

3 Select or clear the Use the Payment Reminder option.



To use the ENTER key to move between fields

If you prefer to use ENTER, rather then TAB, to move between fields in the Account Register, follow these steps:

1 On the Tools menu, click Options.

2 Click the Editing tab.

3 Under Entry, choose Use Enter key to move between fields.



Changing the Amount for Your Automatic Payments

1

2



To print a report or chart in 3-D Color

1 On the Tools menu, click Options.

2 On the General tab, choose the Print reports and charts in 3-D color option.



To restore Money's Standard Categories

Money provides you with a list of Standard Categories you can use for your transactions. You can change, delete, or add to this 

list at any time. If you want to add or restore Standard Categories to your list of categories, follow the procedure below.

1 On the Tools menu, click Options.

2 On the Categories tab, click the Add button.



To track Investments you don't own

Use this procedure if you want to track the performance of securities you don't own.

1 In the Investment Portfolio, click the New button at the bottom of the screen.

2 In the New dialog box, click A new investment, and then click Next.

3 Choose the type of investment, give it a name, and click Next.

4 If you plan to update the price of the investment with Online Quotes, be sure to enter the official, market-approved symbol for 

the investment in the Symbol field.

To then see the investment in the Investment Portfolio, click the triangle on the left of the view bar, and click Investments.

5 Update the market price of the investment.

If you use Online Quotes, click the Online Quotes button to electronically update the price of the investment. For more 

information, see Setting up Online Quotes.

You can also update the price of the investment manually by clicking the Update Price button.



Quicken Topics: These are all in Quicken.rtf.



To use the Loan Payment dialog box

This dialog box shows the breakdown of your loan payment between principal and interest, which Money calculates for you 

automatically. 

If you manually change this breakdown, Money will bring up the Adjust Loan Payment Amount dialog box, which lets you specify 

how you want to account for the change.



To use the Paycheck dialog box

All the information you'll need to fill out the Paycheck dialog box can be found on your paycheck stub.

1 Start by clicking the Wages tab and entering your gross pay in the Amount column next to Wages & Salary: Gross Pay. (If 

you don't see this category listed, see Restoring Money's Standard Categories.)

2 Click through the rest of the tabs entering all the information that applies to you. Be sure to enter all deductions as positive 

numbers. Money will deduct these amounts from your total wages. When you're finished, the Unassigned amount on the 

bottom left of the dialog box should equal zero and the Paycheck Total should equal the net amount of your paycheck.

If you want to change the paycheck details at any time, click the Split button on the transaction form.

Note
If you make contributions to a retirement account through your paycheck, enter this amount in the Deductions Before 

Taxes tab, but do not include your employer's matching contributions. You'll be able to enter this when you update the Retirement 
Account.

If you make post-tax contributions to a retirement account after you've exceeded your pre-tax contributions limit, enter 
these on the Deductions After Taxes tab: set the item’s Category to "Transfer," and then select the name of your Retirement 
Contributions Account.



To Use the Split Transaction dialog box

You can use split transactions for:
Depositing part of a check and taking some of it in cash.
Purchasing several items that you want to describe and keep track of separately.
Itemizing a credit card payment.
Itemizing your paycheck. (See Itemizing a Paycheck Deposit.)

1 Enter the category, subcategory, description, and amount for each portion of the split.

To move down one line, press ENTER, or double-click the next line.

2 When you're finished, click the Done button. Split is then displayed in the Category field.

If you want to return to the Split Transaction dialog box, just click the Split button again.

Tips
If you have an unassigned amount you want to apportion between all the parts of the split, press the F6 key. For example, 

if you've purchased several items and categorized them in a split transaction, you can apportion the sales tax among all of them.
If you're taking cash back from a deposit, be sure to include a negative sign (-) in front of the cash amount.



Online Services Setup: matching accounts

The purpose of this dialog box is to give you a chance to specify which Money account corresponds to each online account at 

your bank. This is necessary so that downloaded transactions can be matched with any you might have already manually 

entered.

The account names don't necessarily need to match. You're free to call the account anything you want in Money. For example, 

you might have the name "Rose's Checking," whereas the bank will list simply "Checking."

If you've entered an account number in Money, you can use this as a guide to which Money account the downloaded one 

matches.

If you haven't yet set up an account in Money for the account downloaded by the bank, click the New button.



To roll over a retirement account

If you have a retirement account with one company and move to another that offers the same type of retirement plan, you can 

usually "roll over" the money without tax penalties.

1 Switch to the old Retirement Account in the Account Register.

2 Using information from the last account statement, enter transactions with Sell in the Activity field for each of the investments 

in the account. In the Transfer To field, enter the Associated Contributions Account for the new Retirement Account (the one 

you're rolling the money into).

3 Once there's nothing left in the first account, switch to the new Retirement Account in the Account Register by clicking the 

arrow next to the account name in the navigation bar. If you haven’t yet created the new Account, see Creating an Investment 

Account.

4 Using the statement for the new retirement account that shows the rollover, enter transactions with Buy in the Activity field for 

each of the investments in that account. In the Transfer From field, enter the Associated Contributions Account for the new 

Retirement Account. (This will use up the money you transferred into that account in step one.)

5 Go back to the old Retirement Account, and click the Update Account button on the right of the screen. When going through 

the wizard, use the last statement for that account to make sure everything is cleaned up.

6 Return to the new Retirement Account in the Account Register, and click the Update Account button. The wizard will make 

sure everything has been entered correctly.

7 If you are no longer going to be using the old retirement account, you can mark it as closed in the Account Manager. See 

Closing an account.



To transfer shares between Investment Accounts

1 Go to the Account Register, and switch to the first Investment Account.

2 Enter a transaction with Sell in the Activity field. In the Price field, enter the price of the investment on or around the day the 

transfer took place. In the Transfer To field, enter the name of the Associated Cash Account. (If the first Investment Account 

doesn't have an Associated Cash Account, enter the cash account associated with the second investment account.)

3 In the second Investment Account, enter a transaction with Buy in the Activity field. In the Transfer From field, enter the 

name of the Associated Cash Account you used in step two.



To turn an existing account into a Retirement Account

1 Highlight the Investment Account in the Account Manager.

2 Click the Account Details button.

3 Click to select the Retirement Account check box.

For information on using the Retirement Account, see Tracking a retirement plan.





Printing checks overview

Using Money to print checks can save you time when paying bills -- especially if you print multiple checks at once. Money prints 

the check information on special blank checks you can purchase.

If you don't already have blank checks, your first step is to decide which type of checks you want. You can choose from six types, 

depending on your printer. For more information, click Ordering Checks on Money's Help menu.

{button ,AL("ProcPrintingChecks;ProcUsingLaserStandardandLaserWalletChecks;ProcEnteringInformationYouDontWantPrintedo

nChecks;ProcSettingUptoPrintChecks;ProcPrintingaSampleCheck;ProcLoadingBlankChecksinthePrinter")} See Related 

Topics



To set up to print checks or reports and charts

1 On the File menu, point to Print Setup, and then click Report and Chart Setup or Check Setup.

2 In the Printer box, choose the printer you want to use.

If your printer is not in the list, you need to install it in Windows. See your Windows documentation for instructions.

3 If you're setting up to print checks, under Check, choose the type and source.

Note
Changing the printer settings in Money does not change your basic Windows setup for the printer.
Before you start printing checks, make sure you have typed Print in the Number field of the transactions you are printing 

checks for.

{button ,AL("ProcPrintingaReportorChart;ProcPrintingaSampleCheck;ProcPrintingChecks;ProcLoadingBlankChecksinthePrinter")

} See Related Topics



To align the printing on checks

If you're having problems aligning the printing on your checks, it's best to experiment with a sample check.

1 Make sure you've loaded blank checks in the printer and the printer is ready.

2 In the Account Register, switch to the account you'll use to print checks.

Make sure the account contains a transaction in which you've entered Print in the Number field.

3 Click the Print Checks button to the right of your screen.

4 Click the Print Test button. Money will print sample information on the first blank check.

For Laser checks, you can adjust the alignment by clicking Options and then making your changes under Printing 

alignment.

For continuous-feed checks, you'll need to manually adjust the positioning of the blank checks in the printer.

5 After adjusting your printer, repeat to double-check the alignment.

Tip
If you're using continuous-feed checks, and are satisfied with the way the test check prints, you may want to make a mark 

-- or place a piece of tape -- on your printer's case to help you align checks the next time.
If you use a dot-matrix printer and find the fields on your printed checks are not correctly aligned with the preprinted forms, 

make sure your printer is set to print 10 characters per inch.

{button ,AL("ProcSettingUptoPrintChecks;ProcPrintingChecks;ProcLoadingBlankChecksinthePrinter")} See Related Topics



To print checks

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and choose the account from 

which you want to print the checks. (You can print checks only from Checking, Savings, and Bank Accounts.)

2 Enter your transaction as usual, except in the Number field choose Print this transaction from the list.

3 When you're ready to print the check, click the Print Checks button and follow the instructions on the screen.

Tip
If you want to print a sample check to confirm alignment, choose the Print Test button before printing.

{button ,AL("ProcEnteringInformationYouDontWantPrintedonChecks;ProcSettingUptoPrintChecks;ProcPrintingaSampleCheck;Pr

ocLoadingBlankChecksinthePrinter")} See Related Topics



To use laser standard and laser wallet checks

1 On the File menu, point to Print Setup, and then click Check Setup.

2 Under Check, in the Type box, choose either Laser Standard or Laser Wallet.

Standard checks and Wallet checks are not the same as Laser Standard and Laser Wallet checks, so make sure you choose 

the appropriate one.

Note
Laser Standard and Laser Wallet checks were both designed to be used with a Laser printer. Laser Standard checks are 

standard size checks (8.5" x 3.5") and Laser Wallet checks are smaller, wallet-size checks.

{button ,AL("ProcSettingUptoPrintChecks;ProcPrintingaSampleCheck;ProcLoadingBlankChecksinthePrinter;ProcPrintingChecks"

)} See Related Topics



Loading blank checks in the printer

Continuous-feed wallet, standard, or voucher checks:
Load checks the same way you load plain paper.

Single-sheet laser voucher checks:
Load checks the same way you load plain paper. Load each sheet so that the check, not the voucher, enters the printer 

first.

Single-sheet laser standard or laser wallet checks:
You can load these in two ways:

For a full sheet    If the next check to print is on a full sheet (with three blank checks), load it as you would normally load 

stationary or preprinted forms -- so information will print on the correct side of the checks. Your printer's documentation should 

explain how to load preprinted forms.

For a partial sheet    If you are starting with only one or two checks, load it sideways into the printer's manual-feed slot. Be 

sure to leave the strip of blank paper attached to the final check on the sheet.



To enter information you don't want printed on checks

To add information to a field that won't print on checks, type it between curly brackets {    }.

If you use curly brackets in the Payee field, you'll also get more information about the transaction when viewing the register in 

Top Line Only view.

For example, if you're writing a check to a brokerage firm called Acme Brokerage to buy stock XYZ, type: Acme Brokerage{XYZ 

Stock}. XYZ Stock will not print on your checks; however, the full name will appear on reports.





Keyboard shortcuts for entering transactions

Press To

F1 Get help

TAB or 

ENTER

Start entering 

transactions

ALT+BACKS

PACE

or CTRL+Z 

Undo last typing

CTRL+G Return to your 

most recently 

edited 

transaction

CTRL+S Split a 

transaction

CTRL+D Insert today's 

date in Date 

field

PLUS SIGN Increase 

number or date 

by one

MINUS SIGN Decrease a 

number or date 

by one

CTRL+Y Paste 

information from 

same field in 

previous 

transaction

CTRL+M Mark a 

transaction as 

cleared

SHIFT+CTRL

+M

Mark a 

transaction as 

reconciled

ESC Cancel changes

F8 Convert an 

amount to a 

foreign currency 

(the insertion 

point must be in 

an amount field)

CTRL+K Open the 

Windows 

Calculator

CTRL+F Find a specific 

transaction

CTRL+E Add a Recurring 

Payment to the 



Payment 

Calendar from 

the Account 

Register

CTRL+UP 

ARROW

Go to the 

previous 

transaction in 

the Account 

Register.

CTRL+DOW

N ARROW

Go to the next 

transaction in 

the Account 

Register.

CTRL+T Switch between 

Top Line Only 

and All 

Transaction 

Details views in 

the Account 

Register



To calculate your net worth

1 In the Report and Chart Gallery, choose What I Have on the button panel to the left.

2 Highlight the Net Worth report, and then click the Go To Report/Chart button.

Note

Before you can see an accurate Net Worth Report that reflects everything you own and everything you owe, make sure you've 

entered:
All your bank account information, including checking, savings, credit card, and line of credit accounts.
All your investments, including all stocks, bonds, mutual funds, money markets, CDs, and bonds.
All your assets, including homes, rental and vacation property, cars, and boats.
All your loans, including mortgages, student loans, and car loans.
Any other liabilities you have, such as taxes you owe or other non-amortized loans you might have, such as loans from 

friends or relatives.



To use the Windows Calculator

1 On the Tools menu, click Calculator.

2 Enter the first number in the calculation.

3 Choose the operator you want to use in the calculation.

For example, if you want to add numbers, choose the plus sign (+) button.

4 Enter the next number in the calculation.

If you make a mistake, click the Back button (or press the BACKSPACE key) to correct a few digits, or click the Clear Entry 

(CE) button (or press DEL) to clear the entire number.

5 Enter any remaining numbers and operators.

6 Choose the equal sign (=) button.

Tip
You can also press CTRL+K. This is the only way to bring up the calculator if the Split Transaction window is open.



An account naming strategy

Always try to name your accounts so the first few letters are different than any other account; that way AutoComplete can finish 

the name for you after you type only a few letters.

For example, if you have a savings, checking, and credit card account with Anybank, instead of starting each account name with 

the word Anybank, name the accounts Savings Anybank, Checking Anybank, and Credit Card Anybank.

On the other hand, if you have several checking accounts in several different banks, you might want to have the account name 

begin with the bank name.



To quickly delete a transaction

1 In Account Register, highlight the transaction you want to delete.

2 Press the DEL key on your keyboard.

If you want to delete a transaction without getting a confirmation message, press CTRL+DEL.

Tip
If you haven't yet entered the transaction, you can cancel it by simply pressing the ESC key a few times.



To speed up date entry

Enter the day of the month and press TAB. Money will fill in the month and year for you.
Enter the day and month and press TAB. Money will fill in the year for you.
Increase or decrease the date by pressing the PLUS (+) or MINUS (-) sign keys while the date is highlighted.



To move an account to a different file

1 In the file you would like to move information from, click Export on the File menu.

2 Follow the instructions on the screen, and choose the account you would like to move to another file.

3 Open or create the file you'd like to add the exported account to.

4 Import the account you've just exported by clicking Import from the File menu.

5 Delete the account from the first file.



To split a file into two

1 Export each account you want to include in the new file.

2 Create a new file.

3 In the new file, create a new account for each account that you've exported.

4 Import each exported account into the new accounts you've created.

5 Delete the exported accounts from their previous file.

{button ,AL("ProcImportingaFileintoMoney;ProcExportinganAccount;ProcCreatingaNewFile")} See Related Topics



To create two Recurring Payments for payroll checks

Often, if you get paid twice a month, the amount of the two paychecks differs due to variations in your gross pay and taxes 

withheld.

1 Enter the first payment check in the Payment Calendar as you normally would, but choose Twice a month in the Frequency 

box.

2 Enter the next check -- with a different amount -- and choose Twice a month as the frequency again. Be sure to enter the 

correct deposit date in the Date field.

For more information on entering your payroll ckeck, see Itemizing a paycheck deposit.



To keep track of reimbursable expenses

1 In the Account Manager, create an Asset Account called Expense Report, and enter zero as the account balance.

2 When you have a reimbursable expense, enter it as a transfer from the account (Checking, Credit Card, or Cash) to Expense 

Report.

3 When you're reimbursed, enter a deposit for that amount in the appropriate account (Checking, Credit Card, or Cash), and 

then enter Transfer in the Category field and Expense Report in the Subcategory field.

Once you've received reimbursement for all your expenses, the balance of the Expense Report account should be zero.



To record home improvements

1 Make sure you've set up an Asset Account for the house with the purchase price of the home as the starting balance.

2 In your Checking Account, enter the payment transaction for the improvement as a transfer to the house Asset Account.

For example, you could enter the payment you made at the hardware store as a transfer from your Anybank Checking Account 

to your Home Asset Account.

Money enters the payment as an increase in the house account.

Tip
Keeping records of the improvements you make to your home is important for tax preparation, insurance planning, and 

figuring your net worth.

{button ,AL("ProcTransferringMoneyBetweenAccounts;ProcSettingUpaRentalPropertyClassification;ProcCreatinganAssetAccoun

t")} See Related Topics



Microsoft Money limits

Here are some Microsoft Money limits. Use them to plan how you organize and enter your financial information.

You can 

have up to

63 Non-Loan or Investment 

Accounts per file

63 Loan Accounts per file

63 Investment Accounts per file

253 Categories and subcategories 

per file

2 Classifications per file

255 Items and subitems for each 

classification

50 Favorite reports

9 Digits in the amount fields of all 

windows.

For example, you can enter a 

transaction amount for 

$9,999,999.99 but not 

$10,000,000.00. If you do have 

a transaction amount that 

exceeds this limit, you can 

divide it into two transactions.

44 Currency list items per file

32,765 Payees per file.

32,675 Transactions (or investments) 

per file.

You would have to enter 100 

transactions per month for 27 

years without archiving to reach 

this limit. Splits are considered 

transactions in this calculation.

Money accepts dates between

January 1, 1948 - December 31, 2075

To use the view bar

In the Account Register, Payment Calendar, Account Manager, Investment Portfolio, or Payees and Categories area, click the 

triangle on the left of the bar that says "View: selected item." Then, on the list that drops down, click the item you want to see.

Tip
Use the view bar, for example, in the Investment Portfolio to display either your entire portfolio, or a list of all the 

investments you're tracking (including those you don't own). You can also use it in the Account Manager to view all your account 
balances in one place.



To open Money's Sample.mny file

Money's Sample.mny file contains a family's financial records for a two-year period. You can use it to experiment with Money 

before entering your own data. This way you can see Money's full reporting, charting, budgeting and bill paying capabilities right 

from the start.

1 On the File menu, click Open.

2 Highlight the file Sample.mny.

3 Click the Open button.

4 Click around the different areas and see what a typical file looks like once a couple years' of information is entered.

It's especially helpful to take a look in the Payment Calendar, Report and Chart Gallery, and Home Banking areas.





Report and Chart Gallery overview

The Report and Chart Gallery lets you see a summary view of your financial status so that you can spot trends and provide 

others with information through printing and exporting. Money comes with 26 reports and charts grouped into five areas:
Spending Habits
What I Have
What I Owe
Investments
Taxes

You can customize any of Money's reports to show exactly what you want. You can also save up to 50 reports and charts to a list 

of favorites, so that you can store in one place all the reports you go to most often or those you've customized to show exactly 

the information you're most interested in. For more information, see Saving a Report or Chart to Your List of Favorites.

{button ,AL("ProcExportingaReporttoaWordProcessororSpreadsheetProgram;ProcPrintingaReportorChart;ProcSavingaReportor

CharttoYourListofFavorites;ProcExportingaReport;ProcCopyingaReportorChart;ProcViewingaReportorChart;ProcChangingthe

FontsinaReportorChart;ProcCustomizingaReportorChart")} See Related Topics



To view a report or chart

1 In the Report and Chart Gallery, choose the type of report or chart you want from the button panel on the left.

2 Highlight the report or chart in the list. (You can see a description of the highlighted report below the list.) Then click the Go To 

Report/Chart button.

3 To switch from a report to a chart, click the Chart button at the bottom of the screen. To switch back, click the Report button.

Tip
If the information in the report or chart is not exactly what you want, click the Customize button and make changes.

{button ,AL("ReportandChartGalleryOverview;ProcPrintingaReportorChart;ProcSavingaReportorCharttoYourListofFavorites;Proc

ExportingaReport;ProcCopyingaReportorChart;ProcChangingtheFontsinaReportorChart;ProcCustomizingaReportorChart")} 

See Related Topics



To change the fonts in a report or chart

1 While viewing the report or chart, click the Customize button.

2 Click the Fonts button.

3 Choose the font and size you want.

In the Sample box, you can see what the letters will look like.

Note
When you change the font, both the titles and labels are affected.

{button ,AL("ProcAdjustingtheReportColumnWidth")} See Related Topics



To customize a report or chart

1 While viewing a report or chart, click the Customize button.

2 Choose the options you want in the Customize dialog box. To change the column widths of a report, click the Widths button. 

If you want to change the style and size of the letters and numbers, click the Fonts button.

3 If the report or chart is not exactly what you want, try further customization.

Your customized format will automatically be saved, which means Money will save the report structure, but not the information 

in the report. When you view a customized report in the future, it will contain up-to-date information -- not necessarily the same 

information it contained when you last viewed it.

Tip
To view a report being built as you customize it, click the Apply button.
To return a report to its default settings, click the Reset button.

{button ,AL("ProcChangingtheFontsinaReportorChart;ProcAdjustingtheReportColumnWidth")} See Related Topics



To copy a report or chart

1 Create the report or chart.

2 On the Edit menu, click Copy.

You can then open another Windows application, such as Microsoft Word for Windows, and paste in the report or chart.

{button ,AL("ProcViewingaReportorChart;ProcExportingaReport;ProcPrintingaReportorChart")} See Related Topics



To export a report

1 While viewing your report, click the Export button.

2 Follow the directions in the Export Report dialog box.

Note
Once you've exported a report, you can then open the file in a word processor or spreadsheet program. In a word 

processor, the report will have a tab character between the columns of data in each row, and a paragraph mark at the end of each 
row. In a spreadsheet application, the data will be organized into columns and rows.

For information on exporting a Tax Software Report, see Exporting to a tax preparation program.



To export to a tax-preparation program

1 In the Report and Chart Gallery, click Taxes on the button panel to the left.

2 Highlight Tax Software Report, and then click the Go To Report/Chart button.

3 Click the Export button.

4 Follow the directions on the screen.

The information from your report is ready for use with your tax preparation program. Next, start the tax preparation program, 

and then import the file you just created. For more information on importing, see the documentation for your tax preparation 

program.

Tip
Before you export your tax information for use with a tax preparation program, you'll probably want to assign a tax form 

line to each tax-related category or subcategory in the Payees and Categories area.

{button ,AL("ProcTrackingTaxInformationUsingCategories;ProcAssociatingaCategoryorSubcategoryWithaTaxFormLine;Preparing

forTaxTime")} See Related Topics



To adjust the report column width

1 While viewing your report, click the Customize button.

2 In the Customize Report dialog box, click the Widths button.

3 Click the option you want.

{button ,AL("ProcChangingtheFontsinaReportorChart")} See Related Topics



To view a favorite report or chart

1 In the Report and Chart Gallery, click the My Favorites button on the button panel to the left.

2 Highlight the report or chart you want to see, and then click the Go To Report/Chart button.

{button ,AL("ProcDeletingaFavoriteReportorChart;ProcRenamingaFavoriteReportorChart;ProcSavingaReportorCharttoYourListof

Favorites")} See Related Topics



To delete a favorite report or chart

1 In the Report and Chart Gallery, click My Favorites on the button panel to the left. 

2 Highlight the favorite report or chart you want to delete.

3 Click the Delete button.

{button ,AL("ProcViewingaFavoriteReportorChart;ProcRenamingaFavoriteReportorChart")} See Related Topics



To rename a favorite report or chart

1 In the Report and Chart Gallery, go to the report or chart you want to rename.

2 Click the Customize button (and then click the More Options button if you're viewing a chart).

3 In the Title box, type the new name.

{button ,AL("ProcViewingaFavoriteReportorChart;ProcDeletingaFavoriteReportorChart;ProcSavingaReportorCharttoYourListofFa

vorites")} See Related Topics



Saving a report or chart to your list of favorites

1 First create and customize the report you want in the Report and Chart Gallery.

2 Click the Add to Favorites button on the bottom, right of your screen.

3 In the Add to Favorites dialog box, accept or change the proposed name.

The report is then added to the list of favorite reports.

Tip
You can save up to 50 reports under My Favorites. If the report has been customized, Money saves the report structure, 

but doesn't save the information in the report. When you view a customized report, it will contain up-to-date information -- not 
necessarily the same information it contained when you last viewed it.

{button ,AL("ProcViewingaFavoriteReportorChart;ProcDeletingaFavoriteReportorChart;ProcRenamingaFavoriteReportorChart")} 

See Related Topics



To create a Loan Amortization report

1 In the Report and Chart Gallery, click What I Owe on the button panel to the left.

2 Highlight Loan Amortization, and then click the Go To Report/Chart button.

Note
A Loan Amortization Report displays the payment schedule and principal/interest breakdown for the life of the loan.

{button ,AL("ProcCreatingaLoanAccount")} See Related Topics



To print a report or chart

1 View the report or chart you want in the Report and Chart Gallery.

2 On the File menu, click Print.

Note
If you want to change your page setup, on the File menu, point to Print Setup, and then click Report and Chart Setup.
For more information, see Printing a report or chart in 3-D color.

{button ,AL("ProcExportingaReport;ProcCopyingaReportorChart;ProcViewingaReportorChart")} See Related Topics





Payees overview

In Money, a payee is any individual or business a transaction goes to or comes from. By entering a payee for each transaction, 

you can see a summary in the reports of how much of your money is going to a specific business or person.

You can also use the Payees and Categories area to keep track of details such as address, phone number, and transaction 

history of each payee.

{button ,AL("ProcAddingInformationAboutPayees;ProcCreatingaNewPayee;ProcDeletingaPayee;ProcRenamingaPayee")} See 

Related Topics



To create a new payee

1 In the Payees and Categories area, click Payees on the button panel to the left.

2 Click the New button at the bottom of the screen

3 Type a name for the new payee, and then click the OK button.

Tip
You can also enter a new payee by simply typing the payee name in the transaction. Money will automatically add it to the 

list in Payees and Categories.



To delete a payee

1 In Payees and Categories, click Payees on the button panel to the left.

2 Highlight the payee in the list.

3 Click the Delete button.

Note
If any transactions were assigned to the deleted payee, the transaction will not be affected.

{button ,AL("ProcRenamingaPayee")} See Related Topics



To rename a payee

1 In the Payees and Categories area, click Payees on the button panel to the left.

2 Highlight the payee in the list.

3 Click the Rename button.

4 In the New name box, type the new name.

Note
When you rename a payee, the name is changed in all transactions.

{button ,AL("ProcDeletingaPayee")} See Related Topics



To add information about payees

1 In the Payees and Categories area, click Payees on the button panel to the left.

2 Highlight the payee in the list.

3 Click the Go to Details button.

4 Enter your information.





Planning Wizards overview

Planning Wizard are tools that help you accomplish some of the most common financial planning tasks.

Money has five Planning Wizards:

Loan Calculator:

Use the Loan Calculator to explore loan alternatives or calculate unknown values, such as interest, if you know the other values 

for the loan. You can also use the Loan Calculator to compare two loans, calculate savings on interest from additional payments, 

and see how much interest you're paying over the life of your loans.

Mortgage Planner:

Use the Mortgage Planner to compare the costs of two real estate loans. You can use it when shopping for a mortgage or 

considering refinancing your existing mortgage. It's designed to help you compare two different mortgage loans of the same 

amount to decide which is best for you.

Savings Calculator:

Use the Savings Calculator in planning for future purchases or building a cash reserve.

Retirement Planner:

Use the Retirement Planner to estimate how much you'll need to start saving monthly or annually to reach your retirement goal. 

You can also use it to plan for college.

Interest Estimator:

Use the Interest Estimator to estimate the amount of interest a bank account has earned or the interest you have paid on a credit 

card account.

{button ,AL("ProcUsingthePlanningWizards")} See Related Topics



To use a Planning Wizard

1 In the Planning Wizards area, click the wizard you want.

2 Follow the instructions on the screen.

{button ,AL("TheLoanCalculator;TheMortgagePlanner;TheRetirementPlanner;TheSavingsCalculator;TheInterestEstimator")} See 

Related Topics



The Loan Calculator

You can use the Loan Calculator to explore loan terms, to compare two loans, or to calculate savings on interest from additional 

payments.

The Loan Calculator can help you answer such questions as:
Given the monthly payment I can afford and today's interest rate, how large of a loan can I take out?
How would a different interest rate change the loan payment amount?
How would a 20-year loan compare with a 30-year loan in terms of monthly payment amount and total interest paid?
How much interest will I save by making an extra $1,000 payment this year -- or every year?
How much will I owe on my loan in five years?

Note
The Loan Calculator only calculates terms of a loan. To actually set up a loan in Money, see Creating a Loan Account.
You can click the Report button to create a Loan Amortization Schedule (a payment schedule showing principal and 

interest breakdown).
You can click the Import button to use the terms of an existing loan. This won't affect your existing loan records.
In the Loan Calculator, interest on your loan is compounded according to the payment frequency you've selected. For 

example, if you choose Monthly as the payment frequency, the interest is calculated at the end of each month. While not all loans 
work this way, the Loan Calculator should provide accurate estimates in most cases.

For a mortgage or other loan where interest is tax deductible, keep in mind that the net cost of the interest may be less 
than the interest amount shown in the Loan Calculator.

{button ,AL("ProcUsingthePlanningWizards;ProcComparingtheTermsofTwoLoans;ProcSeeingHowExtraPaymentsAffectYourLoan

s")} See Related Topics



To compare the terms of two loans

1 In the Planning Wizards area, click Loan Calculator.

2 Do your initial calculation by filling in all but one of the boxes and clicking the Calculate button.

You can also click the Import button to use the terms of an existing loan. This won't affect your existing loan records.

3 Click the Compare Loans button.

4 In the second calculator, clear the box for the value you want to calculate and change one or more of the other terms. Then 

click the Calculate button.

You can now compare the amounts for total interest and last payment date, which are displayed below each calculator.



To see how extra payments affect your loans

1 In the Planning Wizards area, click Loan Calculator.

2 Do your initial calculation by filling in all but one of the boxes and clicking the Calculate button.

You can also click the Import button to use the terms of an existing loan. This won't affect your existing loan records.

3 Click the Extra Payments button.

4 In the Extra Amount box, type the amount of your additional payment. For example, if your regular payment is $500 and 

you're considering paying $600, type 100.

5 In the Frequency box, enter Only Once, Monthly, or Annually, depending on how often the extra payment would be made. 

The frequency of the extra payment is not dependent on the frequency of your regular payments. For example, even if your 

regular payments are made monthly, you can enter an extra payment annually.

6 Click the Calculate button, and see the results below.

This calculation is only hypothetical. To actually enter this extra payment in your loan payment records, see Making extra loan 

payments.

{button ,AL("ProcChangingLoanAccountInformation")} See Related Topics



The Mortgage Planner

The Mortgage Planner comes in handy when comparing mortgage terms or considering refinancing your existing mortgage. It 

helps you decide which mortgage is best for you by letting you compare initial costs, monthly payment amounts, and total costs 

of each loan option.

Note
For a mortgage loan where interest is tax deductible, keep in mind that the net cost may be less than the amount shown in 

the Mortgage Planner. For help in tailoring your mortgage terms to your tax situation, contact your accountant or financial advisor.
Click the Copy button to copy the results to the Windows Clipboard. You can then paste the results into another Windows 

application for printing.

{button ,AL("ProcUsingthePlanningWizards")} See Related Topics



The Savings Calculator

You can use the Savings Calculator to plan for future purchases or building a cash reserve.

It can also help you answer such questions as:
On what date will I reach my savings goal of $100,000 if I set aside $500 each month and receive a 7 percent annual 

return?
Given my current savings, what return on my investments must I earn to save $100,000 by 2002?
Assuming a 3 percent inflation rate, what will $100,000 be worth in 2010?
How much should I save each month to reach my savings goal of $75,000 by the time my children reach college?
How much will my $20,000 in savings grow in 20 years?

Do your calculation by filling in all but one of the boxes and choosing the Calculate button.

For more accurate planning, click the Inflation button to see how inflation can affect your savings plan.

Tip
In the Savings Calculator, Annual Return on Savings is compounded according to the Frequency of Contribution you've 

selected. For example, if you choose Monthly as the payment frequency, the interest is calculated at the end of each month.
Click the Copy button to copy the results to the Windows Clipboard. You can then paste the results into another Windows 

application for printing.

{button ,AL("ProcUsingthePlanningWizards")} See Related Topics



The Retirement Planner

You can use the Retirement Planner to estimate the regular contribution amount you'll need to make in order to reach your 

retirement income goal.

The Retirement Planner assumes you'll contribute monthly to your savings plan from now until you reach retirement age. It also 

assumes your savings will be the sole source of your monthly retirement income from the time you retire until you reach the life 

expectancy age you entered.

The Retirement Planner assumes you're saving for retirement in a tax-deferred plan such as an IRA, Canadian RRSP, or 401(k). 

If your savings plan is taxable, you should enter a more conservative estimate for return on savings.

Generally, you can overestimate your life expectancy. This reduces the risk of your savings running out due to higher than 

expected inflation rates.

Keep in mind that the Retirement Planner's calculations are based only on your current and future savings; they don't reflect 

income you might have from post-retirement employment, a pension fund, or government retirement-security programs.

Tip
You can also use the Retirement Planner to estimate the regular contributions you need to make to reach your college 

savings goal. In the Current Age, Retirement Age, and Life Expectancy Age fields, just type the student's current age, the student's 
age when starting college, and the student's age at the time of graduation. Then complete the rest of the wizard giving information 
for your college savings instead of retirement savings.

Click the Copy button to copy the results to the Windows Clipboard. You can then paste the results into another Windows 
application for printing.

{button ,AL("ProcUsingthePlanningWizards")} See Related Topics



The Interest Estimator

You can use the Interest Estimator to calculate the amount of interest a Bank Account has earned or the interest you've paid on a 

Credit Card Account.

This can be especially helpful if you rely on interest income for some of your living expenses, or if you want to closely manage 

the cost of credit card interest.

Note
Most accounts will either pay interest (such as most bank accounts) or charge interest (such as most credit card 

accounts). In these cases, you can leave the zero in the interest rate field that does not apply.
You can use the Copy button to copy the Estimated Interest Amount to the Clipboard. You can then paste it into any 

Amount field in Money.

{button ,AL("ProcUsingthePlanningWizards")} See Related Topics





Online Services overview

As long as you have a modem, Online Services let you do common banking, bill-paying, and information-gathering tasks from 

your computer. 

To learn more about your Online Bill Payment and Banking options, see Finding out what Online Services your bank offers.

For general questions, see Online Services frequently asked questions.

Money's subscription-based Online Services:
Online Bill Payment    Lets you pay bills electronically through your computer. This works with any checking account in 

the U.S. See Setting up Online Services.
Online Banking    Lets you electronically update your bank and credit card records, transfer funds between accounts, 

check your account balances, and order new checks. (Available from participating banks.) See Setting up Online Services.

Money's Internet-based services:
Online Quotes    Lets you electronically update the prices of your stocks and mutual funds. If you have Internet access 

and a web browser compatible with Microsoft Internet Explorer, this service is free. See Setting up Online Quotes.
MoneyZone    Lets you connect to an Internet site that contains information on Money and personal finance, a forum for 

getting your questions answered, updated product release information, and more. See MoneyZone.

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcChangingYourOnLineServicesOptions;ProcPayingBillsElectronically;

ProcSettingupanAccountforOnlineServices;ProcDownloadingMarketPricesWithOnlineQuotes;ProcElectronicallyUpdatingYour

AccountRecords")} See Related Topics



To find out what Online Services your bank offers

Money lets you find out the Online Bill Payment and Banking services and pricing your bank offers before you decide to 

subscribe. Your computer will dial a toll-free number and download the signup information based on the identification number for 

your bank. (The identification number will most likely be the routing number listed at the bottom of your checks.)

1 From Money's Contents screen, click Home Banking.

2 Look at the navigation bar at the top of the screen. If the bank you want to find out about is not displayed, click the triangle to 

the left of the bank name, and then choose the bank from the list. If your bank is not listed here, see Assigning a bank to an 

account.

3 On the Accounts tab, click Set up Online Services.

4 Read the instructions on the screen, and click the Next button when you're ready to move on.

5 Enter your bank or financial institution's identification number, and then click Next.

Your bank's information will be downloaded into Money. You can then decide whether you want to subscribe to the services.

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcFindingandUpdatingInformationAboutYourBank")} See Related 

Topics



To set up Online Services

Before you set up Online Bill Payment or Online Banking, Money lets you find out the services and pricing your bank offers by 

downloading the information into Money. The information is downloaded based on the identification number you enter. (The 

identification number will most likely be the routing number listed at the bottom of your checks.)

1 From Money's Contents screen, click Home Banking.

2 Click the triangle to the left of the bank name in the navigation bar, and then choose the bank that holds the accounts you 

want to set up. If your bank is not listed here, see Assigning a bank to an account.

3 On the Accounts tab, click Set up Online Services.

4 Follow the instructions on the screen, and click the Next button when you're ready to move on.

5 Continue entering all the information asked for, and click the Next button when you're finished with each screen.

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcTroubleshootingYourModem;ProcSettingupanAccountforOnlineServi

ces;ProcSettingUpOnlineQuotes")} See Related Topics



To pay bills electronically

In order to do this, you must be signed up for Online Bill Payment. To sign up, see Setting up Online Services.

1 Enter your transaction as usual, except enter Epay in the Number field, and the due date in the Date field. Because Online 

Services requires time to process and deliver your payment, if the payment can't be delivered by the date you entered, Money 

will ask if you want to accept a later date.

When you enter the transaction, Money displays a lightning bolt and an open envelope in the Number field of the register. 

This indicates a pending instruction that will be sent during your next connection to Online Services. After the instruction has 

been transmitted, a lightning bolt and a closed envelope are displayed.

2 Repeat this for each transaction you want to send. If you're entering transactions in the Account Register, be sure to check 

your balance as you enter each payment to make sure you don't give yourself a negative balance.

3 Once you've entered all your transactions, go to the Home Banking area. (If you're working in the Account Register, you can 

click the Home Banking button on the right of the screen.)

4 In the Home Banking area, review the transaction information on the Connect tab.

5 When all your Online Services transactions are ready to send, click the Connect button, and follow the instructions on the 

screen.

For questions about connecting to Online Services, contact your bank or financial institution. You can find their Customer 

Service number on the Contact Information tab.

Tips
If you want to disable "call waiting" while using the modem so that it doesn't disrupt your connection, click the Dialing 

Properties button after clicking the Connect button.
To make sure your payments are delivered on time, try entering your Electronic Payments several days before the 

payment is due to allow for process and delivery time.
When making payments to multiple accounts at a single company, you can distinguish between the payments by entering 

information in curly brackets {    } in the Payee field. For example, you might pay two Visa bills and enter one as "Visa {Andy}" and 
the other as "Visa {Rose}." The only text the bank will see is "Visa," but in Money you'll see the complete entry.

{button ,AL("ProcTroubleshootingYourModem;OnlineServicesOverview;ProcSettingUpOnlineServices;ProcSettingupanAccountfo

rOnlineServices;ProcUsingAutomaticPayments;ProcCancelinganElectronicPayment;ProcReviewingandSendingInstructionsto

OnlineServices")} See Related Topics



To use Automatic Payments

Automatic Payments are used to electronically pay bills that have a fixed frequency and a fixed amount, such as car, rent, and 

mortgage payments. You only need to set up Automatic Payments once. Afterward, Online Services will automatically make all 

payments and enter a record of them in the Account Register. (Availability of Automatic Payments depends on your bank.)

1 In the Payment Calendar, click the New button.

2 Choose the Bill option, and then click Next and follow the instructions on the screen.

3 When you get to the withdrawal form, enter the payment information as usual, except enter Apay in the Number field, and the 

date you want the first payment delivered in the Date field.

4 Choose the frequency of the payment in the Frequency field.

5 Click OK, and follow the instructions on the screen.

6 Once you've entered all the information about the payment, click the Go To button, and then click Home Banking.

7 Review the payment information on the Connect tab.

8 When all your Online Services transactions are ready to send, click the Connect button and follow the instructions on the 

screen.

The next time you connect to Online Services, all Automatic Payments due within the next 30 days will automatically be 

entered into your Account Register. This gives you a chance to cancel the payment before it's made and reminds you to have 

funds available.

Important
Once you set up Automatic Payments, Online Services automatically withdraws the necessary funds from your account 

and pays the bills when they're due, whether or not you connect to Online Services. Therefore, it's important that you remain aware 
of your account balance and keep enough money in your account to cover the automatic deductions.

{button ,AL("ProcTroubleshootingYourModem;ProcPayingBillsElectronically;ProcPermanentlyCancelingAutomaticPayments;Proc
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To permanently cancel Automatic Payments

1 Go to the Payment Calendar.

2 In the list of Recurring Payments, highlight the Automatic Payment you want to cancel. If you don't see it listed, click the 

triangle on the left of the View bar, and then choose All Bills and Deposits.

3 Click the Delete button.

You will be asked if you want to send an instruction to Online Services to cancel the Automatic Payment model. You must 

choose Yes in order to have Online Services stop sending the payments.

4 Click the Home Banking button on the right of the screen.

5 Review the cancel instruction on the Connect tab.

6 When all your Online Services transactions are ready, click the Connect button and follow the instructions on the screen.

{button ,AL("ProcTroubleshootingYourModem;ProcCancelinganIndividualAutomaticPaymentThathasAlreadyBeenScheduled")} 

See Related Topics



To cancel an individual Automatic Payment that has already been scheduled

The next instance of an Automatic Payment gets added to your Account Register any time you connect to Online Services within 

one month of the due date of the payment. This way, you have a chance to cancel the payment before it's sent by Online 

Services.

1 In the Account Register, right-click the transaction you want to cancel. (If you don't see the transaction, you might need to 

switch accounts by clicking the triangle next to the account name in the navigation bar.)

2 Point to Mark As, and then click Void.

Money displays **VOID** in the Balance column, and a lightning bolt and an open envelope in the Number field, indicating 

that this is a pending instruction to cancel this scheduled Automatic Payment.

3 Click the Home Banking button on the right of the screen.

4 In the Home Banking area, review the cancel instruction on the Connect tab.

5 When all your Online Services transactions are ready, click the Connect button and follow the instructions on the screen.

Note
This will cancel only one payment. Other Automatic Payments will continue to be paid unless you permanently cancel 

them by deleting the transaction in the Payment Calendar.

{button ,AL("ProcTroubleshootingYourModem;ProcPermanentlyCancelingAutomaticPayments;ProcReviewingandSendingInstruct
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To cancel an Electronic Payment

If you haven't yet sent the payment instructions to Online Services (it still says Epay in the Number field), you can delete it by 

simply highlighting it in the Account Register and pressing the DEL key.

If you've already sent the payment to Online Services, but it hasn't yet been sent to the payee, follow these steps:

1 In the Account Register, right-click the transaction you want to cancel. (If you don't see the transaction, you might need to 

switch accounts by clicking the triangle next to the account name in the navigation bar.)

You can identify an Electronic Payment by the lightning bolt and envelope preceding the check number in the Number field.

2 On the Mark As menu, click Void.

Money will ask if you want to send an instruction to Online Services to cancel this instruction. You must answer Yes in order 

for the payment to be canceled.

Money displays **VOID** in the register's Balance field and a lightning bolt and open envelope in the Number field to indicate 

this is a pending instruction to cancel the payment.

3 Click the Home Banking button on the right of the screen.

4 Review the cancel instruction on the Connect tab.

5 When all your Online Services transactions are ready, click the Connect button and follow the instructions on the screen.

Note
To cancel or stop a payment that Online Services has already sent, contact your local bank or financial institution for a 

Stop Payment order.

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcTroubleshootingYourModem")} See Related Topics



To electronically update your account records

1 From Money's Contents screen, click Home Banking.

2 Click the triangle to the left of the bank name in the navigation bar, and then choose the bank that has the account you want to 

update.

3 Review the list of transactions on the Connect tab.

4 When all your Online Services transactions are ready to send, click the Connect button, and follow the instructions on the 

screen.

For questions about connecting to Online Services, contact your bank or financial institution. You can find their Customer 

Service number on the Contact Information tab.

5 Once the connection has ended, read whatever messages are in the Call Summary dialog box, and then follow the 

instructions on the screen.

6 When you're ready to enter the downloaded transactions into your Account Register, highlight the account on the Statements 

tab, and click Read Statement.

7 Click Update Account Register, and follow the instructions on the screen.

Each downloaded transaction will have an "E" in the Cleared field to indicate it was entered electronically.
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To send a letter to Online Services

1 From Money's Contents screen, click Home Banking.

2 On the Connect tab, click the Write Letter button.

3 In the Write Letter dialog box, choose one of the options.

4 Follow the instructions on the screen.

Your letter will be added to the transactions list on the Connect tab.

5 When all your Online Services transactions are ready, click the Connect button and follow the instructions on the screen.

For questions about connecting to Online Services, contact your bank or financial institution. You can find their Customer 

Service number on the Contact Information tab.

Note
Depending on what your bank offers, you can send an electronic letter to Online Services to order new paper checks, get 

copies of processed checks, inquire about transactions, investigate payments, or ask general-purpose questions of your bank or bill-
paying service. (Remember that you will later have to initiate another phone call in order to receive the response.)

A "Letter Inquiring About a Specific Payment" should be used, for example, if a payment you sent hasn't been debited 
from your account. Before doing this, see Checking the status of an Electronic Payment.

If you want to review or change a letter before it's sent, highlight the letter on the Connect tab, and then click the Write 
Letter button again.

{button ,AL("ProcTroubleshootingYourModem;ProcReviewingandSendingInstructionstoOnlineServices")} See Related Topics



To transfer money electronically between accounts

1 In the Account Register, click the triangle to the left of the account name in the navigation bar, and then choose the account 

you want to transfer money from.

2 Click the Transfer tab.

3 Fill in the transfer information as you normally would, except in the Number field, choose Electronic Transfer (Xfer). You can 

also enter information in the Pay To field, but it won't be sent with your instructions. When you finish, click Enter.

In the register, a lightning bolt and an open envelope appear in the Number field next to the word "Xfer."

4 Click the Home Banking button on the right of the screen.

5 In the Home Banking area, review the list of transactions on the Connect tab.

6 When all your Online Services transactions are ready, click the Connect button and follow the instructions on the screen.

Note
In order to transfer money electronically, both accounts must be set up for Online Banking in your Money file. .

{button ,AL("ProcTroubleshootingYourModem;ProcReviewingandSendingInstructionstoOnlineServices")} See Related Topics



To check the status of an Electronic Payment

1 From Money's Contents screen, click Home Banking.

2 Click the triangle to the left of the bank name in the navigation bar, and then choose the bank that has the payment you want 

to check.

3 Highlight the transaction on the Payments in Progress tab.

4 Click the Payment Status button.

In the Payment Status dialog box, you can see when the payment was transmitted to Online Services and when it cleared the 

bank.

{button ,AL("ProcCancelinganElectronicPayment;ProcSendingaLettertoOnlineServices;ProcReviewingandSendingInstructionsto

OnLineServices")} See Related Topics



To change your Online Services options

1 On the Tools menu, click Options.

2 In the Options dialog box, click the Online Services tab.

3 Make the changes you want.

You can use Money's Online Services options to change:
Whether Money shows you each transaction before it's downloaded into your Account Register when you use Online 

Banking.
Whether the bank's descriptions of your transactions are added to the Memo field when you download transactions using 

Online Banking.
The date range money uses to match downloaded transactions to transactions already in your Account Register.



To review and send instructions to Online Services

1 From Money's Contents screen, click Home Banking.

2 Click the triangle to the left of the bank name in the navigation bar, and then choose the bank that has the transaction 

instructions you want to send.

3 Review the list of transactions on the Connect tab.

You can use the right mouse button to click on an instruction and see a menu of options, including Don't Send On Next Call, 

which lets you exclude an instruction from the list.

4 When all your instructions are ready, click the Connect button and follow the instructions on the screen.

For questions about connecting to Online Services, contact your bank or financial institution. You can find their Customer 

Service number on the Contact Information tab.

When the call is complete, Money displays a Call Summary dialog box. This summary includes acknowledgment of all 

instructions sent during this call and information about any errors that might have occurred.

If you want to save any messages you received, click the Save As button.

{button ,AL("ProcTroubleshootingYourModem;OnlineServicesOverview;ProcSettingUpOnlineServices")} See Related Topics



To download market prices with Online Quotes

If you have Internet access and a web browser compatible with Microsoft Internet Explorer, you can use Online Quotes free of 

charge to electronically download the latest prices of all the major stocks and mutual funds you track in Money. If you haven't yet 

set up Online Quotes, see Setting up Online Quotes.

1 From Money's Contents screen, click Investment Portfolio.

2 Click the Online Quotes button on the right of the screen.

3 Review the list of transactions, making sure those you want to send have been selected. (Selected instructions will have a 

check mark in the box to the left of the instruction.)

4 When all your instructions are ready, click the Call button.

5 If you also want to save the Call Summary text for your records, click the Save As button.

Money will then automatically update the prices in your portfolio, and make a record of the date and price in the Update Price 

dialog box, which you can view by clicking Update Price in the Investment Portfolio.

Note
In order to download market prices for a stock or mutual fund, you must first make sure the market-approved symbol for 

the investment is entered in Investment Details. To check this, highlight the investment in the Investment Portfolio, and then click the 
Details button, and check the Symbol field. If you don't know the investment's symbol, you can look it up on MSN Investor on the 
Internet. You can get to MSN Investor through the MoneyZone.

{button ,AL("ProcTroubleshootingYourModem;ProcSettingUpOnlineQuotes")} See Related Topics



To set up Online Quotes

If you have Internet access and a web browser compatible with Microsoft Internet Explorer, you can use Online Quotes free of 

charge to electronically download the latest prices of all the major stocks and mutual funds you track in Money. (Money also 

offers a subscription-based Online Quotes service for those without Internet access.)

1 From Money's Contents screen, click Investment Portfolio.

2 Click the Online Quotes Setup button on the right of the screen.

3 Follow the instructions on the screen, and click the Next button when you're ready.

{button ,AL("ProcDownloadingMarketPricesWithOnlineQuotes;OnlineServicesOverview")} See Related Topics



To enter an electronic Recurring Payment

If you're an Online Bill Payment user, there's two types of electronic payments you can enter in the Payment Calendar: 

Epays (Electronic Payments): Use these for recurring payments whose amounts vary, such as your electricity and phone bill. To 

use this, just enter the payment as you normally would, except enter Epay in the Number field.

Apays (Automatic Payments): Use these for bills that have a fixed frequency and a fixed amount, such as car, rent, and 

mortgage payments. You only need to set up Automatic Payments once. Afterward, Online Services will automatically make all 

payments and enter a record of them in the Account Register. Once you set up Automatic Payments, Online Services 

automatically withdraws the necessary funds from your account and pays the bills when they are due, whether or not you 

connect to Online Services. To use this, go to the Payment Calendar, and enter the payment as you normally would, except enter 

Apay in the Number field. (Availability of Automatic Payments depends on your bank.)

Tip
If your bank doesn't support Automatic Payments but you want to schedule multiple Electronic Payments into the future, 

you can schedule a series of Epays with different payment dates and a frequency of Only Once. The payments will then be 
delivered on the dates you specify.



To find and update information about your bank

1 In the Home Banking area, switch to the bank you want by clicking the down arrow to the left of the bank name in the 

navigation bar.

2 Click the Contact Information tab.

Here you'll see your bank's Customer Service number and other information.

3 Click the Update Contact Information button to download or update the bank's phone number, Internet address, and other 

information. (Your computer will use a toll-free number to access this information.)

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcTroubleshootingYourModem")} See Related Topics



MoneyZone overview

The MoneyZone is an Internet site that provides information on Microsoft Money, personal finance and Online Services. In order 

to use the MoneyZone, you need a modem, an Internet service provider, and a compatible Internet browser. (See below for more 

details.)

Visit the MoneyZone for:
Hints and tips on using Money.
Answers to your Money questions.
Articles that will help you manage your finances more effectively.
Updated product information.
A link to MSN Investor (where you can look up the market symbols for your investments as well as the country codes for 

international markets for use with Online Quotes.)

How you get to the MoneyZone depends on the Internet software you use.

If you use Microsoft Internet Explorer, Netscape Navigator, or a compatible browser:

You can go straight to the MoneyZone by clicking the MoneyZone button on your Money Contents screen.

If you have a web browser through a larger online service:

You can get to the MoneyZone from within your service's web browser. Connect to your service, go to the web browser, and then 

enter the address http://www.microsoft.com/MoneyZone/

If you don't have a web browser or Internet access:

You can download the latest version of Microsoft Internet Explorer free through The Microsoft Network (MSN). If you're not 

already an MSN member, you'll also receive 30 days of free Internet access. To sign up, just double-click The Microsoft Network 

icon or The Internet icon on your desktop.

{button ,AL("ProcTroubleshootingYourModem")} See Related Topics



To assign a bank to an account

1 From Money's Contents screen, click Account Manager.

2 Right-click the account, and then click Details.

3 In the Bank Name field, choose a bank name from the list, or type a new bank name.

You can then see your bank's information in the Home Banking area by choosing this bank from the list of banks in the 

navigation bar. Also, if your bank has an Internet site, you can connect to it and automatically download your bank's updated 

information.

For more information, see Finding and Updating Information About Your Bank.



To cancel Online Services

1 To avoid any unnecessary service charges, call Online Services and tell them you want to cancel the services. You can find 

the number on the Contact Information tab in the Home Banking area.

2 In the Home Banking area, click the triangle to the left of the bank name in the navigation bar, and then choose the bank that 

has the services you want to cancel.

3 On the Accounts tab, click Select Online Services.

4 Go through the wizard by clicking the Next button.

{button ,AL("OnlineServicesFrequentlyAskedQuestions;ProcTroubleshootingYourModem")} See Related Topics



Electronic Payment Dates

The amount of time required to process a payment varies according to your Online Bill Payment provider. Some providers will 

require more time to process the first payment to a particular payee than subsequent payments to that payee.

In some cases, money is withdrawn from your account prior to the due date to make sure your payment doesn't bounce. Make 

sure you have enough money in your account on the withdrawal date listed in the dialog box.

Also, make sure the date on which the payment will be received is not after your due date.

If you have any questions about how your Electronic Payment works, refer to the materials your financial institution and/or 

service provider sent you, send some email, or call the Customer Support number that's listed on the Contact Information tab of 

the Home Banking area.



Electronic Transfer Dates

The amount of time required to process a transfer varies according to your Online Banking provider.

In some cases, money is withdrawn from your account prior to the due date to make sure your payment doesn't bounce. Make 

sure you have enough money in your account on the withdrawal date listed in the dialog box.

If you have any questions about how your Electronic Transfer works, refer to the materials your financial institution and/or service 

provider sent you, send some email, or call the Customer Support number that's listed on the Contact Information tab of the 

Home Banking area.



Online Services Frequently Asked Questions

How do I find out what Online Services are available to me?

Once you have an account set up in Money, go to the Home Banking area and click Set up Online Services on the Accounts tab. 

Money then dials a toll-free number so that you can find out what Online Services are offered by your financial institution, what 

they cost, and how to sign up.

How much do Online Services cost?

The cost varies depending on your financial institution and on which services you use. Click Set up Online Services on the 

Accounts tab in the Home Banking area to find out about the fees at your financial institution.

I checked, and my financial institution doesn't offer Online Banking. How do I find an institution that does?

If you have Internet access, click the MoneyZone button on Money's Contents screen. The MoneyZone contains a regularly 

updated list of financial institutions that offer Online Banking.

If you don't have Internet access, it's easy to sign up for a free, 30-day trial period. Just click the MSN icon on your Windows 95 

desktop.

I have accounts at a few different financial institutions. Can I use Online Services with several institutions at the same 

time?

Yes, for the most part. You can use Online Banking (downloading statements & transferring funds) through any institution that 

provides the service. For Online Bill Payment (paying bills only), you need to decide on a single bank to use with the service.

Can I use Online Bill Payment even if my bank is not online?

Yes. Online Bill Payment works with any financial institution in the United States.

I used to use online services with Quicken. What do I need to do to use those services with Money?

Call your financial institution. Most likely, you'll need to cancel your Quicken Online Services and sign up again in Money, by 

clicking Set up Online Services on the Accounts tab in the Home Banking area. The customer service representative at your 

financial institution can help you cancel your Quicken services and ensure that you don't get billed twice.

Before you cancel Quicken online services, you might want to make sure that any outstanding electronic transactions have been 

paid.

I'm currently using Online Bill Payment only, and I think my payments go through a national bill payment service. Now I 

want to sign up for Online Banking as well. How can I go through my bank for both of these services?

Call your bank to find out if it offers Online Banking and Online Bill Payment through Money 97. If it does, it's a good idea to 

cancel your existing Online Bill Payment service. See Canceling Online Services for details. Then, click the Set up Online 

Services button again to sign up for both services through your bank.

Note: You don't have to cancel your existing Online Bill Payment service just because you want to add Online Banking, but you'll 

probably find it more convenient in the long run. If you sign up for both services through the same provider (your bank), you can 

take care of both Online Banking and Online Bill Payment with a single phone call.

How do I get help with my Online Services?

Click the question mark on the right of the navigation bar in the Home Banking area. If you can't find what you need, you can get 

immediate assistance by clicking the Contact Information tab in the Home Banking area and calling the Customer Service 

number listed for your financial institution.

If you use Online Banking, you can also click the Write Letter button on the Connect tab in the Home Banking area. A customer 

service representative from your bank will answer your question within the next two or three business days.

My Contact Information tab doesn't have a phone number (or the phone number is wrong). How do I know whom to 

call?

Click the Update Contact Information button on the Contact Information tab. Provided your modem is working properly, Money 

will connect to your bank and download its current information.

Can I pay all my bills with Online Bill Payment?

Just about. The only payments you can't make are those that must be accompanied by an official form, for example, tax 



payments or court-directed payments. Typical payments such as utility bills, mortgage, and other loan payments require only an 

account number, which Money asks you for the first time you create the payment.

What about payments to individuals?

No problem. You can use Money to send a check to anyone in the United States, provided you have their address.

Are Online Services secure?

YES. Online Services use an encryption technology similar to what's used in ATM machines. Just keep your online password 

private, and no one will be able to access your information.

How do I pay for the services?

Typically, service fees are deducted from your account on a monthly basis and are reflected on your account statement. You can 

learn more about how your institution handles Online Services fees when you sign up.

Will online payments appear on my bank/credit union statement?

Yes. Payments made using this service will show up on your monthly statement (both your paper statement and your electronic 

one, if you're using Online Banking). You can compare this information to your Money records.

What do I do if a payment doesn't arrive on time?

Contact Customer Service through the e-mail service that's built into Money, or call the assigned Customer Service number listed 

on the Contact Information tab in the Home Banking area.

What do I do with my utility payment coupon/stub?

Money lets you include an account number with your payment so that you don't need to include the payment coupon. You can 

save them for your records or throw them away.

Do I have to re-enter address information every time I pay someone?

The first time you make a payment to a particular payee, you enter the payment address and your account number. From that 

point on, you enter only the payment amount and due date; Money fills in the rest of the information for you.

Can I still use my current checks?

Yes. Using Online Bill Payment is like having a second checkbook for the same account. Depending on your bank, payments 

made with Online Bill Payment might be assigned special check numbers in Money that distinguish them from your regular bank 

checks.

If I use Online Banking, can I get access to all my accounts?

All participating banks provide access to at least checking and savings accounts. You might also be able to access other 

accounts, such as credit card, money market or loan accounts. Check with your bank for the types of accounts enabled for this 

service.

Can I transfer money to another bank?

Transfer capabilities vary from bank to bank. Depending on your bank, you might be able to transfer money to another bank, and 

even to another person at another bank. To find out more about the transfer features offered by your bank, call the bank phone 

number listed on the Contact Information tab in the Home Banking area.





Payment Calendar overview

Setting up Recurring Payments in the Payment Calendar for regularly occurring bills and deposits can save you time and help 

you keep accurate records.

If you enter recurring bills -- such as monthly utility bills -- in the Payment Calendar, you only need to enter the information once. 

When the bills come due you'll get a reminder and a chance to see what your new balance will be if you enter the payment now. 

Next, enter the transactions automatically into the Account Register once you've reviewed them and make any changes you 

want. This is especially helpful when entering split transactions.

You can use the Payment Calendar for the following types of payments:
 Cable TV
 Child support/alimony
 Education loans
 Electricity
 Garbage
 Health insurance
 Homeowner's insurance
 Life insurance
 Mortgage
 Natural gas

 Rent
 Renter's insurance
 Telephone
 Tuition
 Car insurance
 Car loans
 Vehicle registration
 Water
 Paychecks
 Newspaper

You can use the Payment Calendar for paychecks, as well as payments. You might also use the Payment Calendar to get a 

reminder of a single important transaction, such as the maturity date of a certificate of deposit (CD). It's also a good idea to set 

up a Recurring Payment for loans. (It's best to set this up when you create the Loan Account.)

You can use the calendar on the right to see when you have upcoming payments. Select any date on the calendar and the list 

will adjust to display all the Recurring Payments due up to that date. For more information about the calendar, see Using the 

calendar.

{button ,AL("ProcUsingtheCalendar;ProcChangingPaymentCalendarReminders;ProcPermanentlyDeletingaScheduledPayment;P

rocCancelingaScheduledPayment;ProcUsingthePaymentCalendartoEnterYourRecurringPayments")} See Related Topics



To use the Payment Calendar to enter your Recurring Payments

Once you've set up a Recurring Payment in the Payment Calendar, Money reminds you when it's due. You'll also have a chance 

to make changes to the transaction (including the amount) before Money enters it into the Account Register. For more 

information, see Payment Calendar overview.

1 In the Payment Calendar, click the New button.

2 Choose a transaction type, and then click Next.

3 Read the instructions on the screen, and then fill out the form and click OK.

4 Repeat steps 1 through 3 for each transaction you want to enter.

In the calendar to the right, you'll see an envelope appear each day on which a payment is due.

5 When a payment is due (you'll get a reminder in Money's Contents screen and in the Payment Reminder), go back to the 

Payment Calendar.

6 In the list of payments, click to select the check box of each one you want to enter into the Account Register.

7 In the New Balance column, see if you have enough in your accounts to cover the payments. (If any amounts are not 

accurate, highlight the transaction, click the Edit button, and change the amount.)

8 Click the Enter button. You can then review each transaction and make any changes you want.

9 Click the Enter button to add the transaction to the Account Register.

Notes
You're automatically reminded of upcoming bills 10 days in advance of the due date. To change this option, see Changing 

Payment Calendar Reminders.
Money's Payment Reminder will remind you of upcoming bills you've entered in the Payment Calendar whenever you 

enter Windows (even if you don't enter Money). For more information, see Using the Payment Reminder.
Use the Balance Forecast chart at the bottom of the Payment Calendar to see your balances projected into the future. For 

more information, see Forecasting your balance.

{button ,AL("ProcEditingaScheduledPayment;ProcPermanentlyDeletingaScheduledPayment;ProcSkippinganIndividualScheduled
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To skip an individual Recurring Payment

1 In the Payment Calendar, highlight the transaction in the list.

2 Click the Delete button.

3 Click the Just This Instance button.

This Recurring Payment will remain in the Payment Calendar, and you'll be reminded when the next payment is due. If you 

want to permanently cancel a Recurring Payment, see Permanently Deleting a Recurring Payment.



To permanently delete a Recurring Payment

1 In the Payment Calendar, highlight the transaction in the list.

2 Click the Delete button.

3 Click the Delete All Instances button.

This deletes every instance of this payment. If you just want to delete a single instance of a payment, see Skipping an 

Individual Recurring Payment.



To edit a Recurring Payment

1 In the Payment Calendar, highlight the transaction in the list.

2 Click the Edit button and make your changes.

3 Click the OK button.

Note
The change will apply to all instances of this Recurring Payment. If you want to edit an individual instance of this 

Recurring Payment, make the change when you enter the transaction into the Account Register.



Using the calendar

The calendar is on the right side of the Payment Calendar area. You can use it to:
See at a glance on what days you have payments due. (Days that have Recurring Payments have an envelope icon.)
Click a date on which a payment is due to quickly highlight it in the list to the left. (To then select it for payment, click the 

check box to the left of the payment.)
Check off all bills and deposits up to a certain date by clicking on that date with the right mouse button. You can then look 

in the New Balance column to see how your balances would be affected if all the selected payments were made.
Look ahead to future months and years by clicking the arrows or the date at the top of the calendar. (It's best to just start 

experimenting by clicking around on these items to see what you can do.)
See your balance forecast at the bottom of the screen projected over a longer time period by clicking the right arrow at the 

top of the calendar.
Have a handy calendar reference that covers 1948 - 2075.

{button ,AL("PaymentCalendarOverview")} See Related Topics





This mini-report shows all the transactions you've entered involving the payee selected in the navigation bar.



This mini-report shows all the transactions you've entered involving the item selected in the navigation bar.



This mini-report shows all the transactions you've entered involving the investment selected in the navigation bar.



Click this to assign a different category to all the transactions currently assigned to the category selected in the navigation bar 
above.



Click this to go to the Account Register with the highlighted account opened.



Takes you to Account Details, where you can enter and change information about the currently displayed account, set up the 
account for use with Online Services, and see the account's running balance over the last 12 months.



Takes you to Account Details, where you can enter and change information about the currently displayed Investment Account 
and see the price history of the account over the last 12 months.



Click this to create a new account.



Click this to delete the account highlighted above.



Takes you to the Account Details area, where you can enter and change information about the currently displayed account, set 
up the account for use with Online Services, and see the account's running balance over the last 12 months.



Takes you to the Home Banking area, where you can see more information on the bank associated with the account highlighted 
above.



Takes you to the Account Details area, where you can enter and change information about the currently displayed loan, see the 
loan's terms, or change any of the loan information.



Begins balancing the currently displayed account. You should have the account statement handy before balancing.



Begins balancing the currently displayed Loan Account. You should have the loan statement handy before balancing.



Switches you to the Investment Account related to this Associated Cash Account.



Click this if you want to update the investments held in this Retirement Account so that they match a recent statement.



Switches you to the Associated Cash Account related to this Investment Account.



Click this to print any or all of the payments in which you've entered "Print" in the Number field.



Click this to print any or all of the payments in which you've entered "Print" in the Number field.



Closes this dialog box and saves any changes you have made.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made.



This is the view bar. Click the triangle to the left to customize what's displayed here.



Displays the corresponding list to the right.



Click this to see the details for the item highlighted in the list above.



Click this to add a new item to the list above.



Click this to change the category of all the transactions assigned to the category highlighted above.



Click this to rename the item highlighted in the list above.



Click this to delete the item highlighted in the list above.



Click this to rename the classification selected above.



Click this to delete the classification selected above.



This is Money's navigation bar. Use it to quickly jump to another area by using one of the buttons to the right.

In the Account Register or any of the details areas, you can also click the triangle to the left of the name to display information for 
another account, payee, category, etc.



Click this to return to the Contents screen, which is Money's home base.



Click this to return to the last area you visited in Money.



Click this to jump to any of Money's eight main areas or to go directly to any of your favorite accounts.



This is the view bar. Click the triangle to the left to customize your Account Register display.



This is the view bar. Click the triangle to the left to customize your Account Register display.



This is the view bar. Click the triangle to the left to customize your Account Register display.



This is the view bar. Click the triangle to the left to customize your Investment Portfolio display.



This is the view bar. Click the triangle to the left to customize your Payment Calendar display.



This is the view bar. Click the triangle to the left to customize your Account Manager display. Click Account Balances to see the 
current balances of all your accounts.



Click this to see a list of Help topics that explain how to do things that pertain to this area.



Displays the corresponding list of reports and charts to the right.



These are the reports and charts that relate to the button selected in the button panel to the left. Click another button to see what 
other reports and charts are available.

When you find a report or chart you want to see, highlight it and then click Go To Report/Chart. All reports and charts can be 
customized to present your information exactly as you want it.



Displays the report or chart that's highlighted to the left.



Click this to rename the highlighted report in the My Favorites list.



Click this to delete the highlighted report from the My Favorites report list.



Select each transaction you're considering entering into the Account Register by clicking in the check box to the left of the 
transaction. You can then view your account balances under New Balance to see if you'll have enough to cover the bill.



Click this to add a new Recurring Payment to the Payment Calendar.



Click this to make any changes to the Recurring Payment highlighted above.



Click this to delete the Recurring Payment highlighted above.



Click this to remove all the check marks from the transactions above.



Click this to start entering all the selected transactions into the Account Register. You'll get a chance to make changes to the 
transactions before they're entered.



In step 2, check the balances of the accounts affected by the transactions selected above to make sure they won't put you below 
your minimum balance.



In step 2, check the balances of the accounts affected by the transactions selected above to make sure they won't put you below 
your minimum balance.



In step 3, click the Enter button to enter all the transactions into the Account Register that have a check mark. You'll get a chance 
to make changes to the transactions before they're entered.



In step 3, click the Enter button to enter all the transactions that have a check mark into the Account Register. You'll get a chance 
to make changes to the transactions before they're entered.



Click this to go to the Account Register, where you enter all your transactions and balance your accounts. The Account Register 
is similar to your checkbook. It has a transaction register above and checks and forms where you can enter transactions below.



Click this to go to the Payment Calendar, where you can automate entry of all your Recurring Payments.

If you enter, for example, your monthly utility bill, you only have to enter the information once. When it's due, you'll get a reminder 
and the transaction will be entered automatically once you've made any necessary changes. You can also easily check if you 
have enough in your account to cover the payment.

You can use the Payment Calendar for paychecks as well as payments. You might also want to use the Payment Calendar to 
remind you of a single important transaction, such as the maturity date for a certificate of deposit.



Click this to go to the Home Banking area.



Click this to go to the Home Banking area.



Click this to go to the Home Banking area, where you can sign up for Online Services, which let you do common banking and 
bill-paying tasks from your computer, including:

Online Bill Payment: Lets you pay bills electronically from your computer. This works with any checking account in the 
U.S.

Online Banking: Lets you electronically download your bank and credit card records, transfer funds between accounts, 
check your account balances, order new checks, and more. (Available through participating banks.)

Even if you don't use Online Services, you can still use the Home Banking area to store information about your banks, and -- if 
you have a modem -- connect to your bank's Internet site (if available) to receive additional information.



Click this to go to the Account Manager, where you can see the current balances of all your accounts, create a new account, and 
delete or modify an existing account. You can also go to Account Details, where you can enter and change information about 
your accounts and set up accounts for use with Online Services.



Click this to go to the Investment Portfolio, where you can see a summary of your current investment holdings and their values. 
Any investment transactions you enter are reflected in the Investment Portfolio. You can also electronically or manually update 
the market prices of your investments here.

Before using Money's Investment Portfolio, it's important to understand the difference between Investment Accounts and 
investments:

Investment Accounts provide a place to store your investments. Your first step in the Investment Portfolio will be to set 
up an Investment Account for each brokerage statement you receive.

Investments are added to Investment Accounts. You can have multiple investments in one Investment Account, just as 
you might hold a variety of investments through a single brokerage.



Click this to go to the Report and Chart Gallery, where you can check on your current financial status, see trends, summarize 
information, and provide others with information through printing and exporting.



Click this to go to Payees and Categories, where you can see a list of all your payees, categories, and classifications. You can 
also go to the details area of each if you want to make modifications or see detailed spending information.



Click this to go to the Planning Wizards area, where you can easily accomplish some of the most common tasks in financial 
planning, including:

Setting savings goals
Planning for retirement
Estimating interest earned on a bank account or paid on a credit card account
Calculating loan payments
Comparing fees and points charged for mortgage loans



If you have a modem, an Internet service provider, and a compatible Internet browser, click this to jump on the Internet to the 
MoneyZone, where you can:

Find more information on Money and personal finance.
Get your questions answered by the experts.
Find updated product release information.
Have a link to MSN Investor.

If your web browser won't let you jump to the MoneyZone directly, open the browser and enter the address 

http://www.microsoft.com/MoneyZone/



This is Money's chart of the day. Click the triangle to the left if you want to display another chart.

Click Change Each Day to have the chart automatically change every day.



This is Money's chart of the day. Click the triangle on the left of the title bar if you want to display another chart.

Click Change Each Day to have the chart automatically change every day.



Click this if you want to rename the Investment Account or enable or disable its Associated Cash Account. The name will be 
changed throughout Money.



Select this if the account contains only tax-deferred investments. Transactions from this account will then be excluded from your 
tax reports.



Click this to switch to the Associated Cash Account for this Investment Account. From there you can enter and change 
information about the account and see the account's running balance over the last 12 months.



Click this to go to the Account Register with the highlighted account opened. From there you can enter any buys, sells, or other 
transactions for this account.



Click this to see the details for the investment or Investment Account highlighted above.



Click this to create a new investment or Investment Account. If you create a new investment, such as a stock, bond, or CD, the 
investment won't actually be part of your portfolio until you enter a buy transaction for it in the Account Register. This way, you 
can track the performance of a stock or other investment you don't actually own without throwing off your records.

If you want to see all the investments you've entered, click the triangle on the left of the view bar above, and then click 
Investments.



Click this if you want to see the price history of an investment or if you want to manually update the market price of an 
investment.



Click this if you want to see the price history of an investment or if you want to manually update the market price of an 
investment.



Click this to delete the investment or Investment Account highlighted above.



Click this to enter a split for any of your investments, such as a stock split. When you enter a split, Money adjusts the price and 
quantity to reflect the split. These changes will also be reflected in the Investment Portfolio and in the Update Price dialog box.



Click this to enter a split for any of your investments, such as a stock split. When you enter a split, Money adjusts the price and 
quantity to reflect the split. These changes will also be reflected in the Investment Portfolio and in the Update Price dialog box.



Click this to electronically update your investment prices. Online Quotes will automatically update the market price of each 
investment for which you've entered an official, market-approved symbol in Investment Details.



Click this to electronically update your investment prices. Online Quotes will automatically update the market price of each 
investment for which you've entered an official, market-approved symbol in Investment Details.



Click this to set up Online Quotes or to change your existing setup information.

Online Quotes lets you electronically download the most recent prices for your investments.



Click this to send all the instructions listed to the left to Online Services. If there are any instructions you don't want to send on 
this call, right click on the instruction, and then click Don't Send on Next Call.



Click this to delete the highlighted account above.



Click this to create a new account.



Home Banking Area:



Click this to set up Online Services or to make changes to your existing Online Services setup information, such as your address 
or the phone number you use to access Online Services. You can also set up additional accounts for Online Services here.



Click this to see what Online Services your financial institution offers. Money will dial a toll-free number to find out about the 
services and the pricing.

Then, once you have this information, you can decide whether you want to go ahead and sign up.



Click this to send your Electonic Payments. If there's a payment you don't want to send on this call, right-click it, and then click 

Don't Send on Next Call.



Click here to connect to Online Services and download your transaction information.



Click this if you would like more information on Money's Online Services.



Click this to connect to the Internet to get updated information on the bank selected in the navigation bar.



Click this to change the name you've entered for this bank. The new name will replace the old throughout Money.



Click this to go to the Internet site of the bank selected in the navigation bar. The Internet address for this site is listed in the box 
to the left.



The voice phone number of the bank selected in the navigation bar.



The mail address of the bank selected in the navigation bar.



Provides a space for you to add any additional information you want to remember about this bank.



The Internet address of the bank selected in the navigation bar.



Click this to create a letter to send electronically to your bank. You can send letters to order new checks, get copies of processed 
checks, or send general-purpose inquiries. Remember, you'll have to call Online Services again to receive a response.



Click this to read the downloaded statement highlighted to the left, and then enter the transactions into your Account Register.



Click this to read the downloaded statement for this account.



Click this to check the status of the payment highlighted in the list to the left. You will receive a response from your bank during 
the same connection.



Click this to go to Account Details, where you can enter and change information about the account highlighted above and see the 
account's running balance over the last 12 months.



Click this to go to the Account Register with the highlighted account opened.



Click here to send a payment investigation instruction to Online Services.



This is a list of all the transactions you've sent through Online Bill Payment in the last 60 days. Highlight a transaction, and then 
click the Payment Status button.



This is a list of all the accounts you've set up with this bank. The check marks indicate which Online Services the accounts are 
set up to use.



Click this to read the downloaded statement for the account highlighted to the left.



This is a list of all the accounts you've set up for Online Banking. The amount in the Bank Balance column is the latest balance 
you've downloaded for the account.

If any of the accounts have transactions to download, highlight the account, and then click the Read Statement button to add the 
transactions to your Account Register.



Click here to send all the instructions listed to the left to Online Services. If there are any instructions you don't want to send on 
this call, right click the instruction, and then click Don't Send on Next Call.



Click here to create a letter to send electronically to Online Services. You can send letters to order new checks, get copies of 
processed checks, or send general-purpose inquiries. Remember, you'll have to call Online Services again to receive a 
response.



This is a list of all the instructions ready to send to Online Services. If there's any instructions you don't want to send on the next 
call, right-click the instruction, and then click Don't Send on Next Call.



Click this to bring up a transaction form, where you can enter a new Electronic Payment.



Click this to bring up a transaction form, where you can enter a new Electronic Transfer.



End of Home Banking Topics



Click this to switch between viewing a report and a chart. Both reflect the same information.



Click this to customize exactly what information is included in the report or chart and how it's displayed.



Click this if you want to export the displayed report to a file for use in another computer application, such as a word processor or 
spreadsheet program. The report will be exported as tab-delimited text.



Click this to add the displayed report or chart to your list of favorites. This way, you can keep all the reports you go to most often 
in one place.



Click this to use the Loan Calculator, where you can explore and compare different loan terms and see how much total interest 
you'll pay on a loan. You can also calculate savings on interest from additional payments.



Click this to use the Mortgage Planner, where you can compare the costs of two real estate loans. You can use it when shopping 
for a mortgage or when considering refinancing your existing mortgage. It's designed to help you compare two different mortgage 
loans of the same amount to decide which is best for you.



Click this to use the Savings Calculator, which helps you plan for future purchases or plan for building a cash reserve. You can 
also automatically compensate for inflation.



Click this to use the Retirement Planner, which helps you estimate how much you need to start saving per month to reach your 

retirement goal.



Click this to use the Interest Estimator, which helps you estimate the amount of interest a bank account has earned or the 
interest you have paid on a credit card account.





To assign, change, or delete a password

1 On the File menu, click Password.

2 Follow the instructions on the screen.

If you've forgotten your password, see If you forget your password.



If you forget your password

If you forget your password and would like to regain access to your Money file, you'll need to contact a company that specializes 

in decrypting password-protected files.

Microsoft AnswerPoint does not provide this service. Microsoft makes no warranty and assumes no liability if you choose to hire 

a company for these services.

Companies will typically charge you a fee for this service, so you may decide that you would rather start over with a new Money 

file.

You may do your own research to find companies that provide this service and what fees they charge before you decide which 

company to choose.

You will need to provide the company you choose with your data file, which is probably the following:

C:\Program Files\Microsoft Money\My Money.mny

One company that provides this service for a fee is Access Data Corp. In the U.S. call (800) 574-5199, and in Canada call (801) 

224-6970.

Microsoft provides no endorsement of or warranty for the services of Access Data Corp.



To turn the confirmation messages on or off

1 On the Tools menu, click Options.

2 Click the Editing tab.

3 Under Confirmation, choose or clear the options you want.

Confirmation messages let you accept or cancel changes before they're entered.



To turn Money's sounds on or off

1 On the Tools menu, click Options.

2 Click the General tab.

3 Under Sound, choose or clear the Play sounds option.

Hint
To also change Microsoft Window's sounds in Money, go to Sounds in the Windows Control Panel.



To automatically display category lists

1 On the Tools menu, click Options.

2 Click the Editing tab.

3 Under Entry, choose the option Automatically drop down category lists.

Note
When this option is on, your drop-down list of categories automatically displays whenever you enter the Category field.
You can also use the F4 key or ALT + DOWN ARROW while in the field to display the list.



To automatically insert decimal points

1 On the Tools menu, click Options.

2 Click the Editing tab.

3 Under Entry, choose the Automatically insert decimal point in amount field option.

Note
With this option on, you'll need to type two zeros whenever you enter a whole dollar amount, or you'll have to enter a 

decimal point manually. When you move to the next field, the decimal point is inserted two digits from the right.



To change the backup option

1 On the Tools menu, click Options.

2 Click the General tab.

3 Under Backup, choose the option you want from the drop-down list.

Note
Money is preset so that when you exit or open a different file, you are reminded to make a backup of your file. A backup is 

an extra copy of your work that serves as a precaution against data loss.

{button ,AL("ProcBackingUpYourFile;ProcRestoringaBackupFile")} See Related Topics



To change Payment Calendar reminders

1 On the Tools menu, click Options.

2 Click the Payment Calendar tab.

3 Make your changes.

{button ,AL("ProcCreatingaRecurringPayment")} See Related Topics



To require a category in each transaction

1 On the Tools menu, click Options.

2 Click the Categories tab.

3 Under Using categories, choose the Require a category for each transaction option.

{button ,AL("ProcCreatingaNewCategoryorSubcategory;ProcAssigningCategoriesToTransactions")} See Related Topics



To change your option settings

1 On the Tools menu, click Options.

2 Click the tab for the option you want to change, and then make your changes.





Question Mark area topics: (with F1 list topics following)



Money's Contents screen

Contents screen overview

Finding out what Online Services your bank offers

Account Register overview

Payment Calendar overview

Home Banking area overview

Account Manager overview

Investment Portfolio overview

Report and Chart Gallery overview

Payees and Categories area overview

Planning Wizards overview

MoneyZone overview

Restoring a backup file

Opening a Quicken file in Money

Starting the Product Tour

Using the Payment Reminder



Contents screen overview

The Contents screen is Money's "home base." It lets you jump directly to any of Money's nine main areas. You can also quickly 

return to the Contents screen at any time by clicking the Contents button on Money's navigation bar at the top of the screen.



Account Register

Account Register overview

Finding out what Online Services your bank offers

Entering a transaction

Deleting a transaction

Transferring money between accounts

Switching between accounts

Creating an account

Paying bills electronically

Entering credit card payments

Itemizing a paycheck deposit

Splitting a transaction between multiple categories

Balancing (reconciling) an account

Changing an account's opening balance

Printing checks

Using the Payment Calendar to enter your Recurring Payments

Using the ENTER key to move between fields



Account Register overview

The Account Register is where you enter your transactions and balance your accounts. It's similar to your checkbook in that it 

has a transaction register above and forms where you can enter transactions below.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 

account you want.

To enter a transaction, click a tab in the forms below for the type of transaction you want to enter. You can also enter transactions 

directly into the register by clicking the triangle to the left of the view bar above and then clicking Transaction Forms.

To create a new account, go to the Account Manager.

{button ,AL("ProcTransferringMoneyBetweenAccounts;ProcSplittingaTransactionBetweenMultipleCategories;ProcEnteringaTrans

action;ProcEnteringaTransactionDirectlyintotheRegister;ProcCreatinganAccount;ProcMarkingaTransactionasClearedorReconc

iled")} See Related Topics



This is a list of all the transactions you've entered for this account. This is also where you enter all your transactions and balance 
your accounts. The Account Register is similar to your checkbook in that it has a transaction register above and checks and 
forms where you can enter transactions below.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 
account you want.

You can also enter transactions directly into the register by clicking the triangle to the left of the view bar above and then clicking 
Transaction Forms.



This is a list of all your previously entered transactions. This is also where you enter all your transactions and balance your 
accounts. The Account Register is similar to your checkbook's register.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 
account you want.

You can also use transaction forms to enter your transactions by clicking the triangle to the left of the view bar above and then 
clicking Transaction Forms.



Account Register -- Loan Account

Account Register overview

Loan Accounts overview

Entering loan payments

Paying bills electronically

Switching between accounts

Balancing a Loan Account

Entering late fees

Making extra loan payments

Changing Loan Account information

Creating a loan report



Account Register -- Investment Account

Use the Account Register to enter your Investment Account activity. To see a summary of your Investment Accounts and 

indididual investments, go to the Investment Portfolio.

Account Register overview

Creating an Investment Account

Entering your current investment holdings

Switching between accounts

Entering purchases and sales

Adding shares to an Investment Account

Removing shares from an Investment Account

Entering interest received, dividends, and capital gains distributions

Tracking puts and calls

Tracking employer-offered stock options

Making changes to an investment transaction

Entering a stock split

Tracking a Retirement Plan

Verifying your investment records with a statement



Payment Calendar

The Payment Calendar is where you can automate your payment entry with Recurring Payments.

Payment Calendar overview

Using the Payment Calendar to enter your Recurring Payments

Editing a Recurring Payment

Using the calendar

Forecasting your balance

Using the Payment Reminder

Changing Payment Calendar reminders

Skipping an individual Recurring Payment

Permanently deleting a Recurring Payment

Entering an electronic Recurring Payment

Using Automatic Payments

Permanently canceling Automatic Payments

Canceling an individual Automatic Payment that has already been scheduled



Payment Calendar Overview

The Payment Calendar is where you enter all your Recurring Payments for regularly occurring bills and deposits.

For example, if you enter your monthly utility bills in the Payment Calendar, you only have to enter the information once. When 

the bill is due, you'll get a reminder and the transaction will be entered automatically. You can also use the Payment Calendar to 

do "what if" calculations to see if you will have enough money in your accounts to cover the payments.

You can use the Payment Calendar for paychecks as well as payments. You might also want to use the Payment Calendar to 

remind you of a single important transaction, such as the maturity date for a certificate of deposit.

{button ,AL("ProcChangingPaymentCalendarReminders;ProcPermanentlyDeletingaRecurringPayment;ProcCancelinganIndividu

alRecurringPayment;ProcCreatingaRecurringPayment;ProcEnteringRecurringPayments")} See Related Topics



This is a list of all the Recurring Payments you've created. Click in the check box to the left of the transactions you want to enter 
into the Account Register.



Use this list to see how the transactions checked above will affect your account balances. Look in the After column to make sure 
the bills you've selected won't put you below the minimum balance allowed on this account.



Use this calendar to see when you have upcoming payments. Click on a particular payment to see it highlighted in the list to the 
left. You can also use the right mouse button to click on a date and see other options.



Online Services

Online Services Overview

Finding out what Online Services your bank offers

Setting up Online Services

Assigning a bank to an account

Paying bills electronically

Checking the status of an electronic payment

Canceling an electronic payment

Transferring money electronically between accounts

Reviewing and sending instructions to Online Services

Electronically updating your account records

Using Automatic Payments

Sending a letter to Online Services

Finding and updating information about your bank

Downloading market prices with Online Quotes

Changing your Online Services options

Troubleshooting your modem



This is a list of all the instructions ready to send to Online Services. If there's any instructions you don't want to send on the next 
call, click on the instruction with your right mouse button, and then click Don't Send on Next Call.



This is a list of all the accounts you've set up for Online Banking. The amount in the Bank Balance column is the latest balance 
you downloaded for the account. 

If any of the accounts have transactions to download, highlight the account, and then click the Read Statement button to add the 
transactions to your Account Register.



This is a list of all the transactions you've sent through Online Bill Payment in the last 60 days. Highlight a transaction, and then 
click the Payment Status button.



Account Manager

Account Manager overview

Accounts overview

Creating an account

Assigning a bank to an account

Balancing (reconciling) an account

Changing an account's name or type

Closing an Account

Deleting an account

Changing an account's opening balance

Choosing a Favorite Account

Setting up Online Services

Archiving your records



Account Manager overview

In the Account Manager, you can see a summary of all your accounts, create new accounts, and delete or modify existing 

accounts. You can also go to Account Details, where you can enter and change information about your accounts, set up 

accounts for use with Online Services, and see an account's running balance over the last 12 months.

You can also use the Account Manager to see the current balances of all your accounts by clicking the triangle on the left of the 

view bar above the account list, and then choosing Account Balances.

{button ,AL("AccountsOverview;ProcCreatinganAccount;ProcChanginganAccountsOpeningBalance;ProcChanginganAccountsN

ameorType;ProcDeletinganAccount")} See Related Topics



This is a list of all your accounts. You can change what's displayed here by choosing a different option from the view bar above. 
Just click the triangle on the left of the bar, and then choose an option from the list.



Account Details -- Investment Account

This is where you can enter and change information about your accounts and see the account's price history over the last 12 

months.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 

account you want.



Account Details -- Loan Account

This is where you can enter and change information about your Loan Accounts and review your loan terms.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 

account you want.



Account Details

This is where you can enter and change information about your accounts, set up accounts for use with Online Services, and see 

the account's price history over the last 12 months.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another account, click the triangle to the left of the account name in the navigation bar above and then click the 

account you want.



Investment Portfolio

Investment Portfolio overview

Creating an Investment Account

Entering your current investment holdings

Tracking a retirement plan

Entering purchases and sales

Adding shares to an Investment Account

Removing shares from an Investment Account

Entering interest received, dividends, and capital gains distributions

Making changes to an investment transaction

Transferring shares between Investment Accounts

Verifying your investment records with a statement

Downloading market prices with online quotes

Manually updating your market prices

Using the view bar

Tracking puts and calls

Tracking employer offered stock options

Creating an Associated Cash Account

Entering a stock split



Investment Portfolio Overview

This is where you can see a summary of your current investment holdings and their values. Any investment transactions you 

enter are reflected in the Investment Portfolio. You can also electronically or manually update the market prices of your 

investments here.

You can change what's displayed in the list to the left by clicking the triangle on the left of the view bar.

Before using Money's Investment Portfolio, it's important to understand the difference between Investment Accounts and 

investments:
Investment Accounts provide a place to store your investments. Your first step in the Investment Portfolio will be to set 

up an Investment Account for each brokerage statement you receive.
Investments are added to Investment Accounts. You can have multiple investments in one Investment Account, just as 

you might hold a variety of investments through a single brokerage.

{button ,AL("ProcCreatinganInvestmentAccount;ProcEnteringYourCurrentInvestmentHoldings;ProcCreatinganAssociatedCashAc

count;ProcEnteringaStockSplit;ProcManuallyUpdatingYourMarketPrices")} See Related Topics



This is a list of all your Investment Accounts and/or investments. You can change what's displayed here by choosing a different 
option from the view bar above. Just click the triangle on the left of the bar, and then choose an option from the list.



Investment Details

This is where you can enter and change information about your investments and see the investment's transaction history.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another investment, click the triangle to the left of the investment name in the navigation bar above and then click 

the investment you want.



Report and Chart Gallery

Report and Chart Gallery overview

Viewing a report or chart

Customizing a report or chart

Printing a report or chart

Printing a report or chart in 3-D color

Exporting a report

Creating a budget

Changing the fonts in a report or chart

Adjusting the report column width

Saving a report or chart to your list of favorites

Copying a report or chart



Report and Chart Gallery Overview

Here you can see a summary view of your financial status to spot trends, summarize information, and provide others with 

information through printing and exporting. Money comes with 26 reports and charts that are grouped into the five areas you see 

in the button panel to the left.

First, click the button of the type of report you're interested in, and then highlight the report title in the list. A description of the 

report or chart will appear below the list. When you find a report you want to see, highlight it, and then click the Go to 

Report/Chart button to the right.

You can customize any of Money's reports to show exactly what you want. You can also save up to 50 reports and charts to a list 

of favorites, so that you can store in one place all the reports you go to most often or those you've customized to show exactly 

the information you're most interested in. For more information, see Saving a report or chart to your list of favorites.

{button ,AL("ProcPrintingaReportorChart;ProcExportingaReport;ProcCopyingaReportorChart;ProcViewingaReportorChart;ProcC

hangingtheFontsinaReportorChart;ProcCustomizingaReportorChart")} See Related Topics



Payees and Categories

Payees and Categories Area overview

Payees:

Payees overview

Creating a new payee

Deleting a payee

Renaming a payee

Adding information about payees

Categories:

Categories and subcategories overview

Creating a new category or subcategory

Deleting a category or subcategory

Renaming a category or subcategory

Adding information to a category or subcategory

Restoring Money's Standard Categories

Classifications:

Classifications overview

Creating a classification

Creating a classification item or subitem

Deleting a classification or classification item

Renaming a classification or classification item

Adding information about classification items and subitems



Payees and Categories overview

This is where you can see a list of all your payees, categories, and classifications, which are tools for organizing your finances 

and getting detailed and accurate reports. You can also go to the details area of each if you want to make modifications or see 

detailed spending information.

Use the button panel to the left to choose which you want to display. Click the triangle on the left of the view bar to choose the 

level of detail you want display.

{button ,AL("ProcCreatingaNewCategoryorSubcategory;ProcDeletingaCategoryorSubcategory;ProcRenamingaCategoryorSubca

tegory;ProcAddingInformationtoaCategoryorSubcategory;ProcAddingInformationAboutPayees;ProcCreatingaNewPayee;Proc

DeletingaPayee;ProcRenamingaPayee;ProcDeletingaClassificationorClassificationItem;ProcRenamingaClassificationorClassif

icationItem;CreatingaClassificationItemorSubitem;ProcCreatingaClassification;ProcAddingInformationAboutClassificationItems

andSubItems")} See Related Topics



This is a list of all your payees, categories, or classification items -- depending on which one you've selected in the button panel 
to the left.



Categories/Classifications Details

This is where you can enter and change information about your categories and classifications.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another category or classification, click the triangle to the left of the name in the navigation bar above, and then pick 

one from the list.



Payee Details

This is where you can enter and change information about your payees.

For additional information on any of the fields to the left, click in the field, and then press the F1 key.

To switch to another payee, click the triangle to the left of the payee name in the navigation bar above and then click the payee 

you want.



Planning Wizards

Planning Wizards overview

The Loan Calculator

The Mortgage Planner

The Retirement Planner

The Savings Calculator

The Interest Estimator



Planning Wizards overview

Money's Planning Wizards help you accomplish some of the most common financial planning tasks. The planning wizards are 

intended to help you with "what if" calculations. To start one of the wizards, click one of the buttons to the right of the screen.

Money has five Planning Wizards:

Loan Calculator:

Use the Loan Calculator to explore loan alternatives or calculate unknown values, such as interest, if you know the other values 

for the loan. You can also use the Loan Calculator to compare two loan alternatives, calculate savings on interest from additional 

payments, and see how much interest you're paying over the life of your loans.

Mortgage Planner:

Use the Mortgage Planner to compare the costs of two real estate loans. You can use it when shopping for a mortgage or 

considering refinancing your existing mortgage. It's designed to help you compare two different mortgage loans of the same 

amount to decide which is best for you.

Savings Calculator:

Use the Savings Calculator in planning for future purchases or building a cash reserve.

Retirement Planner:

Use the Retirement Planner to estimate how much you'll need to start saving monthly or annually to reach your retirement goal.

Interest Estimator:

Use the Interest Estimator to estimate the amount of interest a bank account has earned or the interest you have paid on a credit 

card account.

{button ,AL("TheLoanCalculator;TheMortgagePlanner;TheRetirementPlanner;TheSavingsCalculator;TheInterestEstimator")} See 

Related Topics





Accessibility for people with disabilities

Microsoft is committed to making its products and services easier for everyone to use. This help file provides information about 

the following features, products and services, which make Microsoft Windows, Microsoft Windows NT and Microsoft Money more 

accessible for people with disabilities:

Microsoft Money accessibility

Hints for customizing Microsoft Windows or Microsoft Windows NT

Microsoft services for people who are deaf or hard-of-hearing

Microsoft software documentation on audio cassette, floppy disk and compact disc (CD)

Third-party utilities to enhance accessibility

More information about products and services for people with disabilities

Note
The information in this section applies only to users who purchased Windows or Windows NT in the United States. If you 

purchased Windows or Windows NT outside the United States, your Windows package contains a subsidiary information card listing 
Microsoft support services telephone numbers and addresses. You can contact your subsidiary to find out whether the type of 
products and services described in this help file are available in your area.



Microsoft Money accessibility

In addition to Microsoft Windows and Microsoft Windows NT accessibility products and services, the following features make 

Microsoft Money more accessible for people with disabilities:

AutoComplete A Money feature that automatically fills in a payee, category, classification item, or account name you have used 

before once you start typing.

AutoComplete+ A Money feature that automatically enters the amount, memo, category, classification, and account fields from 

the last transaction when you enter a payee name you've used before.

Abbreviations A short name you can assign to categories, classifications, accounts, and payees for quick entry.

Shortcut keys You can choose any item on the screen by pressing ALT+ the underlined letter in the item.

Favorite accounts You can choose up to nine favorite accounts, adding them to the Go To menu in the navigation bar. This lets 

you quickly jump to the accounts at any time.



Microsoft services for people who are deaf or hard-of-hearing

If you are deaf or hard-of-hearing, complete access to Microsoft product and customer services is available through a text 

telephone (TT/TDD) service.

Sales Information

You can contact Microsoft Sales Information Center on a text telephone by dialing (800) 892-5234 between 6:30 A.M. and 5:30 

P.M. Pacific time. 

Technical Assistance

For technical assistance in the United States, you can contact Microsoft Support Network on a text telephone at (206) 635-4948 

between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, dial (905) 568-9641 

between 8:00 A.M. and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays. Microsoft support services are 

subject to Microsoft prices, terms, and conditions in place at the time the service is used.



Microsoft software documentation on audio cassette, floppy disk and compact disc

In addition to the standard forms of documentation, many Microsoft products are also available in other formats to make them 

more accessible.

If you have difficulty reading or handling printed documentation, you can obtain many Microsoft publications from Recording for 

the Blind & Dyslexic, Inc. Recording for the Blind & Dyslexic distributes these documents to registered, eligible members of their 

distribution service, either on audio cassettes or on floppy disks. The Recording for the Blind & Dyslexic collection contains more 

than 80,000 titles, including Microsoft product documentation and books from Microsoft Press.    You can contact Recording for 

the Blind & Dyslexic at the following address or phone numbers for information about eligibility and availability of Microsoft 

product documentation and books from Microsoft Press:

Recording for the Blind & Dyslexic, Inc.

20 Roszel Road

Princeton, NJ 08540

Phone: (609) 452-0606

Fax: (609) 987-8116

http://www.rfbd.org



Third-party utilities to enhance accessibility

A wide variety of third-party hardware and software products are available to make it easier to use personal computers. Among 

the different types of products available for the MS-DOS, Windows, and Windows NT operating systems are:
Programs that enlarge or alter the color of information on the screen for people with visual impairments.
Programs that describe information on the screen in Braille or synthesized speech for people who are blind or have 

difficulty reading.
Hardware and software utilities that modify the behavior of the mouse and keyboard.
Programs that enable people to “type” using a mouse or their voice.
Word or phrase prediction software that enables people to type more quickly and with fewer keystrokes.
Alternate input devices, such as single switch or puff-and-sip devices, for people who cannot use a mouse or a keyboard.

For more information on obtaining third-party utilities, see Getting more information. For more information about customizing 

Windows and Windows NT for people with low vision, see Customizing Windows or Windows NT.



Customizing Windows or Windows NT

There are many ways you can customize Windows or Windows NT to make your computer more accessible.
Beginning with Windows 95, accessibility features are built in to Windows. These features are useful for individuals who 

have difficulty typing or using a mouse, have moderately impaired vision, or who are deaf or hard-of-hearing. The features can be 
installed during setup, or you can add them later from your Windows 95 installation disks. Look up "accessibility" in the Windows 
Help Index for information about installing and using these features.

Many of the features which make Windows 95 more accessible can be added to Windows NT, earlier versions of Microsoft 
Windows, and MS-DOS through Access Packs. You can download these files by modem, or you can order them on disks from 
Microsoft.

You can also use Control Panel and other built-in features to adjust the appearance and behavior of Windows or Windows 
NT to suit varying vision and motor abilities. These include adjusting colors and sizes, sound volume, and the behavior of the mouse 
and keyboard.

Dvorak keyboard layouts make the most frequently typed characters on a keyboard more accessible if you have difficulty 
using the standard "QWERTY" layout. There are three Dvorak layouts: one if you are a two-handed user, one if you type with your 
left hand only, and one if you type with your right hand only. You do not need to purchase any special equipment to use these 
features.

The specific features available, and whether they are built-in or must be obtained separately, depend on which operating system 

you are using.

For full documentation on the accessibility features available in the operating system you are using, obtain the appropriate 

application notes listed below. Accessibility features are also documented in the Microsoft Windows 95 Resource Kit and the 

Microsoft Windows NT Resource Kit.

Which Files to Download or Order

You can obtain these files by downloading them with your modem, or you can order them on disks by phone. Specific information 

about downloading or ordering these files immediately follows this list of files.

These files include:
Application notes providing more complete documentation on ways to customize Windows and Windows NT.
Access Packs and Dvorak keyboard layouts provide additional features for versions of Windows or Windows NT in which 

they are not already included.

For You need 

Application notes 

for Microsoft 

Windows 95

Ww1062.exe

Application notes 

for Microsoft 

Windows NT 3.1 

and 3.5

(includes Access 

Pack for 

Microsoft 

Windows NT)

Wn0789.exe

Application notes 

for Microsoft 

Windows for 

Workgroups 3.1

Wg0788.txt

Application notes 

for Microsoft 

Windows 3.1

Ww0787.txt

Application notes 

for Microsoft 

Windows 3.0

Ww0786.txt

Access Pack for 

Microsoft 

Windows 3.0 and 

Accp.exe



3.1

Dvorak keyboard 

layouts for 

people who type 

with one hand

(already included 

in Windows NT 

3.5 and higher)

Ga0650.exe 

(Most 

network 

services)

Ga0650.zip 

(Microsoft 

Download 

Service)

To Download the Access Packs, Application Notes, and Alternative Keyboard Layouts by Modem

If you have a modem, you can download these files from the following network services:
Microsoft's World Wide Web Site on the Internet. On the www.microsoft.com home page, click the Support icon. click 

Knowledge Base, and select MS-DOS as the product. Enter KBFILE GA0650.EXE, and click GO! Open the article, and click the 
button to download the file.

Microsoft’s Internet servers, ftp.microsoft.com and    gopher.microsoft.com, in /softlib/mslfiles
MSN, The Microsoft Network online service.
CompuServe, type GO MSL
GEnie
Microsoft Download Service (MSDL), which you can reach by calling (206) 936-6735 any time except between 1:00 A.M. 

and 2:30 A.M. Pacific time.

MSDL supports 1200, 2400, 9600, 14400, or 28800 baud rates (V.32 and V.42), with 8 data bits, no parity, and 1 stop bit.
Various user-group bulletin boards (such as the bulletin-board services on the Association of PC User Groups network)

To Order the Access Packs, Application Notes, and Alternative Keyboard Layouts on Disks by Phone

If you do not have a modem, within the United States you can order the Access Packs, Application Notes, and Alternative 

Layouts on disks by calling Microsoft Sales Information Center at (800) 426-9400 (voice) or (800) 892-5234 (text telephone).

In Canada, you can call (905) 568-3503 or (905) 568-9641 (text telephone).



Getting more information

For more information on Microsoft products and services for people with disabilities, contact:

Microsoft Sales Information Center

One Microsoft Way

Redmond, WA 98052-6393

Voice telephone: (800) 426-9400

Text telephone: (800) 892-5234

Fax: (206) 635-6100

The Trace R&D Center at the University of Wisconsin-Madison produces a book and a compact disc that describe products that 

help people with disabilities use computers. The book, titled Trace ResourceBook, provides descriptions and photographs of 

about 2,000 products. The compact disc, titled Co-Net CD, provides a database of more than 18,000 products and other 

information for people with disabilities. It is issued twice a year. To obtain these directories, contact:

Trace R&D Center

S-151 Waisman Center

1500 Highland Avenue

Madison, WI 53705-2280

Voice telephone: (608) 263-2309

Text telephone: (608) 263-5408

Fax: (608) 262-8848

For general information and recommendations on how computers can help specific people, you should consult a trained 

evaluator who can best match your needs with the available solutions. An assistive technology program in your area will provide 

referrals to programs and services that are available to you. To locate the assistive technology program nearest you, you can 

contact:

National Information System 

Center for Developmental Disabilities

Benson Building

University of South Carolina

Columbia, SC 29208

Voice/text telephone: (803) 777-4435

Fax: (803) 777-6058





Ordering Checks



Quicken conversion overview

Use the following Help topics to learn more about the conversion of your Quicken file:

Opening a Quicken file in Money

Details of Quicken conversion

Quicken commands in Money

Switching Quicken Online Services to Money

Recategorizing transactions that use deleted Quicken categories

Resolving account balance differences following conversion from Quicken

Tracking lots

Accommodating short sells from a Quicken file

Using Quicken checks with Money

IntelliCharge accounts



To open a Quicken file in Money

If you've been using Quicken 3.0 for Windows (or later), you can use the Converter Wizard for Quicken to convert your file to 

Money.

1 On Money's File menu, click Open.

2 Choose Quicken files in the Files of type box.

3 Double-click the Quicken file you want to import.

4 Follow the Converter Wizard for Quicken through the conversion of your file.

5 After the conversion, save the summary as a file in case you need to refer to it later.

You can also import single Quicken accounts into an existing Money file using the Import command on the File menu. See 

Importing a file into Money.

{button ,AL("ProcDetailsOfQuickenConversion;ProcQuickencommandsinMoney;ProcSwitchingYourOnlineServicestoMoney;Proc

RecategorizingTransactionsThatUseDeletedQuickenCategories;ProcTrackingLots;ProcAccommodatingShortSellsFromaQuick

enFile;ProcUsingQuickenChecksWithMoney;ProcIntelliChargeAccounts")} See Related Topics



To use Quicken checks with Money

1 On Money's Tools menu, click Options.

2 Click the Print Checks tab.

3 Make sure the Use my existing checks from Quicken check box is selected, and then click OK.

4 On Money's File menu, point to Print Setup, and then click Check Setup and choose the appropriate check type from the 

drop-down list.

{button ,AL("ProcOpeningaQuickenFileInMoney;ProcPrintingChecks;PrintingChecksOverview;ProcSettingUptoPrintChecks")} 

See Related Topics



To switch Quicken Online Services to Money

Money offers Online Services similar to what you might have used in Quicken, but you need to sign up for Money's services 

separately.

1 Contact your bank to see what you need to do to cancel your Quicken online services.

2 When you're ready to sign up for Money Online Services, go to the Home Banking area and switch to the bank whose 

accounts you want to set up.

3 On the Connect tab, Click the Set up Online Services button.

{button ,AL("OnlineServicesOverview;ProcFindingOutWhatOnlineServicesYOURBankOffers;ProcSettingupanAccountforOnlineS

ervices")} See Related Topics



IntelliCharge accounts

You can continue to use your Quicken credit card to make purchases, but you won't be able to download the transactions into an 

IntelliCharge Account in Money.

You can download credit card transactions into a Money account by using a credit card from a bank that provides Online Banking 

for use with Money.

To download credit-card transactions into Money:

1 Get a credit card through a bank that provides Online Banking for use with Money.

For a list of current banks, connect to the MoneyZone.

2 Set up a Credit Card account in Money.

3 Sign the account up for Online Banking.

{button ,AL("ProcSettingupanAccountforOnlineServices;ProcCreatingaCreditCardAccount;ProcEnteringCreditCardPayments;")} 

See Related Topics



Quicken commands in Money

The following table describes the Money equivalents of Quicken menu commands. In Money, you work in a single area at a time 

(such as the Account Register or Investment Portfolio), and everything you need to do in an area is contained in the area itself. 

Therefore, many Money equivalents of Quicken commands are tasks in an area, rather than items on a menu.

All of Quicken's commonly used commands have Money equivalents; a few less frequently used commands do not, and those 

are not included in the list.

Quicken 

Command

Money Equivalent

File, New File, New

File, Open File, Open

File, Year End 

Copy

File, Archive

File, Passwords File, Password

File, Backup File, Backup

File, Restore File, Restore Backup

File, Import File, Import

File, Export File, Export

File, Save 

Desktop

Tools, Options, 

General tab to choose 

what area Money 

starts in when you 

launch the program.

File, Printer 

Setup

File, Print Setup

File, Print 

Checks

File, Print Checks

Edit, New 

Account

In Account Manager, 

click New Account.

Edit, Edit 

Account

In Account Manager or 

Account Register, click 

Account Details.

Edit, Delete 

Account

In Account Manager, 

click Delete.

Edit, Void 

Transaction

In Account Register, 

click Edit, Mark As, 

Void.

Edit, Copy 

Transaction and 

Edit, Paste 

Transaction

Right-click the 

transaction, click 

Move to Account, then 

choose the account to 

which you want to 

move the transaction.

Edit, Memorize Money automatically 

remembers the five 

most recent 

transactions for each 

payee.



Edit, Find Tools, Find

Edit, Go To 

Transfer

Right-click the transfer 

transaction, then click 

Go To Account.

Activities, Create 

New Account

In Account Manager, 

click New Account.

Activities, Write 

Checks

Enter Print in the 

Number field of any 

transaction you want 

to print.

Activities, Use 

Register

From Contents or the 

Go To menu, click 

Account Register. 

Activities, 

Reconcile

In the Account 

Register, click the 

Balance button.

Activities, 

Update 

Balances

When you balance 

your account against a 

statement, Money 

gives you the 

opportunity to enter a 

balance adjustment.

Activities, 

Financial 

Calendar

Click Payment 

Calendar on the Go To 

menu.

Activities, Loans To set up a new loan, 

go to the Account 

Manager and click 

New Account.

To view a loan, go to 

Account Register and 

choose the loan from 

the triangle menu in 

the navigation bar.

Activities, Set Up 

Investment

In the Investment 

Portfolio, click the 

New button.

Activities, 

Portfolio View

In Investment 

Portfolio, choose 

Portfolio from the 

triangle menu in the 

view bar.

Activities, 

Recategorize

In the Payees and 

Categories area, click 

Categories, select a 

category, then click 

the Move button.

Activities, Use 

Calculator

Tools, Calculator 

(CTRL + K)

Activities, Tools, Options, 



Reminders Payment Calendar tab

Activities, Order 

Checks

Help, Ordering 

Checks

Reports Menu, 

all commands

Report and Chart 

Gallery

Lists, Account Account Manager 

area. For a list of all 

account details, click 

the triangle in the view 

bar and choose 

Account Balances.

Lists, Category 

and Transfer

Categories button in 

the Payees and 

Categories area

Lists, Class Classification button in 

the Payees and 

Categories area

Lists, Scheduled 

Transaction

Payment Calendar

Lists, Security Investment Portfolio. 

Click triangle in view 

bar and choose 

Investments.

Lists, Security 

Type

Report and Chart 

Gallery, Investments 

button, Performance 

by Investment Type 

report

Lists, Online 

Payees

Payees button, 

Payees and 

Categories area 

(shows all payees, not 

just online ones)

Plan, Budgeting Tools, Budget

Plan, 

Forecasting

Payment Calendar 

area, Balance 

Forecast chart

Plan, Financial 

Planners

Planning Wizards area

Online, Online 

Banking

Home Banking area

Online, Online 

Bill Payment

Home Banking area

Online, Portfolio 

Price Update

Investment Portfolio, 

Online Quotes button

Online, Financial 

Directory

The MoneyZone

Online, Quicken 

Financial 

The MoneyZone



Network

{button ,AL("ProcOpeningAQuickenFileInMoney;ProcDetailsOfQuickenConversion")} See Related Topics



To accommodate short sells from a Quicken file

Because Money voids short sell transactions, the cash account associated with an Investment Account is likely to have an 

incorrect balance when you import it. You can easily correct this. Any of the following will work; choose the one you prefer.

Recreate all short transactions

This method provides the most accurate records of your previous short sells.

1 Create an Add Shares transaction for the number of shares you sold short.

2 Create a Sell transaction with the same date, entering the details of the sale.

3 When you cover the short, create a Buy transaction, entering the details of the purchase. (If the Buy transaction existed in 

your Quicken file, Money will have imported it and you should skip this step.)

4 Create a Remove Shares transaction, removing the number of shares you bought so that they no longer appear in your 

account.

Create a balance adjustment

This is the quickest way to correct your account balances, but doesn't reflect the history of your short sells. If you don't want to 

enter the details of each transaction involving short sells, correct the balance by entering a balance adjustment transaction (a 

deposit or withdrawal that brings your account balance up to date).

Then, in the Investment Account, void the Buy transaction for each short position, so that your account doesn't reflect long 

positions on investments you don't actually hold.

Switch the dates on the buy and sell

This method lets you track your profits correctly and is a bit simpler than the previous method.

Instead of entering the short sell at the time you open the position, wait until you close it. When you do buy the stock, enter both 

the buy and sell transactions at the same time. (You'll have to enter the buy before the sell, as if it were a long position.) The 

dates will be incorrect, but your reports will accurately reflect your profits.



To track lots

If you want to track your investment purchases by individual lot (that is, if you want to specify which purchase you're selling when 

you sell shares of a security), do the following:

1 Use a slightly separate investment name for each purchase of the stock.

For example, "Acme Industries (a)" and "Acme Industries (b)."

2 When you sell the stock, sell the specific group of shares you want.

If you sell all of the stock, enter the sale of each "lot" separately.

Warning
If you use this method, your reports and charts will reflect the profits and losses for each lot rather than for the investment 

as a whole.



To recategorize transactions that use deleted Quicken categories

Money imports the 250 most frequently used categories and subcategories from your Quicken file. If your Quicken file contained 

more than 250 categories and subcategories, Money deleted the extra categories and assigned the category "Deleted Category" 

to the affected transactions.

1 On Money's Tools menu, point to Find, then click Transactions.

2 Click the Categories tab.

3 If all categories are highlighted, click the No Categories button to deselect all categories, then click the category Deleted 

Category.

4 Click the Find button.

5 In the bottom half of the Find Transactions window, press CTRL as you click to highlight all the transactions you want to 

reassign to the new category.

6 In the top half of the Find Transactions window, click the Change Category button.

7 Click the category or subcategory to which you want to reassign the transactions.



To resolve account balance differences following conversion from Quicken

In a few cases, Money will not import all transactions exactly as they were in Quicken. This can result in a difference between a 

Quicken account balance and the balance as it appears in Money. If your Money account balances do not exactly match the 

Quicken balances, read the table below to find the possible reasons.

Note: When Money changes a transaction during conversion, it categorizes it as "(Quicken: modified transaction)." You can find 

these transactions easily using the Find command on the Tools menu, then choosing the type of transaction you want to look for.

A 

difference 

in this 

account

Can be caused by

Investment 

Account 

Short sells: Money voids the 

transaction. See 

Accommodating short sells 

from a Quicken file.

A "price history" for a CD: 

Because Quicken treats CDs 

as any other security type, you 

can record buying "shares" at 

a price other than $1.00. 

Money allows the 

transactions, but because 

Money handles CDs 

differently, the account 

balance might be different. In 

addition, the price history is 

not imported.

Negative transaction 

amounts: Money voids the 

transaction. Fix the balance 

discrepancy with a balance 

adjustment.

Rounding differences: For 

example, $2.375 is displayed 

as $2.37 in Quicken, but as 

$2.38 in Money. This can 

result in different (not 

incorrect) balances, especially 

when a transaction involving 

several decimal places, such 

as a stock split, has been 

recorded. 

Non-current account value 

in Quicken: If you update 

investment prices in Quicken, 

then import the file to Money 

before Quicken recalculates 

the account value, the Money 

and Quicken balances will 

differ.

In Quicken, a tilde (~) appears 

before the account balance if 



an account value has not 

been updated. If you want to 

confirm Money's balance, 

update the account balance in 

Quicken. (For details, refer to 

your Quicken documentation.) 

The balances should now 

match.

Any account Archiving the Quicken file: 

This can sometimes cause 

temporary balance 

inconsistencies in Quicken 

that get passed on when you 

convert the file to Money. You 

can easily fix the balance by 

opening the Quicken file, then 

viewing the account whose 

balance is off. Finally, re-

import the Quicken file.

If the balance is still off, try re-

indexing the Quicken file. 

Refer to your Quicken 

documentation for 

instructions.

Non-current account value 

in Quicken: If you change an 

account in Quicken, then 

import the file to Money before 

Quicken recalculates the 

account value, the Money and 

Quicken balances will differ.

If you want to confirm Money's 

balance, open Quicken and 

double-click the account name 

to open the register and 

update the account balance. 

The balances should now 

match.

Unsupported currencies: If 

your Quicken file contains 

amounts in currencies other 

than U.S. dollars, your 

balances will be incorrect. 

Money does not support 

multiple currencies.

Details of Quicken conversion

The table below details how Money handles the elements in your Quicken file when you convert it. Most Quicken files won't 

change noticeably when you convert to Money. However, if your file is very large or very complex, there are a few issues you'll 

want to be aware of.

You might want to print this table if you plan to review it thoroughly.

File How it's 



elem

ent

converted

Acco

unts: 

maxi

mum 

numb

er

Money supports 

63 Bank Accounts 

(including 

Checking, 

Savings, Credit 

Card, and others), 

63 Investment 

Accounts, and 63 

Loan Accounts. If 

a Quicken file 

contains too many 

accounts, Money 

imports the 63 

most recently used 

accounts of each 

type.

Categ

ories: 

maxi

mum 

numb

er 

Money imports the 

250 most 

frequently used 

categories and 

subcategories. If 

there are used 

categories and 

subcategories left 

over, Money 

removes them and 

creates a category 

called "Deleted 

Category," and 

assigns 

transactions to it 

that used the 

removed 

categories.

Retire

ment 

Acco

unts

Money imports 

IRAs, 401(k)s, and 

other retirement 

accounts as 

Investment 

Accounts, but 

does not import 

their tax-deferred 

status. Once the 

account is 

imported, you can 

specify that it is 

tax-deferred in the 

Account Details 

area.

Trans

action 

Money does not 

import scheduled 



group

s

transactions 

assigned to 

Quicken 

transaction 

groups. However, 

it's easy to add 

those transactions 

to Money's 

Payment Calendar 

after conversion. 

Simply right-click 

the transaction in 

the Account 

Register and 

choose Add to 

Payment 

Calendar.

Budg

ets

If you use multiple 

budgets in 

Quicken 5.0, 

Money imports the 

most recently used 

budget from your 

file. (Even if you 

have a budget 

with more recent 

dates, Money 

imports the budget 

you most recently 

opened.)

Pass

words

Money imports the 

password for a 

Quicken file, but 

not the password 

for a transaction.

Mem

orized 

charts 

and 

report

s

Money does not 

import memorized 

Quicken charts 

and reports, but 

you can recreate 

them in Money 

and save them as 

Favorites.

Super

categ

ories

Supercategories 

are not imported. 

Other categories 

and subcategories 

are imported as 

described above.

Invest

ment 

Acco

unts

Money creates an 

Associated Cash 

Account for each 

Investment 



Account.

Lots Money doesn't 

import individual 

lot information, but 

does import the 

investment and 

related buy/sell 

transactions so 

that your account 

balances are not 

affected. However, 

capital gains might 

be different than 

they were in 

Quicken.

Short 

sells

Money imports 

short sell 

transactions, but 

voids them. 

Account balances 

will be affected. In 

Money, search for 

"(Quicken: 

modified 

transaction)" in 

your Investment 

Accounts to find all 

voided short sell 

transactions.

See 

Accommodating 

short sells from a 

Quicken file.

Invest

ment 

categ

ories

If you didn't track 

investments in 

Quicken and you 

want to start 

tracking them in 

Money, it's a good 

idea to assign 

categories to your 

investment 

transactions. Use 

the Investment 

Categories dialog 

box to set up the 

way Money 

automatically 

categorizes 

specific types of 

investment 

transactions.

Click Options from 



the Tools menu, 

click the 

Investments tab, 

then click the 

Investment 

Categories button.

In the Investment 

Categories dialog 

box, create the 

categories and 

subcategories you 

want to use for 

each kind of 

investment 

transaction. 

Chara

cters 

in 

fields: 

", [, ], 

\, *, ?

Money replaces 

these characters 

with the characters 

# and /

Multip

le 

curre

ncies

Money does not 

support multiple 

currencies. If your 

Quicken file 

contains 

currencies other 

than U.S. dollars, 

the accounts will 

be imported, but 

the amounts will 

not be converted 

and balances will 

be incorrect.

Class 

List

Money supports 2 

Classifications 

(compared to 1 

Class group in 

Quicken). Up to 

250 classes can 

be imported into 

Money's first 

Classification 

group.

Money's 

Classifications 

work differently 

than Quicken's 

Classes. Money 

imports Classes 

so that you can 

use them 

according to 



Quicken's model 

or Money's, which 

means that you 

might end up with 

two versions of the 

same class. After 

conversion, you 

might want to 

clean up your 

class list by 

deleting any 

extras.

Price 

Histor

y of 

invest

ments

Price Histories 

before 1948 are 

imported as 

1/1/1948. 

Balances are not 

affected.

Loan 

paym

ents 

made 

using 

online 

servic

es

If you made loan 

payments 

electronically in 

Quicken, you'll 

end up with two 

payments 

scheduled in 

Money's Payment 

Calendar for each 

loan payment. To 

delete the extra 

set of payments, 

right-click an 

instance of the 

payment in the 

Payment 

Calendar, then 

click Delete All 

Instances.

Loan 

origin

ating 

prior 

to 

1/1/1

948

Money imports the 

loan. Payments 

made prior to 

1/1/1948 are 

imported, and their 

dates are changed 

to 1/1/1948.

Loan 

comp

oundi

ng: 

daily 

comp

oundi

ng on 

a 

Compounding 

changed to 

monthly



mont

hly 

loan

Manu

ally 

sched

uled 

loan 

paym

ents

Money schedules 

loan payments 

according to the 

loan's payment 

frequency. If you 

manually added 

payments to 

Quicken's 

scheduled 

transaction list, 

Money does not 

import them.

Loan 

with a 

variab

le 

intere

st 

rate

Money imports 

only the most 

recent rate from 

your Quicken file. 

This might affect 

the loan 

amortization 

schedule.

Invest

ment 

activit

ies

Money maps to 

the investment 

activities that most 

closely match the 

Quicken ones, 

ensuring that the 

activity is affected 

the same way it 

was in Quicken.

In Money, search 

for "(Quicken: 

modified 

transaction)" in 

your Investment 

Accounts to find all 

changed 

investment 

transactions.

Trans

action

s: 

maxi

mum 

numb

er 

If the Quicken file 

contains more 

than about 30,000 

transactions (the 

exact number 

varies by file), 

Money does not 

convert the file. 

You might want to 

use Quicken's File 

Operations/

Copy command to 



create a copy of 

the Quicken file 

that includes 

transactions for 

only the last two or 

three years. Then 

convert that file 

into Money.

Loans

: 

paym

ent 

frequ

ency 

not 

suppo

rted 

by 

Mone

y

Money does not 

import the loan.

Loans

: 

Paym

ent 

frequ

ency 

differ

ent 

than 

comp

oundi

ng 

frequ

ency

Money changes 

compounding 

frequency to 

match payment 

frequency for most 

loans. If the loan 

uses Canadian 

compounding 

(twice yearly), 

Money does not 

change the 

compounding 

frequency. 

Secur

ity 

types

Any security types 

in your Quicken 

file that Money 

does not 

recognize (such as 

security types that 

you defined) are 

assigned the type 

"Mutual Fund."

Trans

action 

dates 

prior 

to 

1/1/1

948

Money assigns the 

transactions the 

date 1/1/1948. 

Account balances 

are not affected.

NUM 

field 

entry 

Money changes all 

Xmits to ">>>>>" 

To send these 



for 

online 

paym

ents 

that 

have 

not 

yet 

been 

trans

mitted

transactions, you 

need to sign up for 

Online Bill 

Payment through 

Money, then 

choose Tools, Find 

and search for 

">>>>>" Change 

each transaction's 

number field to 

"Epay." Those 

payments will be 

sent the next time 

you connect to 

Online Services.




